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Fourth Shift Basics

Using Fourth Shift
The Fourth Shift program contains a wide variety of features allowing you to enter, view, and 
monitor the critical information that runs your business.

This section introduces the important terms and concepts you need to know to use Fourth Shift. It 
also describes the tools and options available to help you get the most out of the program.

Modules and Screens
The Fourth Shift system is made up of numerous modules, each supporting a particular business 
function such as Accounts Receivable or Shipping. Each module contains screens that help you 
carry out specific activities within the module. The modules work together to provide an integrated 
solution for your business.

Function Codes
Each screen has a unique Function Code, which is a four-character "shortcut" that identifies the 
screen. For example, the Item Master screen is identified by the Function Code "ITMB." Use the 
Function Code to open, or go to a particular screen.

Fourth Shift provides many mechanisms to help you move between screens. Because it is likely 
that you will be working with a limited number of screens on a regular basis, you will quickly learn 
the Function Codes for the screens you use most often.

The Function field is always visible when you are using Fourth Shift, appearing in the region 
directly beneath the toolbar. It displays the Function Code of the screen you are viewing. You can 
go to a different screen by entering that screen's Function Code and pressing Esc.

For more information, see Moving Between Screens.

Screen Types
There are several different types of screens you may encounter while working with Fourth Shift. 
Occasionally, the ways you use the program are different depending on the type of screen you are 
working on.

Entry and Inquiry Screens
A screen that allows you to add, change, or view business data is called an entry screen. Each 
screen is identified by a name and Function Code. Entry screens contain fields for entering or 
viewing data.

All screens contain four special elements directly beneath the toolbar:

• The Function field displays the four-character Function Code identifying the screen. It also 
contains a selection list that allows you to move to a related screen, menu screen, or Fourth 
Shift Explorer.

• The name of the screen is displayed beside the Function field.
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• The Status indicator describes your current activity on the screen.

• The current date is displayed beside the Status indicator.

Many entry screens have read-only counterparts called inquiry screens. Inquiry screens contain 
the same data that entry screens do. The only difference is that data changes are not allowed on 
inquiry screens. You may be granted permission to access an inquiry screen if you need to view, 
but not change, data supporting a specific business function.

Scrolling Lines
Some screens contain scrolling line sections, in which information is displayed in a list format. 
Scrolling line sections are shown on the screen with a light background. They are set up like 
tables, with darker lines showing the boundaries between rows and between columns.

You can scroll backward and forward through the lines using the scrollbar, or the Up arrow and 
Down Arrow keys. You can also select a line by clicking it with the mouse. Each screen displays a 
finite number of lines at one time, so you cannot always view the entire list at once.

Scrolling line sections contain the following additional features:

• The line marker is an arrowhead symbol at the beginning of the active line, indicating your 
current location within the list.

• Some scrolling line sections display additional detail information about the current line in an 
identification line. The identification line appears beneath the scrolling line section.

• Many scrolling line sections have related detail screens that contain additional information 
about the line.

Detail Screens
Detail screens provide additional information about the active line in a scrolling line section. You 
can access a detail screen in a variety of ways, including:

• selecting it from the Function field

• clicking a transport button

• pressing a Function key, such as F8

When you are viewing a detail screen, the Function field displays the Function Code of the screen 
that contains the scrolling lines. You can return to the screen identified by the Function Code by 
selecting Return from the Function field selection list, or by clicking the Return transport button.

Windows
Related information about the screen you are viewing is often displayed in a window. Some 
windows can be opened from anywhere on the screen, while others can be opened only from a 
specific active field.

When a window is opened, it overlays the screen and cannot be repositioned. Close the window to 
redisplay the entire screen by pressing Esc.

Windows are typically used for special purposes, such as browsing, displaying detail, selecting 
from a list, or performing mass maintenance.

Status Description

ADD Adding new information

CHG Changing information in open fields

INQ Viewing information only; changes are not allowed
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Batch Processes and Tasks
A batch process is a sequence of ordered tasks which perform specific actions. A task might 
generate a report, update a set of records, or import or extract data. The Batch Process Setup 
(BSET) screen is a special screen that allows you to set up batch processes.

Tasks may include required and optional parameters. Required parameters, such as date ranges, 
must be identified before you can execute a batch process. Optional parameters, such as whether 
to print a report, can be identified when needed.

Each task has a unique Function Code. When the Function Code for a task is displayed, the BSET 
screen shows the name of the task. When a batch process is displayed on the BSET screen, each 
task in the sequence has a separate line in a scrolling line section. The available parameters for 
the task in the active line are displayed on the screen.

Once a batch process is set up, you can execute it whenever necessary using the Batch Process 
Execution (BEXE) screen. For more information, see Batch Processing in the System Control 
manual.

Menu Screens
A menu screen lists a set of related screens and allows you to transport to each one.

There are two types of menu screens:

• Master menu—lists the available modules. 

- Click a module name to go to that module menu.

• Module menu—lists the screens that are available for a single module. 

- Click a screen or submenu name to go to that screen or submenu.

Menu screens list only the screens or modules that you have been allowed to access.

Fourth Shift Modules
Use the Fourth Shift main program to access screens in the following modules:

Module Name Code

Accounts Payable APSM

Accounts Receivable ARSM

Advanced Price Book APBM

Bill of Material BILM

Cash Management CSHM

CIM Customizer CSTM

Custom Products Manufacturing CPMM

EDI Services EDSM

Electronic Data Interchange EDIM

Engineering ENGM

G/L Restructuring RTSM

General Ledger GLSM

Intrastat ISTM
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The other modules in the Fourth Shift system use other programs to access their features, or 
provide features that supplement the main Fourth Shift program.

Fourth Shift displays the name of the module you are using. The module name directly relates to 
the active screen, with the exception of batch process tasks. The System Control module name is 
displayed for all batch process tasks in all modules.

In general, the screens and features in each module use the standard program features described 
in this manual. Any additional features that apply to a single module, or that have special meaning 
in a particular module, may be described in the online manual for that module. Consult the online 
manual for each module that you use regularly.

Accessing Fourth Shift
Before you can access Fourth Shift screens, you must have a User Id and Password assigned to 
you by your system administrator. Once you have these, you may open the program and use them 
to sign on to Fourth Shift.

Your User Id and Password give you permission to view a specific set of screens and modules, as 
determined by your system administrator. After you sign on to Fourth Shift, the Master Menu is 
displayed. It lists the modules you are allowed to access.

You can sign on to Fourth Shift directly or through the Fourth Shift Explorer.

• Click the Start button, and then point to Programs. Point to the folder that contains the Fourth 
Shift group, and then click Fourth Shift or Fourth Shift Explorer.

Inventory Control INVM

Lot Trace/Serialization LOTM

Management Reports MGRM

Manufacturing Order Management MOMM

Manufacturing Analysis MMAM

Material Requirements Planning MRPM

Multi-Currency MCMM

Operations Performance OPFM

Order Entry CUSM

Product Costing PRCM

Purchasing PURM

Repetitive Manufacturing RPTM

Sales Analysis SAAM

Sales Order Processing SOPM

Shipping SHPM

Shop Floor Tracking and Reporting SFRM

System Control SYSM

Module Name Code
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Using the Fourth Shift Explorer
From the Fourth Shift Explorer, you can go to every Fourth Shift screen you are allowed to access 
directly, without using menu screens. You can also access modules that do not require you to use 
the Fourth Shift main program, such as Engineering (ENGM) or Shop Floor Tracking and 
Reporting (SFRM).

Using the Start Menu
When you complete the workstation installation for the System Control (SYSM) module, the 
following shortcuts are created in the Fourth Shift folder in your Start menu.

• Fourth Shift

• Fourth Shift Explorer

• Fourth Shift Report Viewer

• Shop Calendar

Additionally, a Help folder is created in the Fourth Shift folder. This folder contain shortcuts that 
access commonly used online manuals.

Troubleshooting
• The Sign On screen also displays the product release level and names of Database Server, 

Lock Server, and SystemIdentChar of the server you are signing on to. This information is 
useful for troubleshooting should you encounter any difficulties in signing on.

• If you can not see the entire window once Fourth Shift opens, you may need to change some 
appearance settings.

- If you want to change the appearance of the borders around open fields, see 
Removing Graphical Borders. Removing the borders will reduce the size of the 
window.

- If you want to change the font or font size, see “Changing the Look and Feel” on 
page 42. Choosing a smaller font will reduce the size of the window.

- If you want to use the desktop color scheme that coordinates with the Fourth Shift 
program, see Using the Fourth Shift Color Scheme.

Moving Between Screens
Several methods are available for moving between Fourth Shift screens.

• Fourth Shift Explorer
Use the Fourth Shift Explorer to go to any screen or task in any application that you are 
allowed to access. You can also specify data values to be filled in when you go to a screen. 
For more information, see Using the Fourth Shift Explorer in this manual.

• Master menu and module menus
The master menu lists the available modules. 

- Click a module name to go to the module menu.

Each module menu lists the screens and tasks in that module that you are allowed to access. 
Some module menus also contain submenus. 

- Click the folder icon, screen name or function code to go to the selected screen or 
menu. 
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Note: You can press F5 to go to the "parent" menu of the screen or menu you are viewing.

• Function field
here are two ways to use the Function field to go to a screen:

- Enter the function code for a screen or task and press Esc.

- Click the arrow in the Function field to select from a list of related or detail screens. 
You may also use this method to go to a menu screen or to the Fourth Shift Explorer.

• Transport buttons
Click a transport button below the menu bar to go to a related screen or detail screen. Select 
Display Explorer Menu Pane from the Options menu to use this method.

• Custom Toolbar Buttons
Create buttons on the toolbar for the screens you use most frequently. See Customizing the 
Toolbar for more information.

• Function keys
Press a Function key (usually F8, F9, or F10) to go to a related screen. Use the transport 
buttons or the selection list in the Function field to review the function keys available for a 
screen.

• Back button
Click Back to return to a screen you have viewed previously, or right-click to select a screen 
from the list of screens you have viewed previously. Detail screens appear grayed and cannot 
be selected from the list. 

- To view a detail screen, select the main screen listed below it and enter key field data 
values. From there you can access the detail screen.

You can open other applications, such as those in the Sales Order Processing (SOPM) and 
Sales Analysis (SAAM) modules, by using custom toolbar buttons.

Note: Remember to save any changes you have made before moving to a new screen. Data 
is not saved automatically when you change screens.

Entering, Editing, and Viewing Data
Fourth Shift is designed to allow you to enter and review business information quickly and easily. 
Most of the operations and techniques you need to use are typical for Microsoft Windows-based 
programs. However, there are some special considerations to keep in mind while using Fourth 
Shift.

Field Display and Editing
Each field has a label that describes the data in that field. Some field data can be changed, while 
some cannot. If you can change the data in a field, it is an open field. If you cannot change the 
data, it is a closed field.

Open Fields
Open fields allow you to update the information in the field as needed. A box appears on the 
screen for you to type into. In scrolling lines sections, open fields are shown in the active line only. 
Move to another line to see the open fields in that line.

The active field is the field you are entering data into, or are ready to enter data into. Many Fourth 
Shift features, such as Browse Windows and Field Help, are sensitive to the active field.
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You can make a field active by clicking it with the mouse. You can also move between fields by 
pressing Tab or Shift+Tab. For fast data entry, select the Auto Tab Between Fields option in the 
Options menu. When you select this option, the program advances to the next field automatically 
whenever a field is filled with data.

For more information, see Data Entry and Validation.

Open Fields with Selection List
Some open fields permit only a limited set of entries. These fields contain a small box in the lower 
right corner. When you move your mouse over the box, an arrow appears. Click the arrow to 
display the list of acceptable entries, which also shows a brief description of each entry. Select 
either the entry or the description to transfer the value to the field.

Note: If you are using Net UI, descriptions for the acceptable entries are displayed only if 
you have downloaded the Fourth Shift Application Help component.

Closed Fields
Closed fields display the data value but do not allow you to change it. In this way, you can see 
important information while the system is protected from accidental changes or deletions. A closed 
field can never be the active field.

Working with Key Fields
When you first go to a screen, usually only a small number of fields are open. These fields are key 
fields. You must enter values for the key fields before you can access the rest of the fields on the 
screen.

Select Save from the File menu, or press Enter, after entering the key field values.

• If the key field values already exist in the database, the rest of the fields on the screen show 
the current data related to the key fields. You may make changes to any open field.

• If the key field values do not exist in the database, a new record is created. Enter the 
necessary related data in the remaining open fields.

Remembered Fields
Fourth Shift helps you retain values for key fields when you move from one screen to another. 
Whenever possible, the value from the key fields are carried over to the key fields on the next 
screen. This remembered fields is always active and does not need to be specially configured.

For example, if you go from the CUID (Customer Master) screen to the COCD (Customer 
Orders by Customer ID) screen, the value from the active Customer ID field on the CUID screen 
is carried over to the Customer ID field on the COCD screen. You can access information about 
that customer on any screen that requires a Customer ID key field without retyping the Customer 
ID.

If the next screen uses a different key field — location instead of customer, for example — the 
Customer ID value is not carried over. Instead, it is "remembered" and used the next time you go 
to a screen that uses Customer Id as a key field. Remembered field values are forgotten when you 
exit Fourth Shift.

Data Entry and Validation
The data you enter is considered temporary until you save it to the database. When you do this, 
the system may verify that the data is acceptable. In general, the system validates the:

• format of the entry. For example, did you enter a number in a field requiring a number?

• logic of the entry. For example, is the beginning date earlier than the ending date in a range of 
dates?
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• consistency of the entry. For example, did you try to ship a customer order that is not ready to 
be shipped?

When a field entry is not acceptable, a message appears in the status bar and that field turns red 
and becomes the active field.

Data Format Types
Every field has a data format type, which defines how the data in that field is displayed, sorted, or 
used in calculations. The three main data format types are alphanumeric, numeric, and date.

• Alphanumeric fields can accept both letters and numbers, as well as most punctuation 
marks. Alphanumeric fields are not considered in calculations.

Alphanumeric fields can accept certain values (P, M or C, for example, to indicate purchasing, 
manufacturing or customer orders), or only a specific range of values. Although alphanumeric 
fields are not considered in calculations, some may accept numbers only.

The tilde (~) character is unacceptable and should not be used in data entry. Also, an 
alphanumeric field entry cannot have a quotation mark adjacent to a comma. This combination 
of characters causes processes that rely on log files or text file data extracts, such as data 
import and recovery, to malfunction.

• Numeric fields are used in calculations and can accept numbers and decimal symbols.

In some cases when dealing with very large numeric amounts, a closed calculated field will 
display asterisks (*) or scientific numbers instead of a value. This condition affects only the 
display of the value; the supporting data is not changed in the database.

• Date fields are entered in a six-digit format based on the date format configured for your site. 
For more information, see "Date and Number Formats" in the System Control manual.

The valid date range is January 01, 1980 through December 31, 2079.

Required Entries
Some field entries are required so that the system functions properly. If you omit an entry in a 
required field, the field turns red when you try to save the data and the message

Entry is required in this field

appears in the status bar. Enter the required information and try to save again.

Default Entries
Some fields may have system-assigned or user-defined default entries that provide automatic 
entries for data elements. These default entries appear in open fields every time you begin using, 
or refresh a screen. You can change or delete a default entry at any time. Initial default values are 
not restored if they are changed or deleted.

• System-assigned default values are set up on system or module configuration screens. 
Because they affect the entire system, modifications to these default values should be made 
carefully.

Other system-assigned default values are provided automatically by Fourth Shift. These defaults 
cannot be modified.

• User-defined default entries are set up using default masks. Some screens allow you to set 
up temporary masks for a limited set of fields to speed data entry. For more information, see 
Default Data Entry Masks.

Using default values can dramatically increase your data entry speed, especially when entering 
groups of related information such as items in the Item Master.

Additionally, some screens support DEFAULT records with specific identifiers which supply default 
entries for the screen. For example, the ITMB (Item Master) screen allows you to define a 
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DEFAULT-ITEM. Values from the DEFAULT-ITEM are used as default entries for all new items. 
The following DEFAULT records are available:

Error Messages and Indicators
When you try to save data that is unacceptable or incomplete, the system provides error 
messages, warnings and indicators to help you enter correct information.

When an error condition occurs, a message appears in the status bar at the bottom of the screen, 
describing the nature of the problem. The field or fields triggering the error turn red and the first 
field in error becomes the active field.

Sorting Alphanumeric Data
The sorting of data in alphanumeric fields is based on the standard ascending order of the initial 
character in the field. Fields starting with numbers are listed before those starting with letters, 
starting from the left.

Data Default Record ID Default Record Description

items 000000 DEFAULT-ITEM

workcenters 000000 DEFAULT-ITEM

vendors 000000 DEFAULT-VENDOR

customers 000000 DEFAULT-CUSTOMER

trade classes DEFAULT-CLASS default classification by industry type for customers

shipping addresses 000000 default ship-to

customer orders 000000 DEFAULT-ORDER

manufacturing orders 000000 DEFAULT-ORDER

purchase orders 000000 DEFAULT-ORDER

purchase order 
contracts

PRICE-QUOTE default contract by vendor

banks 00 default bank

tax codes 99 = state and federal
999 = county and 
municipal

DEFAULT TAX CODE

invoices Ref No = DEFAULT-
INVOICE
Ref Seqn = 0000

default invoice

credit memos Ref No = DEFAULT-
CR-MEMO
Ref Seqn = 0000

default credit memo

walk-in cash sales Ref No = DEFAULT-
WALK-IN
Ref Seqn = 0000

default walk-in cash sales

Product line DEFAULT-PROD-LN Default product line
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For example, the numbers 30, 60 and 360 are sorted differently if they are zero-filled from the left 
than if they are not.

Keep this sequencing in mind as you set up identifiers throughout the system.

Resizing Columns on a Screen
On screens that display data in tables or grids, you can resize the columns to view the full field. 
To resize columns:

1. Move your mouse pointer over the column divider line or grid of the table. 
The cursor changes to a double-headed arrow. 

2. Click and drag the double-headed arrow to resize the column ( ).

Column widths remain as set by the user after exiting the screen. 

- To reset the column widths to the original size, right-click on the grid and choose 
Restore Defaults Grid Layout.

Locating an Entry in a List
Many screens, such as the CUID (Customer Master) or ITMB (Item Master) screens, display lists 
that can be very long. On these screens, an open Starting field appears at the top of the screen. 

• Enter a value and press Enter. The line in the list that most closely matches your entry will be 
displayed. 

• Use the scrollbar or Up arrow and Down arrow keys to move through the list. This feature 
enables you to locate a particular entry in the list quickly.

• To see the first entry in the list, press Enter without making an entry in the Starting field. You 
can also see the first entry that begins with a particular number or letter by typing that 
character in the Starting field and pressing Enter.

Starting Over: Refreshing the Screen
You can return a screen to its initial state at any time by selecting Refresh from the Edit menu, or 
by pressing Esc. This clears all fields on the screen and allows you to enter new key values.

Note: If you have entered data on the screen but haven't saved it, those entries are lost 
when you refresh the screen.

Non-Zero-Filled Order Zero-Filled Order

30 00030

360 00360

60 00060
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Using the Mouse
You can use your mouse to complete the following actions:

System-wide Features
Fourth Shift offers a variety of system-wide features designed to provide flexibility and consistency 
across modules.

Printing and Generating Reports
Fourth Shift's reporting features are broad and robust. For example:

• Most Fourth Shift screens can generate one or more reports, many of which can be previewed 
before printing.

• Many batch process tasks generate reports that can be printed directly or saved as a file.  
Some external reports can be automatically sent to a business partner via email.

• You can specify report formats for selected print-outs. See the SQL Server System 
Administration Help for more information on these tools.

Automatic Email of Documents
Fourth Shift provides the ability to automatically email key business documents.  There are five 
primary areas of setup required to enable this feature:

1. Customer/Vendor - for each type of document which supports automatic email, indicate 
whether they desire email, print, or both 

2. Contacts - define and indicate if they wish to subscribe to receive specific documents for the 
customers or vendors that they are related to

3. Email Templates - define the actual subject and body of the email and whom it will be sent 
from

4. Email Infrastructure and Security - technical setup/configuration of email and necessary 
permissions

Action Description

Select a menu option Click any menu to open it; click a menu option to select it.

Select a toolbar button Click any toolbar or scrollbar button to perform the command.

Move to another screen Click any transport button to go to the selected screen, or select from 
the list in the Function field.

Go to an open field Click the field to move quickly to that field.

Select from a list Click any item in a selection list to insert data into to an open field.

Select a row Click anywhere in a scrolling lines section to go to the first open field in 
that row.

Select text Click and drag over text in an open field to select it, or double click in 
any open field to select an entire word.

Open the Pop-up menu Right-click anywhere to select an option from the pop-up menu.
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5. Batch Tasks - modify appropriate batch tasks (BSET) to include necessary parameters for 
generating emails

Customers and Vendors
The Vendor Report Option (VROP) screen in Purchasing and Customer Report Option (CROP) 
screen in Order Entry are used to maintain vendor /customer email preferences for all email 
enabled document types.  Available settings are:

• Email - desires email delivery of report; requires that at least one contact for the customer/
vendor is properly setup to receive emails for that report

• Print - desires printed delivery of report (the default)

• Both - desires printed delivery of that report but also email delivery if any contacts have 
requested an email copy

Contacts
Contacts are created and maintained on three different forms depending on the type of contact.  
On these forms, you are able to define basic information regarding the contact, including an email 
address, as well as indicate whether this contact wishes to subscribe to receive document emails.

• Customer Contact (CCOT), Customer Contact Detail (F8 from CCOT), and Ship To/Delivery 
Location Contact Detail (F9 from CCOT)

• Vendor Contact (VCOT) and Vendor Contact Detail (F8 from VCOT)

• Internal Contact (ICOT) and Internal Contact Detail (F8 from ICOT) 

Document email can be configured uniquely by document type for each customer/vendor and 
contact.  

Email Templates
Email Templates determine the message content and sender of the emails that are generated.  
Optionally, internal recipients can be configured on the email template to be copied on each email 
that gets sent to customer or vendor contacts.  Email templates are defined on the Email Template 
(ETPT) form in System Control.  Separate templates may be created for each type of document 
that can be emailed.  Multiple templates may be defined for each document type (for example, 
perhaps you want to use a different template for order acknowledgments during a sales promotion 
where information regarding the promotion is included in the body of the email).  The actual 
template used will be determined by the template name specified on the batch task that is run.

Email Infrastructure and Security
Microsoft SQL Server Database Mail

The technology used to enable emailing for this feature is Microsoft SQL Server Database Mail.  
SQL Database Mail requires that a mail profile be defined from which the emails are sent.  A 
default profile named FSMail is set up as part of the Fourth Shift server installation.  Your 
administrator can setup any number of additional profiles using SQL Server Management Studio.  

SQL Database Mail saves sent email in the msdb database, which is created during the SQL 
Server installation.  

Report Administrator Security

The user defined as the report administrator (shown on the Report Admin tab of the Fourth Shift 
SQL Administrator utility) needs to be a member of the DatabaseMailUserRole database role in 
the msdb database in order for batch tasks to successfully send email.  The server installation 
program does this automatically.  Also, if the Fourth Shift SQL Administrator utility is used to 
configure a different Fourth Shift report administrator user, the new administrator is configured 
properly to allow successful sending of emails by batch tasks.
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In addition, the user who is defined as the report administrator must have permission to use the 
Default Sender profile and also have read and write permissions to the folder specified by the 
AuxDataFiles or AuxRptFiles Fourth Shift configuration variables.

Batch Tasks
Add a parameter to each related Batch Task (BSET) if you wish to take advantage of the 
automatic email feature.  Each batch task has two new parameters:  

• Zxxx where xxx indicates the ID of the email template to be used

• X where X indicates that subscriber email should not be sent as a result of this run.  Email will 
only be generated for those individuals explicitly included on the email template.  This option is 
helpful when performing your internal testing of Fourth Shift's automatic email sending feature.

These parameters are now available with the following batch tasks to enable email of reports:

• Accounts Receivable Statements (ARST)

• Accounts Receivable Invoice Print (IVPR)

• Accounts Receivable Invoice Reprint (IVRR)

• Order Acknowledgements (BOPR - C (Customer Order) and P (Purchase Order) parameters)

In order to manage the database space required for sending email, the M option has been added 
to the RWFL (Database Table Row Purge) batch task so that sent email data stored in the Fourth 
Shift and msdb databases older then the specified number of days can be removed from those 
databases on a regular basis.

Viewing Status Messages
The status bar displays a single line of help pertaining to the active field when you select Field 
Action from the Help menu.

Messages are also automatically displayed in the status bar in two situations:

• Each time you enter a screen, the status bar message describes the first action to take.

• When you attempt an invalid entry, the status message describes the nature of the error.
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Selecting from a Browse List
When you are using the traditional Fourth Shift system, the Browse features provide a way for you 
to select an entry for the active field by choosing from a master list. For example, master list 
entries could come from your Item Master, Customer Master or Vendor Master. Where you need 
to enter an item identifier, for example, you can browse for it rather than entering it directly. Browse 
lists typically display identifiers and descriptions, so you are not required to memorize identifiers. 

When you are using Fourth Shift WebUI, the Find feature provides the method for selecting an 
entry for an active field. See Using the Find Feature for more information on using the searching 
within the Fourth Shift WebUI.

Browse Windows
You can open a Browse window from an active entry field by selecting Browse/Detail from the 
Tools menu, or by pressing Alt+F4. The Browse window contains the list of possible entries for 
that field. When you open a browse window from an entry field, the list begins with the value 
entered in the field, if any.

• Scroll up or down to the desired line and press Enter to select from the list. The Browse 
window closes automatically and your selection is transferred to the entry field.

• Press Esc to close a Browse window without making a selection.

• Press F5 to close a Browse window without making a selection and exit from the current 
screen.

From a Browse window for some master lists, you may be able to open a Browse Setup window, 
a Browse Detail window, or a Standard Text Detail window to get more information on the 
entries in the master list.

Browse windows are available in the following modules:

Module Browsing Available For

Accounts Payable (APSM) Banks
Contacts
Purchase Orders
Vendors
Vendor Invoices
Vendor Contacts

Accounts Receivable (ARSM) Banks
Contacts
Customers
Customer Orders
Items
Ship to Ids
Customer Contacts

Advanced Price Book (APBM) Price Books

Bill of Material (BILM) Items

Cash Management (CSHM) Banks

Configuration of Interface Account Numbers 
(CNFA)

Product Lines

Custom Products Manufacturing (CPMM) Customers
Customer Orders
Items
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Browse Detail Windows
The Browse Detail window displays detailed information about an entry in the master list shown in 
the Browse window. Press Alt+F4 from the Browse window to open the Browse Detail window. A 
selection for an entry field can also be transferred from the Browse Detail window.

General Ledger (GLSM) Banks

Inventory Control (INVM) Customer Orders
Items

Lot Trace/
Serialization (LOTM)

Customer Orders
Items
Manufacturing Orders
Purchase Orders

Manufacturing Order Management (MOMM) Items
Manufacturing Orders

Material Requirements Planning (MRPM) Customers
Customer Orders
Items
Manufacturing Orders
Purchase Orders
Vendors

Order Entry (CUSM) Contacts
Customers
Customer Orders
Items
Ship to Ids
Customer Contacts

Product Costing (PRCM) Items
Manufacturing Orders
Purchase Orders

Purchasing (PURM) Contacts
Items
Purchase Orders
Vendors
Vendor Contacts

Sales Order Processing (SOPM) Customers
Items

Shipping (SHPM) Customers
Customer Orders
Manufacturing Orders
Purchase Orders
Ship to Ids

System Control (SYSM) Buyers (Internal Contacts only)
Contacts
CSRs (Internal Contacts only)
Email Templates
Internal Contacts
Items
Templates

Module Browsing Available For
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• Press Enter to transfer the selection to the entry field and close the Browse Detail and 
Browse windows.

• Press Esc to close a Browse Detail window and return to the Browse window.

• Press F5 to close both the Browse Detail and Browse windows without making a selection 
and return to the Module Menu.

Since Browse Detail windows can contain information that all users should not necessarily be able 
to see, security can be assigned to the windows using access codes on the FCMT (Function 
Code Maintenance) screen. For more information, see the “System Administration” topic of the 
module manuals containing Browse Detail windows.

See also Browse Setup Windows.
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Browse Setup Windows
Some Browse windows also display a Browse Setup window. The Browse Setup window 
enables you to:

• locate a particular list entry or specify a starting point for the list

• select the sort order in which the browse list is displayed

• filter the information displayed in the list by specifying matching criteria

If you open a Browse window from an active field that contains no data, the Browse Setup 
window opens automatically. You can also open the Browse Setup window at any time by 
pressing ALT+S from the Browse or Browse Detail window.

Enter a value (or partial value) to start the master list in the Browse window. To close the Browse 
Setup window and return to the Browse or Browse Detail window, press Ctrl+Enter.

If the Browse Setup window allows you to specify a sort order for the master list, an asterisk (*) is 
displayed next to the sort option currently selected. You can select a different sort option for the 
master list by scrolling to the sort option desired and pressing the asterisk (*) key. Press the up 
arrow and down arrow to scroll in the Browse Setup window.

You can also use matching criteria to limit the number of lines included in the master list. Matching 
criteria can use any combination of alphanumeric characters and wildcard symbols. Wildcard 
symbols can be inserted anywhere in the search string and may be used as many times as 
needed. Entries that do not match the matching criteria are not displayed in the master list.

Several wildcard symbols are available for specifying matching criteria:

To search for one of the wildcard symbols as a regular character, precede the wildcard symbol 
with a backslash (\). To search for the backslash as a regular character, precede the backslash 
with another backslash (\\).

Wildcard symbols can be used independently or combined to create the master list desired. Here 
are some matching criteria examples:

Wildcard Purpose

* used to match any sequence of zero or more characters

? used to match any single character in a specific position

! used to select entries that do NOT contain the characters 
listed after the wildcard symbol

Desired List Search String Sample Match

All names listed as corporations Name = *CORP* ALLIED HDWRE CORP
ABC CORPORATIONS

Any names ending with INC Name = *INC JOHN’S TRUCKS INC
SMITH BROS INC

Any names including HARDWARE and 
DIST

Name = *HARD-
WARE*DIST*

XYZ HARDWARE DIST.
HARDWARE DIST-100

Ids starting with “MN” followed by 3 char-
acters ending with a zero

Id = MN???0 MN1000
MN2100
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Scroll to the matching criteria fields and enter a search string. To return to the Browse or Browse 
Detail window after specifying matching criteria or changing the sort option, press Ctrl+Enter. If 
you opened the Browse Setup window from the Browse Detail window, the Browse Detail 
window displays details for the first list entry that matches your search string.

Standard Text Detail Windows
The Standard Text Detail window displays the text messages attached to an entry in the master 
list. Press Alt+F8 to open the Standard Text Detail window from either the Browse or Browse 
Detail window. Security for the Standard Text Detail window is based on the security assigned 
for the Browse Detail window.

Any names that are not distributors Name = !*DISTRIB* ABC CORPORATIONS
JOHN’S TRUCKS INC

Any names with a distribution center using 
a ship to name DISTRIB*MAIN

Name = *DISTRIB\*MAIN* ABC DISTRIB*MAIN
XYZ DISTRIB*MAIN

Desired List Search String Sample Match
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Using the Text Features
The text features in Fourth Shift allow you to build a library of text messages to be printed on 
documents or displayed internally. 

Standard Text
The Standard Text feature allows you to build a library of text messages that can be used in 
multiple locations in the system. Text messages can be attached to records by entering an 
identifying text number.

Certain screens allow you to create or edit messages in a special text message area or from a 
Text Message window. Additionally, you can use the TEXT (Text Review) and TXWU (Text 
Where Used) screens to add, view, or modify existing messages in the library. You should 
periodically review the text messages in your system and delete any that are obsolete or unused.

For more information, see "Text Review" or "Text Where Used" in the System Control manual.

Usage
The following table lists the locations where text messages may be attached to records. 

• Source—the screen or task where the message originates or is displayed. 

• Text Type—indicates whether the message is associated with the manufacturing (M) or 
financial (F) library. 

• Destination—the screen or document where the message is transferred automatically. 

• Transfer Conditions—identifies the circumstances under which the message is transferred 
automatically to the Destination.

Source
Text 
Type Destination Transfer Condition

A/P Payment Detail n/a payment voucher always

APCW n/a payment voucher debit memo applied against invoice

APID n/a payment voucher always

APIE n/a payment voucher always

ARAD n/a printed statement based on oldest aging category with 
a balance for that customer

Bill of Material Detail M Picklist Detail always

CORV M displays on CORV only always

Contract Header Detail M header section of printed 
contract

POCF/Vendor Configuration: Print 
Standard Text on Ext Documents 
= Y

Contract Item Detail/
Pricing

M line item section of printed 
contract

POCF/Vendor Configuration: Print 
Standard Text on Ext Documents 
= Y 

Custom Product Com-
ponent Detail

M customer job summary; 
customer order picklist; 
customer order routing

always

Custom Product Detail:

- accessed from 
COMT

M order acknowledgement CNFG: Print Text on Ext Docu-
ments = Y
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- accessed from 
CPMT

M customer job summary; 
customer order picklist; 
customer order routing

always

Customer Financial 
Detail

M displays on Customer 
Financial Detail only

always

Customer Name/
Address Detail

M Customer Order Header 
Detail

always

Customer Order 
Header Detail

M order acknowledgement CNFG: Print Text on Ext Docu-
ments = Y

shipping summary; 
shipping invoice summary

SHCF: Carry CO Header Text For-
ward to SHIP Text = Y

CORV always

Invoice Header Detail F credit memo; invoice IVPR/IVRR task parameter

ITEM LOT RECEIPT 
window

M LMST LTCF: Carry Item Lot Trace Text 
Forward to Lot Master = Y

Item Master Detail M displays on Item Master 
Detail only

always

Item Lot Trace and 
Serialization Detail

M LMST LTCF: Carry Item Lot Trace Text 
Forward to Lot Master = Y

Item Master Planning 
Detail

M displays on Item Master 
Planning Detail only

always

Manufacturing Order 
Line Item Detail

M Line item section of printed 
manufacturing order

always

MOMT M MORV and header section 
of printed manufacturing 
order

always

MORV M displays on MORV only always

Packaging Detail: M

- header section 
text

packing list SHCF: Print Text From SHIP on 
Packing List = Y

- line item section 
text

box labels SHCF: Print Text From Package 
Detail on Box Label = Y

Picklist Detail M printed picklist always

Purchase Order 
Header Detail

M header section of printed 
purchase order

POCF/Vendor Configuration: Print 
Standard Text on Ext Documents 
= Y

Purchase Order Line 
Item Detail

M line item section of printed 
purchase order

POCF/Vendor Configuration: Print 
Standard Text on Ext Documents 
= Y

SBOL M printed Bill of Lading, ship-
ping summary, shipping 
invoice summary

SHCF: Print Text From SBOL on B/
L and Ship Lists = Y

Source
Text 
Type Destination Transfer Condition
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SHIP M packing list SHCF: Print Text From SHIP on 
Packing List = Y

Standard Product 
Detail

M order acknowledgement CNFG: Print Text on Ext Docu-
ments = Y

TEXT M or F any screen with Text No 
field

always

F customer statement ARST/ARBS parameter

F invoice IVPR/IVRR parameter

F credit memo IVPR/IVRR parameter

TXWU M or F any screen with Text No 
field

always

F customer statement ARST/ARBS parameter

F invoice IVPR/IVRR/IVEX/IVRX parameter

F credit memo IVPR/IVRR/IVEX/IVRX parameter

Vendor Configuration M displays on Vendor Config-
uration only

always

Vendor Master Detail M displays on Vendor Master 
Detail only

always

Vendor/Item Detail M displays on Vendor/Item 
Detail only

always

Source
Text 
Type Destination Transfer Condition
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Extended Text
The Extended Text feature enables you to enter descriptive, context-specific text messages. You 
can access an Extended Text window from selected screens for this purpose. Each extended text 
message can contain more than one page.

Since extended text messages are meant for specific information, such as a particular purchase 
order, they cannot be reused. However, global extended text messages can be included in 
context-specific extended text messages.

The following shortcut keys have a special meaning when editing extended text messages:

Usage
The locations where extended text messages may be attached are listed below. 

Source—the screen or task where the extended text message is entered. 

Destination—the screen or document where the message is transferred automatically. 

Transfer Conditions—identifies the circumstances under which the message is transferred 
automatically to the Destination.

Keys Description

Ctrl+Enter Save text

Esc Exit window without saving text

Alt+F4 Insert global extended text message

F6 • Add a new page of text prior to current page, while 
viewing a page of extended text. 

• Add a new global extended text message, when the 
global extended text Browse window is open. 

Ctrl+F6 Delete current page of text

Ctrl+Page Up Move up to a previous page of text

Ctrl+Page Down Move down to the next page of text; adds a new page if no 
page exists after the current page

Ctrl+Home Move to the first page of text

Ctrl+End Move to the last page of text

Source Destination Transfer Conditions

Contract Header Detail header section of purchase order 
contract

POCF/Vendor Configuration: 
Print Extended Text on Ext 
Documents = Y

Contract Item Detail/ Pricing line item section of purchase 
order contract

POCF/Vendor Configuration: 
Print Extended Text on Ext 
Documents = Y

Custom Product Detail (CUSM 
only)

order acknowledgement; invoice ARCF: Print Extd Text From 
CO = Y (invoice only)

Customer application (SOPM) displays on Customer application 
only
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Global Extended Text
The Global Extended Text feature allows you to enter descriptive text that can be incorporated 
into context-specific extended text messages. Use the TEXT screen to review global extended text 
messages, which are identified by Text Type = G.

Press Alt+F4 from the Extended Text window to insert global extended text into a context-specific 
extended text message. Unlike extended text messages, global extended text messages may not 
be longer than one page. Global extended text messages can be changed or deleted at any time 
without impacting any existing extended text messages.

Customer Order application 
(SOPM)

– Header order acknowledgement; invoice ARCF: Print Extd Text From 
CO = Y (invoice only)

– Line Grid Print CO Extd Text = Y (ARCF)—
invoice only

order acknowledgement; 
invoice

Customer Financial Detail displays on Customer Financial 
Detail only

Customer Order Header Detail order acknowledgement; invoice ARCF: Print Extd Text From 
CO = Y (invoice only)

packing list SHCF: Print Extd Text on 
Shipping/Packing Lists = Y

Invoice Header Detail displays on Invoice Header Detail 
and ARCR only

LMST displays only on LMST

Purchase Order Header Detail header section of purchase order POCF/Vendor Configuration: 
Print Extended Text on Ext 
Documents = Y

Purchase Order Line Item Detail line item section of purchase 
order

POCF/Vendor Configuration: 
Print Extended Text on Ext 
Documents = Y

SBOL shipping invoice summary; ship-
ping summary

SHCF: Print Extd Text on 
Shipping/Packing Lists = Y

invoice ARCF: Print Extd Text From 
SBOL = Y

packing list SHCF: Print Extd Text on 
Shipping/Packing Lists = Y

Standard Product Detail order acknowledgement; invoice ARCF: Print Extd Text From 
CO = Y

Source Destination Transfer Conditions
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Global Extended Text
The Global Extended Text feature allows you to enter descriptive text that can be incorporated 
into context-specific extended text messages. Use the TEXT screen to review global extended text 
messages, which are identified by Text Type = G.

Press Alt+F4 from the Extended Text window to insert global extended text into a context-specific 
extended text message. Unlike extended text messages, global extended text messages may not 
be longer than one page. Global extended text messages can be changed or deleted at any time 
without impacting any existing extended text messages.
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Using the Shop Calendar
Use the Shop Calendar to record your company’s policy on shop days and non-shop days. The 
Shop Calendar is a key element for accurate planning because it is used when determining MRP 
planning schedules. It is recommended that you set up the shop calendar for at least one year to 
accurately reflect your planning horizon. The possible date range is 01/01/1980-12/31/2079. It is 
recommended that you use a four-digit year, such as YYYY, when setting up the Windows Short 
Date format. 

The shop calendar considers all weekdays to be shop days and weekend days to be non-shop 
days until you specify differently. After changing shop and non-shop days, the system adjusts all 
planned activities, such as MRP planned orders, accordingly. To toggle a date from a shop day to 
a non-shop day, double-click the date or press the space bar. 

When the Shop Calendar is open, any task that places an exclusive lock on the manufacturing 
data group cannot be processed. For example, when the Shop Calendar is open, you cannot run 
the PLNG (MRP Planning) task.

A simulated planning calculation, based on shop days, is available by specifying a combination of 
start date, end date, or number of shop days. 

Feature Access
The Shop Calendar can be accessed from the Start menu or from the toolbars within Fourth Shift 
Engineering MMAM and SFRM modules. 

- Click Start then point to Programs—(the folder that contains the Fourth Shift 
group)—Shop Calendar

When accessed, the Shop Calendar is in inquiry mode and updates to the Shop Calendar are not 
allowed. If you are assigned the CLD1 function code, you will have read and update permission to 
Shop Calendar; otherwise this feature is in a read-only mode.

Feature Layout
Shop Calendar is divided into sections that include:

Section Description

Monthly Calendar Used to navigate through your shop calendar month-by-month. Today’s date is 
circled for your reference.

Calculation Method Used to select the method to calculate shop days, either by start date, end date 
or number of shop days.

Calculation Criteria Used to enter criteria that is used during the simulated calculation, including start 
date, end date or number of shop days. 

• Click Calculate to begin the simulation.

Buttons

OK Use this button to close the Shop Calendar and save your changes. 

Cancel Use this button to close Shop Calendar without saving your changes.

Apply Use this button to save your changes but without closing the Shop Calendar.
After clicking  Apply, the following message is displayed: Updated successfully. 

The Apply button will be:
• inactive, if no changes are made to the calendar. 

• active, after a change is made to the calendar. 

• inactive again after clicking Apply and the data is saved.
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Shop Calendar has the following menu options:

Shop Calendar Tips
Shop days are displayed in a highlighted or bold font. Non-shop days are displayed in a regular or 
non-bold font.

To update the Shop Calendar, you must be assigned the CLD1 function code, and therefore have 
security to update the Shop Calendar. After updating the Shop Calendar, the calendar goes back 
into the inquiry mode—the Apply button is inactive.

Shop day calculation methods include:

• by a specific start date

• by a specific end date

• by a specific number of shop days

The Shop Calendar is a useful tool that can be used by external applications, such as Microsoft 
Excel or Word. 

We recommend that you set up the shop calendar for at least one year to accurately reflect your 
planning horizon. Remember you can make changes to your shop calendar at any time, if 
necessary.

Calculate Shop Days
To calculate shop days, do the following: 

1. Click Start then point to Programs—(the folder that contains the Fourth Shift group)—Shop 
Calendar.

2. Go to the month you want to work with to calculate shop days.

3. Select the calculation method.

4. Enter the calculation criteria.

5. Click Calculate to simulate shop days calculation.

Change Shop Days
To change shop days, do the following:

1. Click Start then point to Programs—(the folder that contains the Fourth Shift group)—Shop 
Calendar.

2. Go to the month needing shop day changes.

3. Go to the specific date to change.

4. Double-click the date or press the space bar to toggle a date from a shop day to a non-shop 
day.

The date changes from a bold black font to grey.

5. Click Apply or OK to save your changes.

Menu Option Description

File Exit Closes the Shop Calendar.

Help Help Topics Opens the online Help.

About Shop 
Calendar

Displays information about the release level and name of the application.
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Using the Currency Information Window
If your Fourth Shift system includes the Multi-Currency Management (MCMM) module, many 
monetary values can be displayed in either local or foreign currency. Whenever you review or 
update monetary values using a foreign currency, the currency information window is displayed. 
This window is displayed over the system date in the upper right section of the Fourth Shift 
window.

The currency information window shows the following details:

• description of the currency currently used to display monetary values

• current exchange rate between the local and foreign currencies

• whether the customer, vendor or transaction is controlled by the local or foreign currency

Press Alt+C to toggle all monetary values on the screen between the local currency and the 
foreign currency. For more information on using multi-currency features, see "Suggestions for 
Using the Module" in the Multi-Currency Management manual.

Controlling Currency
The controlling currency that is displayed in the currency information window is related to the 
header section of the screen you are viewing. This does not change between header and scrolling 
lines sections.

• If the header section shows customer information, the currency information window displays 
the controlling currency of the customer.

• If the header section shows vendor information, the currency information window displays the 
controlling currency of the vendor.

• If the header section shows transaction information, or if the screen has no header section, the 
currency information window displays the controlling currency of the active transaction.

Euro Triangulation
For EMU (Economic and Monetary Union) transactions that require triangulation through the euro 
currency, both exchange rates of the triangulation calculation are displayed in the currency 
information window at the same time. When you press Alt+C, the toggled currency is highlighted 
to indicate which currency is being displayed on the screen. For more information on the Economic 
and Monetary Union, see "EMU Requirements" in the Multi-Currency Management manual.
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Mass Maintenance Actions
Use the Mass Maintenance Menu window to select an action such as mass addition or deletion. 
Mass maintenance actions are screen-specific. Each Mass Maintenance Menu window displays 
only the actions available on the current screen. 

To open the Mass Maintenance Menu window, do one of the following:

• Select Mass Maintenance from the Tools menu

• Press Alt+M

• Press Alt+F4 with the cursor in the Mass Maintenance field, if available

A Selection Criteria window, used to select or mark mass maintenance groups, is displayed 
based on the mass maintenance action. For example, a Selection Criteria window is used to 
mark orders for inclusion on a consolidated picklist for a customer shipment based on user-defined 
criteria such as Customer ID or Shipping Location.

Asterisk symbols (*) indicate which lines on a list have been marked for a mass maintenance 
action. Use the asterisk key (*) to mark or unmark individual lines.
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Default Data Entry Masks
Use the Mask Setup window as a tool to enter repetitive or similar data. The Mask Setup window 
allows you to match specific data entry requirements character by character. You can specify 
which characters are copied from the previous line, which characters are blank, and where the 
insertion point should start in each new line. The mask can be modified throughout the data entry 
session to meet changing needs.

Activate a Default Mask
When you first enter a screen, the default mask is not activated. 

• To activate the default mask and open the Mask Setup window, do one of the following:

- Select Default Setup from the Tools menu

- Press Alt+S

A mask line, matching the entry line on the previous screen, is displayed with the letter D in each 
character position.

You can use the following symbols to design your entry line by designating which characters 
should be defaulted from the previous line. Each position in the mask line must be filled with one of 
the valid symbols.

Deactivate a Default Mask
Deactivate the default mask by pressing Esc to refresh the screen or by opening the Mask Setup 
window and entering the letter B or a blank in each position in the mask line.

Usage
The Mask Setup window is available for the following data:

Symbol Description

D Default the character from the previous line to this position.

B or
(blank)

Clear this position.

C Clear the position and place the insertion point in this position for new 
lines.

P Default the character from the previous line and place the insertion 
point in this position for new lines.

Data Module(s) Screen

components BILM
PRCM

BILL

customer order lines CUSM COMT

inventory adjustments INVM INVA

inventory moves INVM IMTR

purchase order lines PURM POMT
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Master Account Number Masks
The master account numbers used throughout the system must match the Master Account 
Number Mask set up on the GLCF (G/L Configuration) screen. If hyphens are included in the 
mask, the system accepts a numbers-only entry and formats the master account number using 
hyphens based on the mask.

Master account numbers are also validated so that the following conditions are met:

• The organization portion, if any, is defined on the GLOS (G/L Organization Structure) 
screen.

• The account portion is defined on the GLCA (G/L Chart of Accounts) screen.

• The account is active.

• The account is set up as a posted account.

• The master account number is open.
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Menus and Button Bars
Most of the actions and features in Fourth Shift can be completed or accessed from menus and 
button bars.

Menus
The menu bar at the top of the Fourth Shift window contains lists of commands or actions that you 
can complete. Each of the five menus — File, Edit, Tools, Options, and Help — can be opened 
using either the keyboard or mouse. Click the menu title to view the options in each menu. Click on 
a menu option to start the action listed.

You can choose any menu option with the keyboard by pressing Alt+ the letter underlined in the 
menu name to open the menu. Press the letter underlined in the option name to select the option.

You can open a pop-up menu by clicking the right mouse button anywhere. The pop-up menu 
contains some of the most commonly used standard menu options.

Menu options may not always be available. If an option is unavailable, the text is grayed and the 
option cannot be selected.

Button Bars
Fourth Shift contains three button bars that make it easy for you to access useful program 
features.

• The toolbar provides a quick way to access some of the most frequently used commands and 
features. It is displayed horizontally beneath the module name and menu bar.

• The scroll bar provides a quick way to move around on large and complex screens. It is 
displayed vertically along the right side of the window.

• Transport buttons allow you to navigate quickly to related or detail screens. It is displayed 
near the bottom of the explorer menu pane.

You have the option of hiding or displaying each of these button bars. Select your preferences 
from the Options menu.

File Menu

Edit Menu

Menu Option Description

Save Data Saves data on the screen to the database

Print Preview Generates a screen report and displays it using the Fourth Shift Report Viewer

Print Prints a screen report using the selected printer and printing options

Exit Closes Fourth Shift

Export

Menu Option Description

Undo Field Returns the field data to the previous entry in the field
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Tools Menu

Options Menu

Refresh Resets all fields and returns the screen to its initial state

Cut Removes highlighted text and copies it to the clipboard

Copy Copies highlighted text to the clipboard

Paste Inserts the text from the clipboard at the insertion point

Delete Removes highlighted text

Clear Field Clears the value from the active field

Add Data Adds a new line or section for data entry on screens where detail can be added

Delete Data Deletes the line or data entry section containing the active field

Menu Option Description

Browse/Detail Opens a window displaying a list of available values or additional detail about the 
information currently displayed

Currency Display Toggles the values displayed on the screen between local currency and foreign 
currency

Default Setup Opens a setup window which allows you to define a set of values to reduce data 
entry effort

Extended Text Opens a window which allows entry of multi-page text messages

Mass Maintenance Allows you to update multiple records at once

Add Data Adds a new line or section for data entry on screens where detail can be added

Delete Data Deletes the line or data entry section containing the active field

Shop Calendar Opens the Shop Calendar

Report Viewer Opens the Fourth Shift Report Viewer to view a saved report file

Menu Option Description

Display Toolbar If selected, displays the toolbar

Hide Toolbar If selected, hides the toolbar

Auto Hide Toolbar If selected, displays the toolbar only when you move the mouse pointer to the top 
of the window

Display Explorer 
Menu Pane

If selected, displays the menu pane with transport buttons at the bottom of the 
pane

Shortcut Keys on 
Hyperlinks

If selected, displays shortcut keys on transport hyperlinks

Menu Option Description
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Help Menu

Pop-up Menu (from right mouse button)

Auto Tab Between 
Fields

If selected, automatically moves to the next field whenever a field is filled with 
data

Title Case for Labels If selected, displays screen field labels in Title Case; if not selected, displays 
screen field labels in UPPER CASE; all data entries remain in uppercase

Primary Font Allows you to select a standard font to display most screens and data

Fixed Width Font Allows you to select a fixed width font to display certain features which require 
fixed width fonts

Customize Toolbar Allows you to change and add options on the toolbar

Menu Option Description

Screen Help Displays context-sensitive online help for the screen

Field Action Displays the message about the active field or performs and displays calcula-
tions related to the active field

Keyboard Shortcuts Displays shortcut keys available for quick access to Fourth Shift commands and 
features

Using Fourth Shift Displays information on using Fourth Shift

Net UI Help Displays information on using a "thin client" installation

About Fourth Shift Displays the release level and name of the application

Menu Option Description

Undo Field Returns the field data to the previous entry in the field

Cut Removes highlighted text and copies it to the clipboard

Copy Copies highlighted text to the clipboard

Paste Inserts the text from the clipboard at the insertion point

Delete Removes highlighted text

Clear field Clears the value from the active field

Add data Adds a new line or section for data entry on screens where detail can be added

Delete data Deletes the line or data entry section containing the insertion point

Browse/Detail Opens a window displaying a list of available values or additional detail about the 
information currently displayed

The following menu options are also available: Restore Default Grid Layout, 
Restore All Defaults, Screen Help, Field Property

Menu Option Description
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Toolbar
The toolbar appears below the menu bar at the top of the application window. The toolbar 
provides a quick way to access some of the most frequently used commands and features. 
Toolbar buttons and tooltips appear automatically when you move your mouse over the toolbar.

The toolbar is displayed by default. You can use the options on the Options menu to hide the 
toolbar completely, or set it to "auto hide" so that it is displayed only when your mouse is 
positioned over the upper portion of the window.

You may also customize the toolbar by adding or removing buttons and button separators. For 
more information, see Customizing the Toolbar.

The default toolbar buttons include:

Button Description

FS Explorer Displays the Fourth Shift Explorer

Back Return to the previous screen

Explorer menu pane Display/hide explorer menu pane

Export Exports data

Go To Navigates to any screen or task by function code

Save Data Saves data on the screen to the database

Print Prints a screen report on the default printer set up for your workstation

Print Preview Generates a screen report and displays it using the Fourth Shift Report Viewer

Cut Removes highlighted text and copies it to the clipboard

Copy Copies highlighted text to the clipboard

Paste Inserts the text from the clipboard at the insertion point

Shop Calendar Opens the Shop Calendar

Screen Help Displays context-sensitive online help for the screen
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Scroll Bar
The scroll bar appears vertically along the right side of the application window. It provides a quick 
way to move around on large and complex screens such as Scrolling Lines screens. Scroll bar 
buttons and tooltips appear automatically when you move your mouse over the scroll bar.

The scroll bar is displayed by default. Use the option on the Options menu to hide the scroll bar.

Use the scroll bar buttons to:

• move quickly between the header and line item sections of a screen

• move quickly through lines or pages of lines within a list or a line item section

• save data

The scroll bar buttons include:

Transport Hyperlinks
Transport hyperlinks appear below the menu portion of the menu pane. They enable you to 
navigate quickly to related or detail screens. You have the option of displaying shortcut keys on 
transport buttons.

Each screen has its own set of transport Buttons. The screens that appear on the transport 
buttons are also listed as selections from the Function field.

Button Description

Header Section Moves to the Header section of a Scrolling Lines screen

To Top Moves to the first item in a list, or to the first line in a Scrolling Lines screen

Page Up Displays the previous set of lines in a list or Scrolling Lines screen

Up One Line Moves to the previous item in a list, or to the previous line in a Scrolling Lines 
screen

Down One Line Moves to the next item in a list, or to the next line in a Scrolling Lines screen

Page Down Displays the next set of lines in a list or Scrolling Lines screen

To Bottom Moves to the last item in a list, or to the last line in a Scrolling Lines screen

Line Item Section Moves to the Line Item section of a Scrolling Lines screen

Enter Saves data on the screen to the database
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Changing the Look and Feel
Fourth Shift provides a number of opportunities for you to personalize the way the program looks 
and operates. For example, you can:

• use the options in the Options menu to hide and display button bars or to change the 
program's appearance.

• customize the toolbar by adding or removing buttons.

• create links to Fourth Shift screens or to any program on your workstation using the Fourth 
Shift Explorer. See Exploring By Link for more information.

There are several other features that allow you to change the look and feel of the program.

Using the Fourth Shift Color Scheme
If you want, you can choose to use the coordinated Fourth Shift Tan desktop color scheme 
installed with Fourth Shift. The scheme alters the color of many elements of your desktop, 
including window titles, backgrounds and borders, to coordinate more closely with the Fourth Shift 
program. If you use this scheme, it will affect every program that runs on your computer.

The Fourth Shift program responds to most Appearance settings defined in the Display Control 
Panel.

Removing Graphical Borders
Graphical borders are the shadow or 3D effect used around open entry fields. Removing the 
graphical border will reduce the size of the window, allowing you to use a larger font.

For example, if you wish to a font size such as 10 point, the overall size of the window may exceed 
the available viewing area in 800x600 resolution. Removing the graphical border may allow you to 
retain the other two settings.

Selecting Fonts
Fourth Shift uses two different fonts to display screens and other information: a primary font and 
a fixed-width font. Most screens are displayed using the primary font selected for your 
workstation. Some windows, however, such as the help windows and browse windows, must use 
a fixed width font to display information.

You can select any font installed on your workstation to be your primary and fixed width fonts. The 
font you select affects only the displayed font, not printed reports. The recommended fonts are:

If you change the size of your primary or fixed-width font, the Fourth Shift window will automatically 
resize to accommodate the change. Depending on the capabilities of your monitor, you may not be 
able to view an entire screen if your font size selection is too large.

For information on changing fonts on printed reports, see Adjusting Report Fonts and Margins.

Type Font Size

Primary font MS Sans Serif 8

Fixed width font Terminal 9
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Customizing the Toolbar
You can customize the toolbar by adding, deleting or rearranging buttons. For example, you can 
create buttons to access a menu option, run a program or execute a sequence of keystrokes. You 
may find it especially useful to create Transport toolbar buttons that automatically go to the 
screens you use most frequently. Additionally, you can change the icon or tooltip of any toolbar 
button, or organize buttons onto multiple toolbars and rearrange them on your screen.

There are four different types of toolbar buttons available.

Predefined
A Predefined button type is used for toolbar buttons that invoke a standard Fourth Shift menu 
option.

To create a Predefined button, select the Predefined option and choose an action from the list 
provided.

Two special kinds of Predefined buttons are separators and new toolbars. Each is used to 
organize toolbars and group related buttons.

• Use a separator to insert a vertical line between two buttons.

• Use a new toolbar to create a new "band" of buttons that can be repositioned within the 
application window. You may move toolbars horizontally or vertically within the region beneath 
the application bar.

• If you enter a Title for a new toolbar, it will appear to the left of the first toolbar button. 

Transport
A Transport button type is used for toolbar buttons that go to a Fourth Shift screen or task.

To create a Transport button, select the Transport option and enter a Function Code. If the 
Function Code is not valid, an error message is displayed when you try to use the button.

Run Program
A Run Program button type is used for toolbar buttons that run or execute a program. It acts like a 
shortcut to another Windows application or document.

To create a Run Program button, select the Run Program option and enter a Command line. The 
command must run an executable (*.EXE) program. Parameters may be included in the command 
line.

Keystrokes
A Keystrokes button type is used for toolbar buttons that execute a predefined sequence of 
keystrokes.

To create a Keystrokes button, select the Keystrokes option and enter an Input value.

• The input value you enter is automatically processed when you click the button. Be sure to 
input the same keystrokes as you would on a keyboard, including tabs between fields.

• Special keys are not case-sensitive.

• If you are including data values in a sequence of keystrokes, use {Ctab} instead of {Tab} to 
move between fields. {Ctab} inserts the tab only if an Auto Tab Between Fields did not occur.

• The keystroke sequence can include literal keyboard characters such as a function code, or 
special keys such as the Tab key. Special keys are entered in braces. For example, to 
transport to the BILL screen and display the item 19-FRAME, enter the following as the 
keystroke input: {Home}{Home}BILL{ESC}19-FRAME{CR}. See the following list of special 
keys.
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The special key values available for use with the Keystrokes button include the following:

Keys Key Value

Alt+Backspace {@BS}

Alt+Enter {@CR}

Alt+Function key {@F1}, {@F2}, {@F3}, etc.

Alt+Tab {@Tab}

Backspace {BS}

Backtab {Btab} or {*Tab}

Ctrl+Break {^Break}

Ctrl+Delete {^Del}

Ctrl+Down arrow {^Dn}

Ctrl+End {^End}

Ctrl+Enter {^CR}

Ctrl+Function key {^F1}, {^F2}, {^F3}, etc.

Ctrl+Home {^Home}

Ctrl+Insert {^Ins}

Ctrl+Left arrow {^Lt}

Ctrl+Page Down {^PgDn}

Ctrl+Page Up {^PgUp}

Ctrl+Print Screen {^PrtSc}

Ctrl+Right arrow {^Rt}

Ctrl+Up arrow {^Up}

Cursor Left arrow {Lt}

Cursor Right arrow {Rt}

Delete {Del}

END {End}

Esc {ESC} or {Escape}

Enter {CR}

Function keys {F1}, {F2}, {F3}, etc.

Home {Home}

Insert {Ins}

Page Down {PgDn}

Page Up {PgUp}

Shift+Function key {*F1}, {*F2}, {*F3}, etc.

Space bar {Sp} or {Space}
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Web Address URL
A Web Address URL button type is used for toolbar buttons that execute a Web-based program, 
such as Fourth Shift Report Model, My Fourth Shift Workplace, etc.

To create a Web Address URL button, select the Web Address URL option and enter the 
program URL. For example, to create a button for My Fourth Shift Workplace, enter:  http://
<machine name>.<domain name>.com/fsportals.

Changing Field Name Labels
Important: Changes to any Fourth Shift field name label affect every Fourth Shift user.

Screen labels (also known as field names) can be changed or even hidden using the Screen 
Customizer (SCRM) module. Typically, administrators use this feature to align standard Fourth 
Shift terms with industry-specific vocabulary. 

If your field name labels have been modified with Screen Customizer, the labels on your screen 
may not match certain Fourth Shift features such as online help and printed reports. Generally, 
screen customizations are limited to the screens displayed in the Fourth Shift program only. They 
are intended to allow a business to tailor Fourth Shift terminology to meet specific needs.

For more information on changing field names, see the Screen Customizer manual.

Tab {Tab}

Tab (but not if the previous character triggered an 
Auto Tab Between Fields)

{Ctab}

Keys Key Value
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Using Shortcut Keys
Entering and editing data

Moving within a screen

To... Press...

Copy selected text to the Clipboard Ctrl+C

Cut selected text to the Clipboard Ctrl+X

Paste text from the Clipboard Ctrl+V

Clear the value from the active field F1

Undo the most recent typing Ctrl+Z

Add a new line or section on screens 
where detail can be added.

Add a Standard Text number. 

View Text Message content (use if  the 
text number already exists and the screen 
does not automatically display the text 
message). 

F6

Delete the line or section containing the 
active field

Ctrl+F6

Reset all fields and return the screen to its 
initial state

Esc

Save data to the database Ctrl+S      or
Enter

To... Press...

Go to the Function field Home+Home

Go to the last open field on the screen End+End

Go to the beginning of the active field Home

Go to the end of the active field End

Go to the first line in a list Ctrl+Home

Go to the last line in a list Ctrl+End

Go up one line in a list Up arrow

Go down one line in a list Down arrow
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Moving between screens

Special features

Note: Commands for extended text functions are described in Extended Text.

To... Press...

Go to the function code entered in the 
Function field

Esc

Go to a related screen or window F8
F9
F10
Alt+F8
Alt+F9
Alt+F10

Go to the module menu for the module 
containing the active screen

F5

Go back to the previous screen Back button

To... Press...

Print a screen report F7

Open a Browse window Alt+F4

Close a Browse window after making a 
selection

Ctrl+Enter

Edit Contact Notes or Email Body on the 
screen

Ctrl+T
(only available on CCOT/VCOT/ICOT 
details screens, and ETPT)

End a search in the Browse window Space bar

Toggle currency values between local cur-
rency and foreign currency

Alt+C

Open an Extended Text window, 
Contact Notes, or Email Body

Alt+T

Open a Mass Maintenance window Alt+M

Open a Default Setup window Alt+S

Move a graphic symbol to the left Ctrl+Left arrow

Move a graphic symbol to the right Ctrl+Right arrow

Open a drop-down menu Ctrl+Down arrow
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Fourth Shift R7.50 Help Basics
This document describes the organization and features of the help system for Fourth Shift R7.50.

Help Content Organization
All six sections of Fourth Shift Help are available from the Help menu in the Fourth Shift 
application and also from Start> Programs > Fourth Shift (system name) > Help. The sections 
are:

• Financial Help

• Manufacturing Help

• System Help

• Foundation Business Views Help

• FS Tables Help

• Data Export Information Paths Help

Help for a specific Fourth Shift screen can be accessed by pressing F3.

Help Window
The Fourth Shift Help window has two sections: the Contents pane (on the left) and the Topic 
pane (on the right). The Contents pane can be hidden with the Hide button.

• The Topic pane contains blue navigation buttons in the upper-right corner and lower-left 
corner to browse through help topics in a module.

• The Help window can be resized with the maximize/minimize button or by dragging the outside 
borders of the window.

Fourth Shift Financial Help
The purple books in the Financial Help represent the modules used by financial and accounting 
functions. To view the topics in a module, click the + symbol to open the book.
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Fourth Shift Manufacturing Help Topics
The purple books in the Manufacturing Help represent the modules used by manufacturing 
functions. To view the topics in a module, click the + symbol to open the book.
Fourth Shift Basics 49



Fourth Shift Release 7.50 Fourth Shift R7.50 Help Basics
Fourth Shift System Help Topics
The purple books in the System Help represent the modules used by system administrator 
functions. To view the topics in a module, click the + symbol to open the book.
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Search
When you are using the Search tab, note that you are searching only within the help section that is 
displayed in the blue title bar of the help window. The six help sections are:

• Financial modules

• Manufacturing modules

• System modules

• Foundation Business Views

• FS Tables

• Data Export Information Paths
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Search Tips
Follow these guidelines for more efficient searching in Fourth Shift Help:

• Use quotes to group words in the exact order, for example: “lot trace assignment.”

• Use upper or lower case letters. Search strings are not case sensitive, for example, “LOT 
TRACE” produces same search results as “lot trace.”

• Click  at the right of the search field to add one or more of the following words to your search 
strings to refine your search:

- AND (doesn’t have to be uppercase), example: buyer AND messages

- OR

- NEAR

- NOT

• Use the asterisk (*) as a wildcard for one or more characters.

• Use the question mark (?) as a wildcard for a single character.

• Use the additional options at the bottom of the Search tab to find similar words, words only in 
titles, or to search in the previous search results.

On the Search tab, type the word or words 
you wish to find and either click the List 
Topics button or press Enter.

To select a topic from the search results, 
either select the topic and click the Display 
button or double-click on the results.

Click the Locate button in the Help window 
to redisplay the Contents tab and locate the 
topic you selected in the index.
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Note: The Match similar words option uses Western-language rules for determining 
suffixes and finds all occurrences of a given word that include common suffixes. For 
example, a search for “run” will find words such as “run,” “running,” and “runner.” The 
word “runtime” will not be found.

Search Results and Ranks
To view the text of the search results, you may resize the Help window in any of the following 
ways:

• Maximize the entire Help window

• Enlarge the Search tab by clicking and dragging right margin to resize the pane

• Resize the Title, Location, and Rank column headings on the Search tab

• Resort the search results by clicking on the Title or Location column headings (the system 
default sorts the results by rank)

The maximum number of search results displayed is 500.

Search results are ranked by the number of times the search term is found within a topic.

Search results are highlighted in the Topic pane when the Search Highlight feature is on in the 
Options menu of the Help window. You can scroll through the Topic pane to locate the highlighted 
results.

You may also turn off the Search Highlight feature on the Options menu of the Help window. This 
is useful if you are using the Find (Ctrl+F) function to find text on a page.

Favorites
To bookmark or save help topics that you use frequently, navigate to the help topic. Then click the 
Favorites tab. At the bottom of the tab, click the Add button to add the topic to your favorites list.

Note: Favorites are stored separately for each of the six help sections.

Index
The Fourth Shift Help index contains topic headings. This makes the index function like an 
alphabetical table of contents. 

To select a topic from the index, either select the topic and click the Display button or double-click 
on the heading.

Click the Locate button in the Help window to redisplay the Contents tab and locate the topic you 
selected in the index.
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Custom Site Help
Custom Site Help is a feature designed to allow Fourth Shift customers to write and access their 
own company-specific help directly from the Fourth Shift application. Custom Site Help files are 
accessed from each Fourth Shift help screen by clicking the Custom Site Help button. These files 
can be created with any HTML editor or can be pages that link to a company intranet. See the 
section “Customizing Site Help” in the System Administration manual for more information about 
creating and publishing Custom Site Help.

Custom Site Help is available from all Fourth Shift screens and from all Fourth Shift interfaces, 
including My Fourth Shift Workplace. If the customer has not created a Site Help file for a screen, 
the Custom Site Help button displays the About Site Help page. 

Print Library
Each topic has a Link to Print Library button. This links to the contents page for the list of help 
documentation available in PDF format that can be displayed with Adobe Reader (Version 7.0.5 or 
higher recommended).

All help topics available in the help are also available in printable PDF format. There are a few 
manuals that are available in PDF only. 

Printing Help
There are several options for all Fourth Shift users for printing help topics:

• Click the Printable Module Help button to print the PDF version of a module’s help from the 
Overview page (first page) of the help. This button is only available on the first page of a 
module’s help. Print the entire manual or individual pages from Adobe Reader.

• Click the Link to Print Library button from any help topic to go to the list of PDF manuals 
available. Select the link for the manual to print and choose to print the entire manual or 
individual pages in Adobe Reader.

• Go to any help screen (either from the Help menu or press F3 from a Fourth Shift screen), and 
choose the Print button from the Help window. Choose to print either the selected topic or the 
selected heading and all subtopics.

Note: The selection for Print the selected heading and all subtopics prints the help for the 
entire module.
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• Highlight text in the help window and right click on the text. Choose Print and in the Page 
Range section, click the Selection button.

• Highlight text in the help window and copy it and paste it into another document or e-mail.
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Using Net UI
The Net UI feature, installed with the Net UI (NUIM) Module, provides alternate methods for using 
Fourth Shift, including across an Internet, intranet or remote dial-up connection. Net UI can also be 
used across a local area network (LAN) to improve performance by eliminating much of the 
network traffic.

This section describes the ways you can access Fourth Shift using Net UI, and some of the 
differences you will see when using Fourth Shift from a Net UI-enabled client. For detailed 
information on installing and administering Net UI, see the Net UI manual.

Net UI Configuration
The Net UI Module expands the traditional Fourth Shift client/server architecture to allow the 
server to act as a "host" to a client connection. The client connection is hosted by Net UI Server 
software installed with the traditional Fourth Shift server software. The main result is dramatically 
improved performance for clients, especially remote clients, because the client is used only to 
display the program. Complex processing occurs on the server-hosted client session.

Net UI clients and traditional Fourth Shift clients (using the main Fourth Shift program) can access 
a Fourth Shift server at the same time.

A Net UI configuration looks similar to:

Client Types
In general, there are two categories of Net UI users: local and remote.

• Local users are connected directly to the local area network (LAN). No special dial-up or 
other connections are required to access the network. Net UI clients are attached to the local 
area network using traditional methods. However, traditional client processing is split between 
the workstation and the Net UI Server.

Net UI Server(s)
Fourth Shift Server(s)

Remote
Net UI

Workstation(s)

Fourth Shift
Database(s)

Local Area Network

Local
Net UI

Workstation(s)

Traditional
Fourth Shift

Client
Workstation(s)

All client
processing
occurs on
workstation

Traditional client
processing split

between workstation
and Net UI Server
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• Remote users are not connected directly to the LAN and use some sort of communication 
technology to access information either through dial-up networking or the Internet.

- If you use dial-up networking, you access the network through a modem and 
telephone line, using third-party dial-up communication software. Once attached to 
the network, you can sign onto Fourth Shift using Net UI.

- If you use the Internet, you access the FSWEB Web page to sign onto Fourth Shift 
using Net UI. A button on the Web page starts the system using Net UI, and allows 
you to sign on.

Installing Net UI
The workstation installation process for Net UI differs depending on whether you are a local or 
remote user.

• Local users use the traditional workstation installation program.

• Remote users install Net UI using a customized installation package created by the FSWEB 
Web page.

For more information, see "Client Installation Options" in the Net UI manual.

Net UI User ID
When you sign on to Fourth Shift using Net UI, you must enter a Net UI user identifier in addition 
to your Fourth Shift User ID. This identifier is used to set up and identify a user-specific directory 
on the machine running the Net UI Server.

The Net UI User ID can be specified using one of the following methods:

• Manual entry when you sign on using Net UI. You will be prompted to enter your Net UI User 
Id before signing into Fourth Shift.

• Command line of the shortcut used to start Net UI. This eliminates the need to specify your 
Net UI User Id each time you start Net UI. See "Net UI Client Shortcut Parameters" in the Net 
UI manual for more information.

• Fourth Shift Explorer can automatically enter your Net UI if you record the value. From the 
View menu of the Fourth Shift Explorer, choose Options. Enter the Net UI information 
needed.
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Accessing Net UI
All screens and tasks available through the main Fourth Shift program can be accessed using Net 
UI. Fourth Shift features and applications that are accessed from separate shortcuts, such as the 
Sales Order Processing (SOPM) and Engineering (ENGM) Modules, can not be accessed using 
Net UI. For more information, see "Restricted Features" in the Net UI manual.

The method used to start Net UI depends on whether you are a local or remote user.

Local User Access
• For local users, the workstation installation program installs shortcuts you can use 

immediately. Click Start then point to Programs—(the folder that contains the Fourth Shift 
group)—then click one of the following:

- Net UI—to use Net UI

- Fourth Shift—to use the traditional client version of the main Fourth Shift program

- Fourth Shift Explorer—to use either Net UI or the main Fourth Shift program
For more information on using Net UI with the Fourth Shift Explorer, see Net UI and 
Other Startup Options in this manual.

All three shortcuts can be present on the same client. This might be useful if you need to use 
functionality that is not available via Net UI. For example, you might use Net UI most of the time for 
performance reasons. However, if you need to use the functionality of the Engineering module the 
traditional client is required.

Remote User Access
For remote users, the customized installation package enables you to run Net UI from the FSWEB 
Web page. After all installation requirements are met and modifications made, complete the 
following steps to start Fourth Shift from a remote workstation.

Action Completed

Verify that the Net UI workstation installation and modifications were completed.

Using Microsoft Internet Explorer, enter the following location:
http:\\ServerName\FSWeb
where ServerName is the name of the Web server.

Press Enter.

Click Run Net UI.

Enter a Net UI User Identifier then click OK.

Enter a User ID and Password. 
Press Enter to sign onto Fourth Shift.
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Printing Using Net UI
Fourth Shift generates several types of reports. When using Net UI, consider the following as you 
generate reports for the available types:

• Screen Reports. Screen reports can be generated by choosing either Print or Print Preview 
from the File menu. 

- Print Preview uses the Fourth Shift Report Viewer. Reports are sent to the Windows 
default printer for your workstation by default, although you can select a different 
printer.

• Batch Process Reports. When a batch process runs, reports are generated either to a file or 
the default printer for the server, not your client workstation. If you wish to use the report file 
generated, the file must be viewed or transferred to your workstation after the processing is 
complete.

Importing Using Net UI
The data import features in the System Control module can be used to input data from a file. You 
can run the data import features using Net UI, but several considerations may limit the situations 
where running data import is reasonable.

• Reference files such as macro files (*.MAC) must be available to your workstation.

• Data files used as input must be visible to your workstation.

• Data import validation uses the FS.CFG file to confirm file locations using drive letter and 
directory specifications.

These considerations mean that either a drive must be mapped from your workstation to the 
location of the files, or the files must be copied to your workstation and accessed from there. This 
applies to both local and remote users.

See “Using the Data Import Features” in the System Control manual for more information on the 
data import feature.
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Using My Fourth Shift Workplace
A variety of features are available in My Fourth Shift Workplace that allow you to enter and view 
the critical information that runs your business. This section introduces the important terms and 
concepts you need to know to use My Fourth Shift Workplace. It also describes the tools and 
options available to help you get the most out of the system.

Overview
My Fourth Shift Workplace provides an alternative method for remote and local users to access 
and use the Fourth Shift system. My Fourth Shift Workplace takes advantage of using an Internet 
browser and therefore provides a flexible and powerful tool for users that can result in increased 
productivity.

What Makes up My Fourth Shift Workplace
My Fourth Shift Workplace is comprised of two base elements, portals and Fourth Shift WebUI. An 
additional, optional, element is the Connectivity Toolkit.

Portals
With My Fourth Shift Workplace, you can create configurable views of information called portals. 
A portal can include the Web-based version of the Fourth Shift program itself, as well as existing 
intranet resources, third-party browser-based applications, or even external Internet Web sites. 
Each user can define portals of their own, as well as access the group of public portals.

You can design portals to contain a variety of resources needed to perform a specific job. (For 
example, a portal for customer service representatives could include a set of commonly-used 
Fourth Shift screens, a Web-based customer relationship management system, and the DHL 
shipment tracking Web site.) Portals can also provide an overview to a specific segment of your 
business, such as a segmented view of continuously updated management reports.

See Using Fourth Shift Portals in this online manual for more information on creating and updating 
portal definitions.

Fourth Shift WebUI
Fourth Shift WebUI provides a Web-like look for the Fourth Shift program. This user interface style 
is similar to the traditional Fourth Shift program, enhanced to operate in the way users expect web-
based software to operate.

Users can update and view data in real time, generate reports, run batch processes, and get 
online help just like traditional Fourth Shift users can. In addition, WebUI provides a number of 
advanced capabilities (such as Finders and links) that are unique to WebUI.

My Fourth Shift Workplace Concepts
My Fourth Shift Workplace is directly based on the traditional Fourth Shift system and functionality, 
but several new concepts are introduced to Fourth Shift users.

Portals
Portals are a collection of views that allow users to more efficiently do their jobs. This collection 
can include a variety of Fourth Shift data, or some Fourth Shift data along with other web content 
from your corporate intranet or outside companies.
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Links
Links are fields or data values that jump to related screens or detail information when clicked. 
When you pass your mouse over a field that has a link assigned, you can click on any of the 
destinations listed to go there immediately.

Navigation
Navigation refers to methods by which you can move around the Fourth Shift WebUI system. 
Navigation methods include using the Fourth Shift Explorer, portal bar buttons, menus, links, tabs, 
Back icon, Next Step icon, function code shortcuts, and keyboard shortcuts.

Workflow
Workflow describes the flow of transaction processing within Fourth Shift WebUI. Workflow allows 
you to continue working without memorizing all the steps in a process. Several workflow methods 
are used, including:

• One-Step method. There is only one step within the transaction process. For example, a 
transaction is completed on one screen and you do not need to go to another screen to 
complete the process. 

• Multiple-Step method. Several steps are involved in the transaction process sequence. For 
example, transactions are entered on one screen, applied on another and completed on yet 
another screen. You can use the Next Step icon to go through the sequence in the transaction 
process.

Getting Started
Understanding several key concepts about My Fourth Shift Workplace, such as access, navigation 
and data entry can help you to use the system more efficiently.

Accessing My Fourth Shift Workplace
To access My Fourth Shift Workplace, enter the URL address of the web site created for My 
Fourth Shift Workplace. For example, you could use FSWebServer.company.com/fsportals. Once 
you have used the URL address to access the Web site created for My Fourth Shift Workplace, 
you access the portals to select the view in which you want to work. You can display the list of 
available portals by selecting its name in the upper-left corner.

Navigating around Fourth Shift WebUI
Several methods are available for moving between functions and navigating around Fourth Shift 
WebUI.

Regardless of the list of the method used to navigate, you can only navigate to destinations that 
you are allowed to access as defined for your User Id on the FCMT (Function Code 
Maintenance) and PASS (Password Maintenance) screens. 

Fourth Shift Explorer
Use the Fourth Shift Explorer frame, called Navigation, in Fourth Shift WebUI to go to a function in 
any application that you are allowed to access. The concepts of the Fourth Shift Explorer in WebUI 
are similar to the concepts of the Fourth Shift Explorer in the traditional Fourth Shift program, but 
some of the techniques are different. See “Using the Fourth Shift Explorer” in the Fourth Shift 
Basics manual in the Manufacturing or Financial help for more information on using the Fourth 
Shift Explorer in the traditional Fourth Shift program.
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Fourth Shift Explorer has several operating modes, including:

• Simple Mode. Using simple mode, the Fourth Shift modules available are listed in 
alphabetical order in the navigation list. You can expand or collapse the list of functions 
available with each module—click on the option in the navigation list to select and go to the 
function.

• Full Mode. Using full mode, you can search for a specific function based on subjects or 
activities. For example, you can enter a search for "credit memo" and only those functions 
related to credit memo are listed in the navigation results. You can also enter the keyword or 
ID of a specific item or object and go directly to it—click on the option in the navigation list to 
select and go to the function or activity in another of the related frames.

You can also toggle back and forth between showing and hiding the function codes in the 
navigation list using the Show Codes and Hide Codes button.

Function Field
Each screen has a unique Function Code, which is a four-character shortcut that identifies the 
screen. For example, the Item Master screen is identified by the Function Code ITMB. Using the 
function code shortcut provides a quick way of accessing other screens.

The Function field is displayed to the far left directly under the row of tabs in the WebUI frame. It 
displays the Function Code of the screen you are viewing. You can go to a different screen by 
entering the corresponding Function Code then click Go or press Esc or Enter. If the Function 
field is not displayed, you can press Back or Esc until you return to the main screen with the 
Function field.

Tabs
Tabs are available when a screen has additional related or required information for a transaction. 
Tabs are always shown, even if you cannot access them based on the data on your screen. For 
example, from the MOAN (Planner Action) screen, you can see the Material Shortages Detail 
tab. But, if the item you are viewing doesn't have any material shortages, you cannot access the 
tab even though you can see it.

When on a tab, the label Return is used for the main screen name, if the tab is accessed from 
more than one screen.

Available tabs for each screen are listed on the Features tab when you select Screen Help from 
the Help menu.

Links
Many fields have been assigned links that allow you to jump to a related screen or detail 
information. Links provide easy access to related data. Fields can have several link destinations.

• Clicking on a field that has one link takes you right to the jump destination. 

• Clicking on a field that has multiple link destinations takes you to the default destination. 

• Moving your mouse over a field that has multiple link destinations displays a list of the 
destinations. In the list, the most likely destination is listed first in bold font (this is also the 
default destination).

For screens that have both entry and inquiry versions, you can be taken to the inquiry version if 
you do not have access to the entry version. For example, from the Item field you can click on a 
link to go to the ITMB (Item Master) screen. But, if you don't have access to that screen, and you 
do have access to the related ITMI (Item Master Inquiry) screen, you are taken to the inquiry 
destination instead.

Available links for each screen are listed on the Features tab when you select Screen Help from 
the Help menu.
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Next Step Icon
Click the Next Step (arrow pointing right) icon, located to the right of the Function field, to go to the 
next set of screens in an application sequence. Next Step enables you to get to the next screen in 
a sequence without having to know the name of the screen. For example, from the ARCD (A/R 
Cash Deposits) screen, the Next Step icon takes you to the ARCR (A/R Cash/Credit Memo 
Application) screen, since it is the next screen in the cash application workflow.

• The Next Step sequence is based on the "Typical Work Flows" diagrams in the Getting Started 
manual.

• The Next Step sequence for each screen is listed on the Features tab when you select Screen 
Help from the Help menu.

Back Icon
Click the Back icon (arrow pointing left), located to the right of the Function field, to return to the 
previously viewed main panel. 

• The Back icon enables you to return to what you were doing without having to remember 
exactly what screen you were on. 

• The Back icon in My Fourth Shift Workplace works similar to the Back button in Internet 
Explorer, but it is specific to what you were doing in a specific Fourth Shift WebUI frame.
Do not use the Internet Explorer Back button.

Entering and Viewing Data
My Fourth Shift Workplace is designed to allow you to enter and review business information 
quickly and easily. Most of the operations and techniques you can use are typical for Web-based 
programs. However, there are some special considerations to keep in mind while using My Fourth 
Shift Workplace.

Selecting an Option in a Field with a Selection List
Fields that permit only a limited set of entries contain a small arrow in the lower right corner. When  
the field gets focus, a drop-down icon will be displayed. You can either click this icon with the 
mouse or press Ctrl+Down Arrow keys to display the menu of options. Descriptions of the entry 
options are displayed at the bottom of the frame when you select Field Action in the Help menu.

Selecting a Row
To help you in determining if certain data rows can be selected, they are displayed slightly different 
than data rows that cannot be selected. 

• Blue Highlighted Background
The current line has a blue background color. You can move the selection with the mouse or 
the keyboard arrow keys.

• Selecting a Line

- Clicking on a line in the detail grid of a main panel moves your cursor to that row. 

- Clicking on a line in a pop-up or browser window selects the row and returns the row 
to the parent screen.

• No line marker 
Some pop-up and browser windows do not contain the arrow markers but you can still select 
from these windows. 

- Select a row to return to the parent screen whenever the hand cursor is displayed.
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Using the Date Picker
For date fields, click the calendar icon to open the date selector function (the Date Picker). 
Perform the following actions within the Date Picker:

• Press Ctrl+Home to return to the current date.

• Click the Today button to select the current date, which closes the Date Picker window and 
moves the cursor to the field with the selected date.

• Click outside the Date Picker window to exit the Date Picker.

Note: Shop days/non-shop days are not differentiated on the Date Picker calendar.

Refreshing Data
You can return a screen to its initial state at any time by pressing Esc. This clears all fields on the 
screen and allows you to enter new key values. An alternate way to refresh your screen is by right-
clicking while you are on the screen and selecting Refresh from the menu. You may be prompted 
to click Retry in order for the data to be resent to the screen.

If you have entered data on the screen but haven't saved it, those entries are lost when you 
refresh the screen.

Saving Data
You can complete a transaction and save data on the screen by clicking the Submit button, 
located near the bottom of the frame where a WebUI screen is displayed, or by pressing Enter.
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Using Shortcut Keys for My Fourth Shift Workplace
Keyboard shortcuts in My Fourth Shift Workplace are slightly different than the keyboard 
functionality of the traditional Fourth Shift program. In My Fourth Shift Workplace, users are 
provided with complete keyboard support, following Microsoft Windows and Internet Explorer 
standards. Many features also can be accessed with the mouse.

My Fourth Shift Workplace keyboard support includes the following:

Entering and Editing Text

Moving Within a Screen

Moving Between Tabs on a Page

To... Press...

Add a new line or section on screens where detail can be 
added

Ctrl+A

Copy selected text to the Clipboard Ctrl+C

Delete the line or section containing the active field Ctrl+D

Paste text from the Clipboard Ctrl+V

Cut selected text to the Clipboard Ctrl+X

Undo the most recent typing Ctrl+Z

Save data to the database Enter

Refresh the data Esc

To... Press...

Go to the Function field Ctrl+G

Go to the beginning of the active field Home

Go to the end of the active field End

Go to the first line in a list Ctrl+Home

Go to the last line in a list Ctrl+End

Go up one line in a list Up arrow

Go down one line in a list Down arrow

Go up one page in a list Page Up

Go down one page in a list Page Down

To... Press...

Move between tabs on a page Ctrl+1 for Tab 1, Ctrl+2 for Tab 2, etc.
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Moving Between Screens

Using Menus

Using Special Features

To... Press...

Go to the function code entered in the Function field Esc or Enter

Go to a related screen or window Tabs, links, Next Step icon

Go back to the previous screen Back button

To... Press...

View context-sensitive help topics Ctrl+H for the Help menu

View report generation options Ctrl+R for the Reports menu

View available tools options Ctrl+T for the Tools menu

To... Press...

Open a Browse or detail list Ctrl+B

Activate the Field Action Ctrl+F

Close a Browse list after making a selection Ctrl+Enter

Print a screen report Reports menu—Generate option

Open an Extended Text window Tools menu—Extended Text option

Open a Mass Maintenance window Tools menu—Mass Maintenance option

Open the Cash Reversal Selection window from the 
ARCD (A/R Cash Deposits) or ARPD (A/R Prior Period 
Cash Deposits) screen

Tools menu—Cash Reversal option

Open a Default Setup window Tab or Tools menu— Default Setup option

Select an option from a list *

Go to next period on GLCF screen Tab

Go to previous period on GLCF screen Shift+Tab

Go to next fiscal year on GLCF screen Ctrl+Right arrow

Go to previous fiscal year on GLCF screen Ctrl+Left arrow

Open a drop-down menu Ctrl+Down arrow

Go to the prior page of extended text Tools menu—Previous Page

Go to the next page of extended text Tools menu—Next Page

Add a new page of extended text prior to the currently 
displayed page

Ctrl+A

Add a new page of extended text while viewing the last 
page of existing extended text

Tool menu—Next Page
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Using the Find Feature
The Find feature provides a quick and efficient way of searching for data to enter into an active 
field. This feature is sometimes called the Finder, since it enables you to search for specific data, 
such as customers, vendors, items, or orders. For example, if you need to enter a customer 
identifier, you can use the Find Customer link to choose the customer identifier from a master list. 
The master list can display more than just the identifier, it can also include the description and 
other information that you can use to choose the identifier without having to memorize it.

Master lists can be narrowed down, or filtered, to display only data that meet the criteria you enter. 
For example, if you want to see a list of customers in a certain city, then you could enter that city 
name as the field criteria and only those customers in that city would be displayed in the filtered 
list.

Accessing the Find Feature
The Find feature can be accessed using the following methods:

Accessed from a Field Within Fourth Shift WebUI
Accessing the Find feature from within Fourth Shift WebUI enables you to quickly enter data into a 
field without having to memorize it and then you can continue on with your processing.

From within Fourth Shift WebUI, you can access the Finder once the field gets focus. The small 
black triangle will be replaced with a trigger icon. This feature can be accessed from the keyboard 
or the mouse:

• Using the keyboard, press Ctrl+Down arrow to access the Finder directly when the Find icon 
is displayed, or to drop down the menu when there is a menu of choices and the down arrow 
icon.

• Using the mouse, click on the trigger icon and select from the menu if there are multiple 
choices. 

Accessed as a Portal Frame
When setting up portals, you can create a portal with the Find feature by using the FS Finder 
frame type. The Find feature can be used independently or with other applications. For example, 
the Find feature can be the only frame in the portal, which enables you to search for Fourth Shift 
data. Or, the Find feature can be included in a portal that contains another frame that is running an 
application such as Fourth Shift WebUI. 

The characteristics of the Find feature when accessed as a portal frame are based on the options 
determined when the FS Finder frame type was created, including:

• Parent or Child
The Find feature can be set up as the parent frame of another application (for example, 
WebUI).

• Logon Information
For security reasons, when accessing the Find feature through a portal frame, you are 
prompted to log on to Fourth Shift. You can enter this log on information (user id and 
password) when creating the frame type so that you are not prompted for it when the Find 
portal is accessed. See Assigning Security for more information on assigning security in the 
Find feature.

• Navigation
When the Find feature is defined as a parent frame, an option is available to set the level of 
navigation. 
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- Option Not Selected—The Find feature (parent) sends a message to Fourth Shift 
WebUI (child) and if the desired screen is already displayed, the data is entered into 
the appropriate field. If the desired screen is not displayed, the data is not entered.

- Option Selected—The Find feature (parent) sends a message to Fourth Shift WebUI 
(child) and Fourth Shift WebUI changes to a screen and the data is entered into the 
appropriate field. Navigation is based on which Find feature is open:

Understanding the Find Feature
When accessed from a data entry field in Fourth Shift WebUI, the Find feature opens immediately 
in a separate window. If starting data was entered in the originating field before accessing the Find 
feature, this data is shown as the criteria for the search. If starting data was not entered, the Find 
feature opens with no pre-set filter criteria. After entering the criteria, click the Reload data icon 
and the Find feature displays the data matching the criteria.

Filter Fields
The fields used for filtering are based on the type of data you are finding. For example, if you are 
finding a customer, you can filter on customer data, such as customer ID, name, contact, phone or 
zip code. If you are finding a customer order, you can filter on order number, status, customer id, 
name or order revision date. Filtering fields have several other features, including:

• Drop-Down Lists
Filtering fields can be easily changed by using a drop-down list and simply selecting another 
field. For example, to filter the customer list by currency code, use the drop-down from any 
field selector and select the Currency Code field. You can then enter data in the criteria field to 
filter the list by a certain currency code. Field selectors without drop-down lists cannot be 
changed.

• Field Labels
Field labels used in the Find feature do not correspond exactly to the field labels used in 
Fourth Shift WebUI. The Find Feature lists similar fields in the drop-down lists together by 
function to simplify locating similar information. For example, all the fields relating to Terms 
start with the word "Terms"; and the field label "phone", which may appear several times, is 
identified as "contact phone" and "customer phone" in the Find Feature.

Find feature Navigate to

CO For CUSM systems: COMT, COMI
For SOPM systems: no navigation

Customer For CUSM systems: CUID, CUII
For SOPM systems: no navigation

GL Master Account GLMA

Item ITMB, ITMI

Lot LMST

MO MOMT, MOMI

PO POMT, POMI

Vendor VEID, VEDI
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• Toolbar
A toolbar is located at the top of the window and allows you to:

- See which Finder is running and select a different Finder when run as a portal frame.

- Use the Reload data icon to apply the query and reload the data grid.

- Use the Save settings icon to save your settings on the client as described in the Save 
Settings section.

- Use the Clear Criteria icon to remove the filter criteria from all fields.

- Use the ? (question mark) icon to display the Help window to assist you with using the 
Finders.

Criteria Fields
Criteria fields are located directly below the filter fields and are available for entering field criteria. 
After entering filter criteria, click the Reload data icon to continue the process of finding the data, 
or click Clear Criteria to remove the filter criteria from all fields. 

For example, if you want a list of all customer identifiers that start with the number "12", select the 
Customer ID field, and then enter 12 in the criteria field. Click the Reload data icon to process the 
request, and a list of all customer identifiers that start with 12 is displayed. See Specifying Criteria 
for more information on using the criteria fields.

Search Results List
When the Find feature displays the data that matches your criteria, the results are initially sorted in 
ascending order based on the first column. You can change the following results list options:

• Setting the records per page
You can specify the number of records of returned data to display per page, based on your 
screen area settings. Enter a value in the Records Per Page field to change the display. The 
default number is 100. 

• Navigating through the list
You can use the set of controls to navigate through the list of data. You can go to the first 
page, previous page, next page or last page. You can also navigate using the vertical scroll 
bar located on the right side of the list or using keys on your keyboard, such as Page Up, Page 
Down, arrow up and arrow down.

• Sorting the Results List
You can change the sort order by simply clicking on the header of another column. You can 
reverse the sort order from ascending to descending by clicking on a column header that is 
already sorted. The current sort field is identified by an angle bracket in the field header.

• Changing Column Widths
Change the width of the columns in the data grid by moving the dividers in the grid header.

Data Selection
When the Find feature displays the list, it also displays the record range and number of records 
found. You can select data by clicking on the row’s arrow marker. Data selection differs based on 
how the Find feature was accessed and if a level of navigation was specified.

• When accessed from a field within Fourth Shift WebUI, the data value is entered into the field 
from which the Find feature was accessed. After the data is selected, the Find window closes.

• When accessed from a portal frame, entry of the data is dependent on the frame configuration. 
For example, for a Find feature (parent) that is allowed to navigate Fourth Shift WebUI (child), 
Fourth Shift WebUI changes to the desired screen and then the data is entered into the 
appropriate field. When the parent frame is not allowed to navigate the child frame, the data is 
Fourth Shift Basics 69



Fourth Shift Release 7.50
entered into the appropriate field only if the desired screen is already displayed. After you 
select the data, the Find feature frame stays open and is available for more find activity.

Save Settings
After making changes to the Find feature settings, you may want to save the changes so that you 
don't have to enter them each time you open the Find feature on this workstation. Click Save 
Settings to save changes such as records per page, filtering fields, filter criteria and sort order. 
Settings are saved separately for each type of finder. 

Reset Finder Fields to Defaults
If you have changed and saved the Finder fields, you can reset the Finder fields back to the default 
fields manually. The following is a list default finder fields for each of the Finders.

• Customer Finder defaults

- CSR

- Cust Zip

- Customer Contact

- Customer Phone

• Customer Order Finder defaults

- Order Status

- Customer Id

- Customer Name

- CO Rev Date

• GL Master Account Finder defaults

- Organization Description

- Account Type

- Account Category

- Account Open or Closed

• Item Finder defaults

- UM

- Make/Buy Code

- Type

- Order Policy

• Lot Finder defaults

- Lot User Def 1

- Lot User Def 2

- Lot User Def 3

- Lot User Def 4
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• Manufacturing Order Finder defaults

- Order Status

- Gateway WC

- MO Rev Date

• Purchase Order Finder defaults

- Order Status

- Vendor Id

- Vendor Name

- Rev Date

• Vendor Finder defaults

- Vendor Contact

- Vendor Phone

- Vend City

- Vend State

Assigning Security
The traditional screen level security used by the Fourth Shift system is used to build the field level 
security in the Find feature. This field level security means that no additional work is necessary to 
make sure that users can see only the data to which they are permitted.

• Fourth Shift Screen Level Security
Screen level security can be assigned to the Fourth Shift screens using your User ID and the 
existing passwords, access codes and function codes specified on the PASS (Password 
Maintenance) and FCMT (Function code Maintenance) screens.

Note: If you are using the Sales Order Processing Module (SOPM), the you must set up the 
following screens for the WebUI Find Feature to allow access to SOPM order entry 
data.

- Name/Address Detail (SOP2)

- Financial Detail (SOP3)

- Order Information (SOP4)

• Finder Field Level Security
Field level security is built by the Find feature based on the screen level security of the PASS 
and FCMT screens. Since the fields available for filtering may originate on several different 
screens, the Find feature verifies that you have security to at least one of those screens 
before allowing you to view or filter on those fields.

For example, if you have access to the Customer Financial Detail (CUS2) screen, the Find 
feature enables you to search and filter data available on that screen. If you do not have access to 
the Customer Financial Detail screen, the Find feature does not allow you to view or filter on 
fields from that screen.

Security by Field
Security for the Find feature is available by field. Security for several screens and fields is different 
based on if you use the CUSM or SOPM module.
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Customer

Field Security based on the panel

A/R Customer CUS2/SOP3

Acct Cntct Fax SOP2

Acct Cntct Name CUS1/BR2C/SOP2

Acct Cntct Phone CUS1/BR2C/SOP2

Acct No: A/R CUS1/SOP2

Acct No: COGS CUS1/SOP2

Acct No: Freight CUS1/SOP2

Acct No: Sales CUS1/SOP2

AR Current Amt CUS2/BR2C/SOP3

AR On Hold Amt CUS2/BR2C/SOP3

AR Past Due1 Amt CUS2/BR2C/SOP3

AR Past Due2 Amt CUS2/BR2C/SOP3

AR Past Due3 Amt CUS2/BR2C/SOP3

AR Total Amt CUS2/BR2C/SOP3

AR Unappl Cash CUS2/BR2C/SOP3

AR Unappl Credit CUS2/BR2C/SOP3

Bank Ref #1 CUS2/SOP3

Bank Ref #2 CUS2/SOP3

Bill To Addr1 CUS1/SOP2

Bill To Addr2 CUS1/SOP2

Bill To City CUS1/SOP2

Bill To Country CUS1/SOP2

Bill To Cust Id SOP2

Bill To Name CUS1/SOP2

Bill To State CUS1/SOP2

Bill To Zip CUS1/SOP2

Bin SOP2

Booked Orders CUS2/SOP3

Carrier Code SOP2

Commission Code CUS1/BR2C/SOP2

Consumed Crdt SOP3

Crdt Limit Amt CUS2/BR2C/SOP3

Crdt Limit Auth CUS2/SOP3
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Crdt Limit Date CUS2/SOP3

Crdt Pol: Assign SOP3

Crdt Pol: Remove SOP3

Credit Hold SOP3

Credit Rep SOP3

CSR CUID/CUII/CUST/CUSI/BR2C/CUS1/CUS2/SOP2/
SOP3

Ctrl Currency CUS2/SOP3

Currency Code CUS2/SOP3

Cust Addr 1 CUS1/BR2C/SOP2

Cust Addr 2 CUS1/BR2C/SOP2

Cust City CUS1/BR2C/SOP2

Cust Country CUS1/BR2C/SOP2

Cust State CUS1/BR2C/SOP2

Cust Zip CUS1/BR2C/SOP2

Customer Class 1 CUS1/BR2C/SOP2

Customer Class 2 CUS1/BR2C/SOP2

Customer Class 3 CUS1/BR2C/SOP2

Customer Class 4 CUS1/BR2C/SOP2

Customer Class 5 CUS1/BR2C/SOP2

Customer Class 6 CUS1/BR2C/SOP2

Customer Class 7 CUS1/BR2C/SOP2

Customer Class 8 CUS1/BR2C/SOP2

Customer Contact CUID/CUII/CUST/CUSI/BR2C/CUS1/CUS2/SOP2/
SOP3

Customer Fax # CUS1/SOP2

Customer Id none

Customer Level SOP2

Customer Name none

Customer Phone CUID/CUII/CUST/CUSI/BR2C/CUS1/CUS2/SOP2/
SOP3

D & B Class CUS2/BR2C/SOP3

D & B Date CUS2/BR2C/SOP3

D & B Rating CUS2/BR2C/SOP3

D & B Ref # CUS2/BR2C/SOP3

Distrib Region SOP2

Field Security based on the panel
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Distrib Zone SOP2

End User Id SOP2

FOB Point CUS1/BR2C/SOP2

Freight Code CUS1/BR2C/SOP2

Last Inv Date CUS2/SOP3

Last Pay Date CUS2/SOP3

Open or Bal Frwd CUS2/SOP3

Partial Alloc SOP3

Partial Shpmnts CUS1/BR2C

Price Adj S/D % CUS1/BR2C/SOP2

Prt:Item Source CUS2/SOP3

Prt:Lang Code SOP2

Prt:Nbr/Date Fmt SOP2

Sales Region SOP2

Srvc Chrg Flag CUS2/SOP3

Srvc Chrg Rate CUS2/SOP3

Statement Cycle CUS2/SOP3

Statement Print CUS2/SOP3

Stockroom SOP2

Tax Cert:County SOP3

Tax Cert:Fd/VAT SOP3

Tax Cert:Muni SOP3

Tax Cert:St SOP3

Tax Code:County SOP3

Tax Code:Fd SOP3

Tax Code:Muni SOP3

Tax Code:St SOP3

Tax Ex:County SOP3

Tax Ex:Fd/VAT SOP3

Tax Ex:Muni SOP3

Tax Ex:St SOP3

Term D:Csh1 % CUS2/SOP3

Term D:Csh1 Days CUS2/SOP3

Term D:Csh2 % CUS2/SOP3

Field Security based on the panel
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Vendor

Term D:Csh2 Days CUS2/SOP3

Term D:Csh3 % SOP3

Term D:Csh3 Days SOP3

Term D:Csh4 % SOP3

Term D:Csh4 Days SOP3

Term D:Net Days CUS2/SOP3

Term M:Cutoff Dy CUS2/SOP3

Term M:Due Day CUS2/SOP3

Term M:Mth Delay CUS2/SOP3

Terms Type CUS2/SOP3

Text (addr) 1 CUS1

Text (addr) 2 CUS1

Text (addr) 3 CUS1

Text (addr) 4 CUS1

Text (addr) No CUS1

Text (fin) 1 CUS2

Text (fin) 2 CUS2

Text (fin) 3 CUS2

Text (fin) 4 CUS2

Text (fin) No CUS2

Top Level Cust SOP2

Trade Class SOP2

VAT Cust Code CUS1/SOP2

YTD Payments CUS2/BR2C/SOP3

YTD Sales CUS2/BR2C/SOP3

YTD Shipments CUS2/BR2C/SOP3

YTD Srvc Chrg CUS2/BR2C/SOP3

Field Security based on the panel

1099 Flag VEN1/BR2V

1099 Tax Id No VEN1/BR2V

Acct Cntct Name VEN1/BR2V

Acct Cntct Phone VEN1/BR2V

Field Security based on the panel
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AP Current Amt VEN1/BR2V

AP Fut Due1 Amt VEN1 

AP Fut Due2 Amt VEN1 

AP Fut Due3 Amt VEN1 

AP Fut Due4 Amt VEN1 

AP On Hold Amt VEN1/BR2V

AP Past Due1 Amt VEN1/BR2V

AP Past Due2 Amt VEN1/BR2V

AP Past Due3 Amt VEN1/BR2V

AP Unappl Cash VEN1/BR2V

Bank Account VEN1 

Bank Name VEN1 

Bank Route VEN1 

Ctrl Currency VEN1 

Currency Code VEN1 

D & B Class VEN1/BR2V

D & B Date VEN1/BR2V

D & B Rating VEN1/BR2V

D & B Ref # VEN1/BR2V

Last Inv Date VEN1

Last Pay Date VEN1

Last Recd Date VEN3

Order Value 1 VEN3

Order Value 2 VEN3

Payee Addr 1 VEN1/BR2V

Payee Addr 2 VEN1/BR2V

Payee City VEN1/BR2V

Payee Country VEN1/BR2V

Payee Name VEN1/BR2V

Payee Name 2 VEN1/BR2V

Payee State VEN1/BR2V

Payee Zip VEN1/BR2V

Payment Form VEN1

Payments 1 VEN1/VEN3/BR2V

Field Security based on the panel
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Payments 2 VEN3

Prt:Item Source VEDI/VEID/VEND/VENI/VEN1/BR2V

Prt:Lang Code VEN1

Prt:Nbr/Date Fmt VEN1

Receipts Value 1 VEN1/VEN3/BR2V

Receipts Value 2 VEN3

Term D:Csh1 % VEN1/BR2V

Term D:Csh1 Days VEN1/BR2V

Term D:Csh2 % VEN1/BR2V

Term D:Csh2 Days VEN1/BR2V

Term D:Net Days VEN1/BR2V

Term M:Cutoff Dy VEN1/BR2V

Term M:Day Due VEN1/BR2V

Term M:Mth Delay VEN1/BR2V

Terms Type VEN1/BR2V

Text (addr) Ln1 VEN1

Text (addr) Ln2 VEN1

Text (addr) Ln3 VEN1

Text (addr) Ln4 VEN1

Text (addr) No VEN1

Text (conf) Ln1 VEN3

Text (conf) Ln2 VEN3

Text (conf) Ln3 VEN3

Text (conf) Ln4 VEN3

Text (conf) No VEN3

Vend Addr 1 VEN1/BR2V

Vend Addr 2 VEN1/BR2V

Vend City VEN1/BR2V

Vend Country VEN1/BR2V

Vend State VEN1/BR2V

Vend Zip VEN1/BR2V

Vendor Approval VEDI/VEID/VEND/VENI/VEN1/BR2V

Vendor Class 1 VEN1/BR2V

Vendor Class 2 VEN1/BR2V

Field Security based on the panel
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Item

Vendor Class 3 VEN1/BR2V

Vendor Class 4 VEN1/BR2V

Vendor Class 5 VEN1/BR2V

Vendor Class 6 VEN1/BR2V

Vendor Class 7 VEN1/BR2V

Vendor Class 8 VEN1/BR2V

Vendor Contact VEDI/VEID/VEND/VENI/VEN1/BR2V

Vendor Fax # VEN1/BR2V

Vendor Id none

Vendor Name none

Vendor Phone VEDI/VEID/VEND/VENI/VEN1/BR2V

YTD Invoiced VEN1/BR2V

Field Security based on the panel

Acct No: COGS ITMC/ITCI

Acct No: Inv ITMC/ITCI

Acct No: Sales ITMC/ITCI

ATP Flag ITM2/ITM4

Avg Unit Price ITMC/ITCI

Buyer ITM2/ITM4/BR2I

Cost Family ITMC/ITCI

Dec Prec Code ITM2/ITM4

Demand Fence ITM2/ITM4

Drawing ITM1/ITM3/BR2I

ECCN ITM1/ITM3 

Family Grouping ITM1/ITM3

Family Name ITM1/ITM3/BR2I

Forecast Code ITM2/ITM4

Forecast Prd ITM2/ITM4

Gateway WC ITM2/ITM4/BR2I

Group Tech Code ITM1/ITM3/BR2I

HTS ITM1/ITM3

Insp Required ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I

Field Security based on the panel
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Item none

Item Class 1 ITM1/ITM3/BR2I

Item Class 2 ITM1/ITM3/BR2I

Item Class 3 ITM1/ITM3/BR2I

Item Class 4 ITM1/ITM3/BR2I

Item Class 5 ITM1/ITM3/BR2I

Item Class 6 ITM1/ITM3/BR2I

Item Class 7 ITM1/ITM3/BR2I

Item Class 8 ITM1/ITM3/BR2I

Item Description none

Item Pcs/Pkg ITM1/ITM3

Item Pkg Type ITM1/ITM3

Item Ref 1 ITM1/ITM3/BR2I

Item Ref 2 ITM1/ITM3/BR2I

Item Ref 3 ITM1/ITM3/BR2I

Item Ref 4 ITM1/ITM3/BR2I

Item Ship Vol ITM1/ITM3

Item Ship Wgt ITM1/ITM3

Lead Time: Fixed ITM2/ITM4/BR2I

Lead Time: Insp ITM2/ITM4/BR2I

Lead Time: Run ITM2/ITM4/BR2I

Lot Size Day ITM2/ITM4

Lot Size Min ITM2/ITM4

Lot Size Mult ITM2/ITM4

Lot Size Qty ITM2/ITM4

Lot: Assign Pol ITM5/ITM6

Lot: Avail Days ITM5/ITM6

Lot: Counter ITM5/ITM6

Lot: Default ITM5/ITM6

Lot: FIFO Inv ITM5/ITM6

Lot: Last Lot No ITM5/ITM6

Lot: Last Ser No ITM5/ITM6

Lot: Mask ITM5/ITM6

Lot: Material ITM5/ITM6

Field Security based on the panel
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Customer Order

Lot: Retest Days ITM5/ITM6

Lot: Ser No Dflt ITM5/ITM6

Lot: Ser No Mask ITM5/ITM6

Lot: Serializtn ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I

Lot: Shelf Life ITM5/ITM6

Lot: Trace Flag ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I

Low Level Code ITM2/ITM4

Make/Buy Code ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I

NMFC Code ITM1/ITM3

NMFC Sub-Class ITM1/ITM3

Order Policy ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I

Planner ITM2/ITM4/BR2I

Planning Fence ITM2/ITM4

Planning Policy ITM2/ITM4/BR2I

Preferred Bin ITM2/ITM4/BR2I

Preferred Stkrm ITM2/ITM4/BR2I

Replan Code ITM2/ITM4

Review Date ITM2/ITM4

Revision Level ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I

Safety Stock ITM2/ITM4

Saleable Ind ITM1/ITM3

Set Up Cost ITMC/ITCI

Status ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I

Type ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I

UM ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I/
ITMC/ITCI

UPC Code ITM1/ITM3

Yield % ITM2/ITM4

Field Security based on the panel

Bill to Id SOP4

CO Number none

CO Rev Date COMT/COS1/SOP4

Field Security based on the panel
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Commission Code COS1/SOP4

CSR COMT/COS1/SOP4

Ctrl Currency COMT/COS1/SOP4

Currency Code CUS2/COMT/COS1/SOP3/SOP4

Cust Address 1 CUS1/BR2C/COMT/COS1/SOP2/SOP4

Cust Address 2 CUS1/BR2C/COMT/COS1/SOP2/SOP4

Cust City CUS1/BR2C/COMT/COS1/SOP2/SOP4

Cust Country CUS1/BR2C/COMT/COS1/SOP2/SOP4

Cust State CUS1/BR2C/COMT/COS1/SOP2/SOP4

Cust Zip CUS1/BR2C/COMT/COS1/SOP2/SOP4

Customer Id COMT/COS1/SOP4

Customer Name CUID/CUST/CUII/CUSI/COMT/COS1/SOP4

Customer PO No COMT/COS1/SOP4

Default Shp Date SOP4

Disc Amt-CTL SOP4

Distrib Region SOP4

Distrib Zone SOP4

End User Id SOP4

Exch Rate 1 COMT/COS1/SOP4

Exch Rate 2 COMT/COS1/SOP4

Exch Rate Op 1 COMT/COS1/SOP4

Exch Rate Op 2 COMT/COS1/SOP4

Expiration Date SOP4

FOB Point COMT/COS1/SOP4

Freight Amt-CTL SOP4

Freight Chg Code COMT/COS1/SOP4

Gross Amt-CTL SOP4

Invoice or COD COMT/COS1/SOP4

On Hold SOP4

Ord Open Amt-CTL COMT/COS1/SOP4

Order Priority SOP4

Order Status COMT/COS1/SOP4

Price Adj S/D % COS1/SOP4

RBPM Required SOP4

Field Security based on the panel
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Region Code SOP4

Sales Category 1 COS1/SOP4

Sales Category 2 COS1/SOP4

Ship To Addr 1 COMT/COS1/CUS1/SOP2/SOP4

Ship To Addr 2 COMT/COS1/CUS1/SOP2/SOP4

Ship To City COMT/COS1/CUS1/SOP2/SOP4

Ship To Country COMT/COS1/CUS1/SOP2/SOP4

Ship Id/Dlvy Loc COMT/COS1/CUS1/SOP2/SOP4

Ship To Id SOP2/SOP4

Ship To Name COMT/COS1/CUS1/SOP2/SOP4

Ship To State COMT/COS1/CUS1/SOP2/SOP4

Ship To Zip COMT/COS1/CUS1/SOP2/SOP4

Ship Via COMT/COS1/SOP4

Shp:Mult Line SOP4

Shp:Mult Order SOP4

Shp:Partial Line SOP4

Template Flag SOP4

Term D:Csh1 % COMT/COS1/SOP4

Term D:Csh1 Days COMT/COS1/SOP4

Term D:Csh2 % COMT/COS1/SOP4

Term D:Csh2 Days COMT/COS1/SOP4

Term D:Csh3 % SOP4

Term D:Csh3 Days SOP4

Term D:Csh4 % SOP4

Term D:Csh4 Days SOP4

Term D:Net Days COMT/COS1/SOP4

Term M:Cutoff Dy COMT/COS1/SOP4

Term M:Day Due COMT/COS1/SOP4

Term M:Mth Delay COMT/COS1/SOP4

Terms Type COMT/COS1/SOP4

Text line 1 COS1

Text line 2 COS1

Text line 3 COS1

Text line 4 COS1

Field Security based on the panel
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Manufacturing Order

Purchase Order

Text line No COS1

Total Lns – CTL COMT/COS1/SOP4

Total Lns-NonCTL COMT/COS1/SOP4

Field Security based on the panel

Deliver To MOMT

Gateway WC MOMT

MO Number none

MO Rev Date MOMT

Order Status MOMT

Planner MOMT

Text Line 1 MOMT

Text Line 2 MOMT

Text Line 3 MOMT

Text Line 4 MOMT

Text No MOMT

Field Security based on the panel

Blanket Order POMT/POM1

Buyer POMT/POM1

Ctrl Currency POMT/POM1

Currency Code POMT/POM1

Exch Rate 1 POMT/POM1

Exch Rate 2 POMT/POM1

Exch Rate Op 1 POMT/POM1

Exch Rate Op 2 POMT/POM1

FOB Point POM1

Order Cont Phone POM1

Order Contact POM1

Order Status POMT/POM1

Orig Order Date POM1

Field Security based on the panel
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PO Number none

PO Revision POM1

Rev Date POMT/POM1

Ship To Address1 POM1

Ship To Address2 POM1

Ship To City POM1

Ship To Country POM1

Ship To Name POM1

Ship To State POM1

Ship To Zip POM1

Term D:Csh1 % POM1

Term D:Csh1 Days POM1

Term D:Csh2 % POM1

Term D:Csh2 Days POM1

Term D:Net Days POM1

Term M:Cutoff Dy POM1

Term M:Day Due POM1

Term M:Mth Delay POM1

Terms Type POM1

Text Line 1 POM1

Text Line 2 POM1

Text Line 3 POM1

Text Line 4 POM1

Text No POM1

Total Amt-CTL POMT 

Total Amt-NonCTL POMT

Transport Via POM1

Vendor Id VEDI/VEID/VEND/VENI/POMT/POM1

Vendor Name VEDI/VEID/VEND/VENI/POMT/POM1

Field Security based on the panel
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GL Master Account

Lot

Field Security based on the panel

Current Period Credits GLMA/GLJE

Account Category GLMA/GLJE

Account Description None

Account Type GLMA/GLJE

Active or Inactive GLMA/GLJE

Balance Limit GLMA/GLJE

Current Balance GLMA/GLJE

Current Net Change Credits GLMA/GLJE

Current Net Change Debits GLMA/GLJE

Current Period Debits GLMA/GLJE

Last Posted Date GLMA/GLJE

Master Account None

Master Account UserID GLMA/GLJE

Open or Closed GLMA/GLJE

Organization Description GLMA/GLJE

Prior Net Change Credits GLMA/GLJE

Prior Net Change Debits GLMA/GLJE

Transaction Limit GLMA/GLJE

Field Security based on the panel

Item Number None

Lot Description LMST/LOTR

Lot Number None

Lot Number Mask LMST/LOTR

Lot Revision LMST/LOTR

Lot User Def 1 LMST/LOTR

Lot User Def 10 LMST/LOTR

Lot User Def 11 LMST/LOTR

Lot User Def 12 LMST/LOTR

Lot User Def 2 LMST/LOTR

Lot User Def 3 LMST/LOTR
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Specifying Criteria
The Find feature enables you to search for data based on search criteria that you enter. By 
entering field values, you can filter the master list to a specific set of data. Criteria can be entered 
using several methods:

Using Order Number Assignment
The Order Number Assignment feature provides an easy method of automatically generating 
sequential order numbers for customer, purchase and manufacturing orders. The Order Number 
Assignment feature can be accessed from either Fourth Shift WebUI or the traditional Fourth Shift 
system. Both user interface types will use the same order number assignment database and will 
work correctly for a mix of users. For more information about using the Order Number Assignment 
feature, see the Fourth Shift Basics online help.

Lot User Def 4 LMST/LOTR

Lot User Def 5 LMST/LOTR

Lot User Def 6 LMST/LOTR

Lot User Def 7 LMST/LOTR

Lot User Def 8 LMST/LOTR

Lot User Def 9 LMST/LOTR

Vendor Lot Number LMST/LOTR

Criteria Type Description Example

Starting Characters You can enter the starting characters 
of data and the Find feature displays 
a list of all the data that begin with 
those characters.

If you enter "12" in the Cust ID field, the 
Find feature displays a list of all customers 
whose identifiers start with "12", such as 
120001, 120002, and 120003.

Wildcards You can enter a space before the 
criteria and the Find feature displays 
a list of the data that contains the 
specified criteria anywhere in the field 
value.

If you know part of a customer identifier, 
you can enter it with a space (by pressing 
on the space bar) before it, such as 
"<space>   05". The Find feature displays 
all customers with "05" anywhere in the 
identifier, such as 050004, 100005 and 
100052.

Multiple Criteria You can enter criteria in more than 
one criteria field and the Find feature 
displays a list of the data that matches 
all the criteria entered.

If you enter "12" in the Customer ID criteria 
field and "San Diego" in the City criteria 
field, the Find feature displays a list of all 
customers whose identifiers start with "12" 
and whose city is "San Diego".

Field Security based on the panel
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Using the Charting Feature
The Charting feature provides a method for you to set up portals with frames that include tables 
and graphs. These frames are child frames that "listen" to the parent frame and display information 
accordingly.

Setting Up the Portal
When creating your portal, you need to select the FSChart frame type in order to use the Charting 
feature. See Add Charting Portal for more information on setting up a portal with the Charting 
feature.

Using the Charting Samples
Several graph and table samples are delivered with Fourth Shift WebUI. For example, the sample 
Inventory Location charts are child frames that listen to the ITMB and ITMC panels and the sample 
Customer Orders by Month, Customer Orders by Year and Orders by Month charts listen to the 
CUID and COCD panels.

For example, you can create a portal that includes a Fourth Shift WebUI frame that defaults to 
ITMB (Item Master) or ITMC (Item/Workcenter Cost Data) and a charting frame that displays an 
Inventory Location graph and table. When the Fourth Shift WebUI frame changes from one item to 
another, the graph and table changes accordingly, displaying the information for the current item.

Creating User-Defined Charts
The Charting feature allows you to create your own charts. Use the pre-defined charts, located in 
workplace database as examples to create your own graphs and tables. My Fourth Shift 
Workplace contains a Chart Builder portal in the Portal Admin Group that can be used to create 
and maintain chart definitions.
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Using the Fourth Shift Explorer
The Fourth Shift Explorer provides a centralized point of access into the applications in the Fourth 
Shift system, and the activities you can perform with them. It also manages your Fourth Shift 
"workspace" and helps you navigate in the system.

The Fourth Shift Explorer helps you become familiar with Fourth Shift, and helps you work more 
effectively by providing a variety of ways to access the system. From the Fourth Shift Explorer, you 
can open Fourth Shift applications, complementary applications, or even popular desktop "office" 
applications.

Net UI and Other Startup Options
Several options must be specified on the Explorer Options dialog before using the Fourth Shift 
Explorer. For example, before you use the Fourth Shift Explorer with Net UI, you must supply Net 
UI connectivity details and your navigation preference since Net UI allows you to open multiple 
Fourth Shift windows on your desktop at one time. Other startup options include setting window 
controls and database connections.

Complete the following steps before using the Fourth Shift Explorer:

1. From the View menu of the Fourth Shift Explorer, choose Options.

2. If you use Net UI, complete the following steps:

a Select the Run Net UI check box.

b. Enter your Server name, Port number, and Net UI ID.

c. Select one of the following Navigation preference option for when you navigate from the 
Fourth Shift Explorer: 

- Use a New Window

- Reuse an existing window when possible

4. Select the Show function code in Explorer Applications list checkbox, if you want to 
display the screen's Function Code beside the name of the screen.

5. Select one of the following Explorer Window options: 

- Normal

- Always on top

- Minimize on use

6. Select the Startup Options for connecting to the database:

- Select the Maintain Connection check box for the database to stay open once the 
connection is established.

- Select a No Connection Available option for when no connection to the database 
could be made: either Show all options to display all the applications and activities or 
Show remembered to display only those applications and activities remembered 
from your previous logon.

7. Click OK.

Note: You must restart the Fourth Shift Explorer for the specified options to take effect and 
in order to run Net UI using the Fourth Shift Explorer.
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Overview
The Fourth Shift Explorer provides three basic approaches to accessing the Fourth Shift system.

• The Applications tab lists the available applications in the Fourth Shift system, by module. 
Use this list to access a specific application, screen or function code.

• The Activities tab lists the most common activities performed in the Fourth Shift system. Use 
this list when you have an activity or task to perform, but don't know which application, screen 
or function code to use.

• The Workspace tab lists the Fourth Shift applications that are currently running, with status 
information about each. Use this tab to create workspaces, create links to open applications 
and manage the windows listed.

Using the Applications Tab
The Applications tab enables you to access Fourth Shift using a list of available applications and 
function codes, sorted alphabetically by module. Double-click an entry in the Applications list to go 
to that location.

Fourth Shift is the most frequently used application in the system, and you can use the Fourth Shift 
Explorer to go to any specific screen or task. You can also use the Fourth Shift Explorer to go to 
applications in the Engineering (ENGM), Sales Order Processing (SOPM), Sales Analysis (SAAM) 
and other modules.

For many screens, you can use the Explorer to supply data values for one or two key fields. The 
data values you enter are filled in when the screen is opened, overriding any remembered fields 
that may ordinarily be filled in. For example, if you want to go to the Purchase Order (POMT) 
screen, you can enter a Purchase Order Number in the Fourth Shift Explorer.

Using the Activities Tab
Activities are sorted alphabetically by subject. Double-click an entry in the Activities tab to go to 
the location where the activity is performed. Additionally, the Fourth Shift Explorer displays step-
by-step instructions and tips for performing the activity.

As with the Applications tab, you can supply data values for one or two key fields. For example, if 
you want to delete a line item from a purchase order, select "Delete Purchase Order Line Item" 
from the Activities tab and enter the Purchase Order Number. The Fourth Shift Explorer will open 
the Purchase Order (POMT) screen and display steps and tips for the activity.

Using the Workspace Tab
The Workspace tab displays your "current workspace," a list of currently active Fourth Shift 
applications. The current workspace also shows the status of each application. For Fourth Shift, 
this status includes the function code and data values for key fields.

You can use the Workspace tab to activate, minimize or close any window shown. You can also 
use the Workspace tab to create "links" that open applications, such as to a specific Fourth Shift 
screen or to any file or program. For more information, see Exploring By Link.
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Exploring Fourth Shift
The purpose of the Fourth Shift Explorer is to help you learn your way around Fourth Shift by 
providing a variety of ways to access the system. Each of the five basic methods of exploring 
Fourth Shift offers a different approach. Whether you are a new, casual or experienced Fourth 
Shift user, the Fourth Shift Explorer can help you move around the system efficiently.

Exploring By Function Code
Traditional navigation within Fourth Shift involves typing a function code into the Function field. 
This method is also available in the Fourth Shift Explorer and is helpful for experienced users who 
are very familiar with the system. If you know exactly which screen or task you need to use, 
exploring by function code is an efficient way to get there.

Enter a function code in the Function field of the Fourth Shift Explorer using either the 
Applications or Activities tab.

• If you are using the Applications tab, the list will display the name of the screen related to the 
function code.

• If you are using the Activities tab, the list will display an activity performed on the screen 
related to the function code.

Click Go To to view the screen. If you want, you can enter data values for one or two key fields as 
well.

Exploring By Screen
The Applications tab lists all of the screens and tasks available to you, sorted by module. In this 
way, it works similarly to the master menu and module menus. Double-click a module name to 
view a list of the available screens within that module. Double-click a screen name to go to that 
screen. If you want, you can enter data values for one or two key fields as well.

This method is helpful for experienced users who understand the system and the way it is 
structured. If you work often with a large number of screens and know which screens belong to 
which modules, exploring by screen is an effective way to navigate in the system.

Optionally, you can display a screen's Function Code beside the name of the screen by selecting 
the Show function code in Explorer Applications list checkbox in the Explorer Options dialog 
box. You must restart the Fourth Shift Explorer for the option to take effect.

The Fourth Shift Explorer also provides access to applications in the Sales Order Processing 
(SOPM), Rules Based Pricing (RBPM), Sales Analysis (SAAM) and other modules. These 
applications are not accessible through the menus.
Fourth Shift Basics 90



Fourth Shift Release 7.50 Using the Fourth Shift Explorer
Exploring By Activity
The Activities tab lists hundreds of activities commonly performed with Fourth Shift at a variety of 
levels of sophistication. The Activities tab can help you add, change or delete data, run and print a 
report, analyze data or execute a batch process. The Activities tab is designed for users who are 
working in unfamiliar areas of the system.

To use the Activities tab, do the following:

1. Scroll through the list to find a subject related to the activity that you want to perform. 

Subjects are common business objects such as customers, shipments, or invoices. 

2. Double-click a subject to see a list of activities. (

In some cases, activities are grouped into subcategories within a subject. 

3. Double-click an activity to go to the location where it is performed. 

If applicable, you can enter data values for one or two key fields as well.

This method is helpful for new or casual users, as well as experienced users in new roles or 
situations. If you are working in an unfamiliar area of the system, exploring by activity can direct 
you quickly to the screen you need to use and help you learn about the features and functionality 
of Fourth Shift.

Exploring By Subject
Subjects are common business objects such as customers, shipments or invoices. You can 
search for screens or activities that relate to a particular subject.

To search by subject, do the following:

1. Select a subject from the Search For box using either the Applications or Activities tab. 

The list is filtered to display only the applications or activities related to the selected subject.

2. Click Go To to locate the screen the application or activity you want to view.  

If you applicable, you can enter data values for one or two key fields as well.

Exploring By Link
Links work like bookmarks or shortcuts, allowing you quick access to an application. You can 
create a link to any application shown on the Workspace tab, or to any program or document 
appearing in the Windows Explorer. For example, you can create links to spreadsheets or word 
processing documents created by any application. A workspace can even contain a link to a page 
on your Intranet or on the World Wide Web.

You can open a link by double-clicking the link in the Organize Links dialog box, or by selecting it 
from the Links menu. When you open a link, the related document or program automatically 
opens and is added to the Workspace tab.
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Workspaces
A group of links is called a workspace. You can create links and workspaces that are for your use 
only or are available to be shared by your colleagues. 

• My Workspaces
Links stored here are for your use only and are not available to others. But, you can use the 
Import and Export menu options to send and receive personal links to others.

• Public Workspaces
Links stored here can be shared. You must sign on to the Fourth Shift Explorer as an 
administrator in order to add, change or delete links to public workspaces. For more 
information, see Administrator Sign on.

Links are displayed in both the Organize Links dialog box and in the Links menu. To view the 
dialog box, do one of the following:

- Select Organize Links from the Links menu 

- Click Organize Links on the Workspace tab

Links to a Fourth Shift Screen
You can create a link to a Fourth Shift screen using the Workspace tab. If you want, you can even 
create a link to a screen showing specific key field data, such as a single purchase order or 
invoice. The Description that is shown on the Workspace tab identifies the additional information 
that is contained in a Fourth Shift link.

Modifying a Link
You can modify the properties of an existing link using the Link Properties dialog. To open the 
dialog, do the following:

1. Select then right-click the link you want to change 

2. Choose Properties. 

The date and time of the last change to the properties is recorded in the Last Modified field 
for your reference.

Security and the Fourth Shift Explorer
When you open the Fourth Shift Explorer, a signon dialog box is displayed, allowing you to enter 
your User ID and Password. This information is validated to ensure that you are an authorized 
user, and a list of the screens and tasks you are permitted to access is compiled.

Once the Fourth Shift Explorer has validated your security information, you can navigate to Fourth 
Shift screens without signing on again. For more information, see "Securing the System" in the 
Getting Started manual.

Filtered Applications and Activities Lists
By default, the Fourth Shift Explorer displays only the applications installed on your workstation, 
and the activities that can be performed with them. In addition, it filters the function codes that are 
not related to your job, displaying only screens and tasks that match the access codes assigned to 
you by your system administrator.

For example, if your system administrator has allowed you to access only certain screens, these 
screens are the only ones displayed on the Applications tab. Likewise, only the activities 
performed on those screens are shown on the Activities tab, and only the subjects related to 
those screens are listed in the Search For Subject list.
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Security Validation Process
The process used by the Fourth Shift Explorer to determine which applications or activities to 
display looks similar to the following:

Administrator Sign on 
The Fourth Shift Explorer has several modes of operation: administrator and standard. Using 
either mode, you can create links and workspaces for your own use. But, you must be in 
administrator mode to create public links and workspaces or to customize the applications list.

If you have authority to do so, use the following information to sign on to the Fourth Shift Explorer 
as an administrator:

1. Use Windows Explorer to go to the MFGSYS\SYSTEM directory.

2. Create a shortcut for the FSEXPLR.EXE file.

3. Right-click the shortcut and choose Properties.

4. Add \admin to the Target command line.

5. Click OK.

6. Rename the new FS Explorer shortcut to: FS Explorer – Admin.

Is the database connection available?

Display Fourth Shift Explorer

Validate User Id and Password

- Open Fourth Shift Explorer
- Enter User Id and Password

Are User Id and Password valid?

No

Yes

No

Yes

- Determine which function codes may be accessed
- Determine which applications have been installed

error
message

Check  Startup
Options to verify
application list.
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Special Considerations
While the applications in the Fourth Shift system share a common look and feel, there are slight 
differences in operation between applications. Use the following guidelines for navigating to the 
applications in the Fourth Shift system.

Fourth Shift Application
The screens and tasks displayed in the Fourth Shift application interact seamlessly with the Fourth 
Shift Explorer. You can go to any screen or task in Fourth Shift from the Fourth Shift Explorer. You 
can also open the Fourth Shift Explorer by clicking the Explorer button on the Fourth Shift toolbar.

Frequently, you can supply one or two key field values to be filled in on the screen you are going 
to. If you do not enter key field values in the Fourth Shift Explorer, Fourth Shift uses its 
remembered fields feature to pre-fill key fields if applicable. See Working with Key Fields in the 
“Using Fourth Shift” chapter of the Fourth Shift Basics online manual for more information.

Fourth Shift Report Viewer
Each time you preview a saved report, Fourth Shift Report Viewer will be listed on the Workspace 
tab. If you have more than one saved report open on your computer at one time, each Report 
Viewer window will be listed separately.

You can create a link to the report, but only if it has been saved as a file first. If you try to create a 
link to a report that has not been saved, you will receive an error message.

The link you create is actually a link to the saved report file. Opening the link will open the saved 
report file in Fourth Shift Report Viewer, it will not regenerate the report.

Engineering Applications
If you use the Engineering (ENGM) or Manufacturing Analysis (MMAM) modules, the basic 
interaction between Fourth Shift and the Fourth Shift Explorer is unchanged. However, some 
Fourth Shift Explorer features are unavailable.

Security
If your Engineering module User ID and Password are different from your Fourth Shift User ID 
and Password, you must sign onto any Engineering application when you open it from the Fourth 
Shift Explorer.

Navigation
To return to the Fourth Shift Explorer from an Engineering application, press Alt+Tab or use your 
desktop Taskbar buttons.

Sales Order Processing and Rules Based Pricing Applications
You can use the Fourth Shift Explorer to open the applications in the Sales Order Processing 
(SOPM) or Rules Based Pricing (RBPM) modules. However, some Fourth Shift Explorer features 
are unavailable.

Navigation
You can use the Fourth Shift Explorer to open the Sales Order Processing module. However, 
you must press ALT+Tab or use your desktop Taskbar buttons to move between the two 
applications once both are open.
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Sales Analysis Applications
You can use the Fourth Shift Explorer to open the features of the Sales Analysis (SAAM) module. 
However, some Fourth Shift Explorer features are unavailable.

Security
The Fourth Shift Explorer does not supply security information to the Sales Analysis database. 
You may need to sign onto it separately when you open it from the Fourth Shift Explorer.

Navigation
To return to the Fourth Shift Explorer from the Sales Analysis database or applications, press 
Alt+Tab.

Fourth Shift Explorer Menu Options
You can access a number of application features using either the menu bar located at the top of 
the window or from several pop-up menus within the Fourth Shift Explorer.

Menu Bar

Menu Option Description

Edit/
Copy

File Import Imports a specified link.

Connect Establishes a connection to the database.

Disconnect Removes the connection to the database.

Exit Closes the Fourth Shift Explorer.

View Options Defines your system-wide and application-specific settings, 
including display and navigation preferences.

Links Organize Links Displays your links and workspaces.

My Workspaces Displays a list of personal links.

Public Workspaces Displays a list of publicly shared links.

Help Help Topics Opens the Fourth Shift Explorer section of the Fourth Shift 
Basics online manual.

About Fourth Shift Explorer Displays the version and name of the application.
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Pop-Up Menu

Option Description

Open Opens the current links in the workspace.

New Create a new workspace or link.

Cut Removes the selected link and puts it on the Clipboard.

Copy Copies selected workspace or link to the Clipboard.

Paste Inserts a copy of the Clipboard contents at the insertion point.

Delete Removes the selected workspace or link.

Rename Allows you to rename the workspace or link.

Properties Displays the current properties of the application or link.

Export Exports a specified link.

Import Imports a specified link.

Refresh Redisplays the view including any changes.
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Using Fourth Shift Portals
With My Fourth Shift Workplace, you can create configurable views of information called portals. A portal 
can include the web-based version of the Fourth Shift program itself, as well as existing intranet resources, 
third-party browser-based applications, or even external Internet Web sites.

Portals can include various types of information in a number of different arrangements. Each different area 
of information in the portal is called a frame.

What is Included in a Portal?
A Portal is a set of views to Fourth Shift data as well as data from other web sites. A Portal is set 
up as a collection of frames. The collection can represent a set of related data or a sequence of 
tasks that are completed.

This collection of information can include a variety of Fourth Shift data, or some Fourth Shift data 
along with other web content from your corporate intranet or external internet resources.

You can design portals to contain a variety of resources needed to perform a specific job. (For 
example, a portal for customer service representatives could include a set of commonly-used 
Fourth Shift screens, a customer relationship management system, and the DHL shipment 
tracking web site.) Portals can also provide an overview to a specific segment of your business, 
such as a segmented view of continuously updated management reports.

There are a number of concepts you should understand about portals before you begin completing 
administrative tasks. Review and understand the following terms.

Frames
A Frame is an individual area of information displayed through a portal. Frames are a concept 
used in Internet browsers as well, and several types of frames included with My Fourth Shift 
Workplace provide enhanced communication between frames. These unique Fourth Shift frame 
types can publish data and subscribe to data for use in other frames. See "Frame Types" for more 
information. 

A portal can have a maximum of 20 frames defined by a maximum of 4 columns, each with a 
maximum of 5 rows.

Portal Types
Portal definitions are created in one of the following categories:

• Public portals can be accessed by all users. This is useful for a general purpose portal, 
beginning a portal for other users or templates for users to begin with when constructing their 
own portal.

• Private portals can be accessed only by the user that creates them. This allows users to 
create a number of specific portals that allow them to complete their jobs more productively. 
For example, users may create different portals for monthly tasks or for solving specific types 
of problems.

Both public and private portals are organized into groups which allows you to locate portal 
definitions more quickly. You should consider assigning logical names to public groups such as 
department names or functional area descriptions.
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Portal Manager
The Portal Manager controls the frames included in the portal by managing the operation and 
communication between the frames. It also provides a way for you to define, manage and select 
portal definitions. 

The Portal Manager is automatically included in each portal definition. The Portal Manager 
consists of two primary elements:

Portal Bar
The portal bar is the top frame in the portal. It contains the identification title of Fourth Shift and 
several important features including:

• Current Portal and Portal List access. On the left side of the Portal Manager frame is the 
portal list access button. The title on the button is the name of the portal you are currently 
viewing. When you click the title, the list is displayed. Clicking the title when the list is already  
displayed, hides the list.

• Portal Security link. Allows you to grant portal admin access to current portal users, revoke 
portal admin access and view portal user account information. Only a portal administrator will 
see this icon.

• Preferences link. Allows you to set up and create portal definitions and personal preferences.

• Save Layout link. Updates the frame sizes and locations of the current portal to match the 
current display. This portal will then display with this layout when accessed.

• Log Off link. Exits all Fourth Shift frames. This method of exiting Fourth Shift allows screen 
level validations to be completed when you exit the system. Closing the Internet Explorer 
browser does not communicate with the Fourth Shift frames so no validation is completed. It 
is highly recommended that you always use the Log Off link in the portal bar to exit My 
Fourth Shift Workplace.

• Help button. Opens the online help for the Portal Manager within My Fourth Shift Workplace. 
The active tab in the help describes portals. Use the other tabs to learn about using the Fourth 
Shift specific frames like WebUI and Explorer. 

Portal List
The portal list includes all portal definitions that are available to you. Both public and private 
portals are available by clicking the button in the list that contains these items. Open the portal list 
by clicking the title of the current portal displayed on the left side of the portal manager.

The following options are available as buttons in the list.

• The Portal Admin portal group is visible only when you are logged in as the main portal 
administrator. It allows you access to all portals created by the main portal administrator for 
this portal group, as well as the default admin portals: Explorer Security and Remote Server 
Admin.

• The Connectivity Toolkit portal group is visible only when you are logged in as the main 
portal administrator and you have this module installed. It allows you access to the portals that 
are part of the Connectivity Toolkit module used to customize the WebUI interface.

• All Public Portals shows the public portal definitions that are available to all users, in a single 
list.

A set of sample role-based public portals is installed with My Fourth Shift Workplace. These 
portals are provided to give you some ideas and a template to start building new portals, if 
desired.

• Group Tree shows the list of public and private portals, by group, in a tree view.
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• The names of any private groups defined for the specific user also appear as buttons in the 
Portal List.

Frame Definitions
Each frame is defined by a set of information, which determines how the frame behaves and 
relates to other frames in the portal. Frame definitions are maintained using the Preferences 
option on the My Fourth Shift Workplace toolbar.

This frame definition consists of the following information.

• Frame Title

• Frame Type

• Predefined Location

• Parameters

• Parent Frame

• Fourth Shift User Information

• Default Frame Settings

Frame definitions are associated with both public and private portals. See "Portal Types" in the 
"Using Fourth Shift Portals" topic for more information.

Frame Title
Frame Title is the name displayed at the top of the frame. This title can include detailed 
descriptions of the content of the frame. When the frame is minimized, this title is still displayed to 
provide an easy way to identify the frame.

Frame Type
Frame type identifies the frame content and communication options available to other frames. The 
frame type determines the communication method available between frames and supplemental 
information that you can associate with a frame. This information might include information such 
as user identifiers and URL addresses. See "Frame-to-Frame Communication" for more 
information on communicating information between frames.

The frame types include the following:

Type Description

FS Chart Runs the Fourth Shift charting application. 

FS Explorer Displays the Fourth Shift Explorer application tree for navigation and assistance 
when using FS WebUI type frames.

FS Explorer Security Updates security information for the Fourth Shift Explorer.

FS Finder Runs the Fourth Shift Find application. 

FS UIEditor Runs the Fourth Shift UI Editor application. 

FS WebUI Runs a Fourth Shift session on the web server.

Terminal Server Runs a a Windows (non-Web) application through Windows Terminal Server.
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Each Fourth Shift WebUI type frame starts a Fourth Shift application session or connection to 
Fourth Shift information. For example, if you are viewing two frames of WebUI information, you 
have started two Fourth Shift sessions. Note that sessions are not the same as Fourth Shift user 
licenses. In the previous example, the two sessions share one user license.

Note: If a portal accesses multiple databases, it may consume multiple Fourth Shift licenses 
(one from each FS system).

Predefined Locations
Predefined locations, or names, allow you to create a reference to a server and then use that 
location name in the portal definition. The location names then allow the server definition to 
change as needed without interfering with the individual portal definitions.

Because the predefined location names are used in the portal definition, choose names that 
clearly identify what the server accesses. For example, use a location name like Colorado Plant 
rather than a server name like CCSVR-21.

Predefined locations are created by selecting the Preferences option on the My Fourth Shift 
Workplace toolbar and then clicking Locations.

Parameters
Parameters are supplemental characters passed when the web site is first accessed. Each frame 
type accepts different initialization strings. 

FS WebUI Frame Initialization
Fourth Shift WebUI frames accept an initialization string which allows the frame to execute a 
predefined sequence of keystrokes. The following apply to these initialization strings:

• Initialization strings for Fourth Shift WebUI type frames must start with a question mark (?) 
character. 

• The initialization string you enter is automatically sent when the frame displays. Be sure to 
input the same keystrokes as you would on a keyboard, including tabs between fields.

• The initialization string can include literal keyboard characters such as a function code, or 
special keys such as the TAB key. Special keys are entered in braces. For example, to 
transport to the BILL screen and display the item 19-FRAME, enter the following as the 
initialization string: ?BILL{ESC}19-FRAME{CR}. See below for a list of special keys.

• Special keys are not case-sensitive.

• If you are including data values in an initialization string, it is recommended that you use 
{Ctab} instead of {Tab} for tabbing between fields. 

Arbitrary Site Accesses a URL address for any web site that is not necessarily associated with 
Fourth Shift or one of the other frame types. 

Named Site Similar to an Arbitrary Site in that it can be used to access any web site. How-
ever, a Named Site allows the URL to be defined as a known location in the loca-
tion list, and then simply referenced by name.

KPI Display To display a Key Performance Indicator from the optional Business Intelligence 
module.

Type Description
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The special key values available for use in initialization strings include the following:

Keys Key Value

ALT+BACKSPACE {@BS}

ALT+ENTER {@CR}

ALT+Function key {@F1}, {@F2}, {@F3}, etc

ALT+TAB {@Tab}

BACKSPACE {BS}

BACKTAB {Btab} or {*Tab}

CTRL+BREAK {Break}

CTRL+DELETE {Del}

CTRL+DOWN {Dn}

CTRL+END {End}

CTRL+ENTER {CR}

CTRL+Function key {F1}, {F2}, {F3}, etc

CTRL+HOME {Home}

CTRL+INSERT {Ins}

CTRL+LEFT {Lt}

CTRL+PAGE DOWN {PgDn}

CTRL+PAGE UP {PgUp}

CTRL+PRINTSCREEN {PrtSc}

CTRL+RIGHT {Rt}

CTRL+UP {Up}

CURSOR LEFT {Lt}

CURSOR RIGHT {Rt}

DELETE {Del}

END {End}

ESC {ESC} or {Escape}

ENTER {CR}

Function keys {F1}, {F2}, {F3}, etc

HOME {Home}

INSERT {Ins}

PAGE DOWN {PgDn}

PAGE UP {PgUp}

SCROLL DOWN {Dn}

SCROLL UP {Up}
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FS Explorer Frame Initialization
Fourth Shift Explorer frames accept an initialization string, which allows the frame to display in one 
of the available modes. The following initialization strings are available:

Other External Frame Initialization
Communication with frames containing other external web sites will vary. One way to determine 
the string used to navigate the web site is to manually click the options to access the desired page. 
Then review the URL address displayed to begin understanding what elements are included. The 
initialization string usually follows the URL address and begins with a question mark (?) character.

Contact your Fourth Shift consultant if you want assistance in setting up complex external frame 
communication.

Parent Frame
Parent Frame identifies which frame in the portal should be used as reference data for this frame. 
This correlation allows you to link some frames to one parent and other frames to another parent.

If this field is blank in the frame definition, the frame does not monitor data messages from another 
frame. My Fourth Shift Workplace will not automatically refresh the data in the frame.

See "Frame-to-Frame Communication" for more information on communicating information 
between frames.

Fourth Shift User Information
Fourth Shift User Information is the security information needed to access Fourth Shift from this 
frame. The FS User Id and Password is used only with Fourth Shift specific frame types.

Fourth Shift user information should be specified for private portals only. Passwords can be 
entered in the definition and the value is passed to the frame each time the portal is launched.

Default Frame Settings
Several defaults may be specified when defining frames for using the Find, Charting, terminal 
server, and Business Intelligence frames.

SHIFT+Function key {*F1}, {*F2}, {*F3}, etc

SPACEBAR {Sp} or {Space}

TAB {Tab}

TAB (but not if the previous character trig-
gered an Auto Tab Between Fields)

{Ctab}

Initialization String Description

?Full=1 Start the FS Explorer frame type in Full Mode

?Full=0 Start the FS Explorer frame type in Simple Mode; this 
is the default mode if no initialization string is entered.

?Codes=1 Show function codes after screen titles

?Full=1&Codes=1 Combined

Keys Key Value
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Default Finder
Default Finder identifies which type of data you are searching for when the Find feature is opened 
as an independent frame. You can specify to search for data such as customers, vendors, orders 
or items.

When the Find feature is accessed as an independent frame using the FS Finder frame type, you 
can also specify how the find results are used. If you want the selected results to force navigation 
of a child Fourth Shift WebUI to a different screen, then check the Navigate Fourth Shift 
checkbox. Leave this checkbox blank if you want selections to merely suggest that a child Fourth 
Shift WebUI Frame move to the selected object. For example, when finding items, the WebUI 
Frame will display that item if it is currently displaying item information and it will ignore the 
selection if currently displaying vendor data.

The default finder options are available when the Frame Type = FS Finder.

Default Chart
Default Chart identifies which type of graph or table to access when the Chart feature is opened. 
You can specify to access information such as inventory location, customer orders by month, 
customer orders by year and orders by month. The default chart option is available when the 
Frame Type = FS Chart.

Screen Size
Screen Size identifies the amount of display space to setup for a terminal server frame. The 
Windows application you run will see this as its display resolution.

Default Application
Default Application is the initial Windows application that is started in a terminal server frame. 
This menu of applications can be customized and will be displayed again if you terminate the 
application.

Default KPI
Default KPI is the Key Performance Indicator selected to appear in this frame.

Frame-to-Frame Communication
My Fourth Shift Workplace expands on technology available in Internet browsers to allow frames 
to pass data from one frame to another. This communication allows frames to react or change 
based on information sent from another frame. Inter-frame communication allows you keep data in 
all related frames tracking so that when you move to view that frame, the necessary related 
information is already displayed.

Terms
Review the following terms related to frame-to-frame communication.

• Parent frame is the frame that is the source of data communication. This frame publishes the 
data to the Portal Manager, which is running behind the scenes as part of My Fourth Shift 
Workplace.

• Child frames listen for the data communication from their parent frame. The child frame 
reacts to the data by refreshing the content of the frame based on the new data. If no parent 
frame is listed, users need to interact with the frame directly to change the data displayed.

• Fourth Shift frame types automatically support frame-to-frame communication. 

• External frame types can either be another organization's web content (like DHL or UPS) or 
your own corporate intranet or web site. External frames can use data from a parent frame but 
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additional steps are needed to take advantage of the data. For example, you will need to 
identify initialization string elements to use in the URL address to refresh the external frame.

• Links are used by WebUI to identify navigation possibilities. For example, the Item field is a 
link to the Item Master on many WebUI screens. Links are normally displayed underlined if 
you have set your Internet Browser option to show links that way. 

Links also are used by WebUI in the frame-to-frame communication process to define which 
data elements are published to other frames. See "Communication Process" for more 
information.

Communication Process
Frames can communicate data between one frame and another. The methods used to 
communicate vary based on the frame type. The following rules apply to data communication 
between frames:

• Linked Data. The data published by Fourth Shift WebUI frames is determined by the data 
elements that are links to other screens. In other words, a message is published for each link 
on the parent screen.

• Parent/Child Relationships for Fourth Shift Frame Types. Fourth Shift frame types are 
able to take full advantage of the parent/child frame relationship. The linked data is 
communicated automatically between Fourth Shift type frames when the linked data is 
understood by the child frame.

• Parent/Child Relationships for Non-Fourth Shift Frame Types. External frame types are 
not aware of data that might be published by Fourth Shift frames. You can, however, develop 
your own web pages that are equipped to understand these messages. Use the sample 
applications provided with My Fourth Shift Workplace to use as a guide in developing your 
own pages. See the files in the Inetpub\WWWRoot\FSPortals\Sample directory.

External frames that are managed by another organization, like DHL or UPS, or are located on 
an external server can also be set up to respond to published data. However, setting up this 
communication can be complex. If you wish to establish this type of link, work with your Fourth 
Shift consultant for further assistance.

• Communication Limitations. The communication feature builds upon technology embedded 
in Internet Explorer. This technology requires that the parent and child frames are both located 
within the same domain. Therefore if your Portal Manager is located on a site on server 
MyServer.MyCompany.com, the communicating frames can be on any server in the 
MyCompany.com domain. This means that Internet Explorer will not allow a frame from 
MyServer.MyCompany.com to communicate with a frame from 
YourServer.YourCompany.com.

• Remembered Fields. The Remembered Fields feature in Fourth Shift WebUI allows you to 
navigate from one screen to another and retain key data being viewed on the previous screen. 
The Remembered Fields feature is available within a frame only. It is not available for frame-
to-frame communication.

Portal Images
Each portal definition is associated with a graphic image. This graphic is displayed in the Portal 
List. You can select from the set of images installed with My Fourth Shift Workplace, or you can 
create a set of your own.
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If you create images:

• Create the images in JPG format.

• Use an image size with a width of 120 and a height of 60 pixels.

• Save the final images in the InetPub\wwwroot\FSPortals\Images directory.

Virtual Space
The display space within the Internet Explorer can be managed in one of two ways:

• You can select this option to place the frames within a large virtual desktop. 

Each frame will consume its full size within this space and you can scroll the entire Internet 
Explorer window around the virtual desktop.

• You can leave the portal’s space to be that of the Internet Explorer window and use each 
frame’s maximize button to expand the frame and reduce it back again to its original size.

Running Microsoft Windows-based Applications in a Portal
The Terminal Server frame type is used to run Microsoft Windows-based applications through a 
My Fourth Shift Workplace portal. For example, you can run Microsoft Access as part of a My 
Fourth Shift Workplace portal using the Terminal Server frame type. You can also run components 
of Fourth Shift that do not currently take advantage of web-based technology, such as the Sales 
Order Processing (SOPM) or Engineering (ENGM) module.

A Terminal Server frame starts a Microsoft Windows Terminal Server session on a remote client. 
Windows Terminal Server allows you to use an application on the server to which you are 
connected as if you were actually sitting at the server.

Implementing Terminal Server Frames
Windows Terminal Server is an optional Microsoft component that can be installed as a part of 
your Windows Server or Windows Advanced Server installation. Once installed, Windows 
Terminal Server runs as an automatic service. However, Windows Server contains only a 
temporary license for using Windows Terminal Server, and you must purchase a permanent 
license from Microsoft Corporation before using Terminal Server frames.

In order to use the Terminal Server frame type, it must be configured. Contact Fourth Shift 
Customer Support for more information.

Starting Applications in a Terminal Server Frame
When you create a portal with a Terminal Server frame, you select a default application to open 
automatically in the Terminal Server frame when the portal is started. If you close the default 
application during your portal session, you can use the application list to select another application 
to run in that frame.

The application list is defined as part of the Terminal Server configuration process, using XML files 
stored in the InetPub\WWWRoot\FSPortals\WTS directory on the My Fourth Shift Workplace 
server. You can easily modify these files once the initial configuration has been completed.

Alternatively, you may run any Windows application in the Terminal Server frame by selecting 
"Windows Desktop" as the startup application when configuring the Terminal Server frame. See 
"Run a Microsoft Windows-based Application" in the Fourth Shift Basics online manual for more 
information.
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User Licenses and Terminal Server Frames
All Fourth Shift applications that are run through a Terminal Server frame use the same single user 
license as long as they are started using one of the following methods:

• the application is specified as the default application for the frame during portal setup

• the application is selected from the application tree in the Terminal Server frame

You can start a Fourth Shift application using a Terminal Server frame that displays the desktop if 
you wish, but any application started this way will consume an additional Fourth Shift user license. 
This method of starting Fourth Shift applications is not recommended.

ASP Sessions and Terminal Server Frames
Terminal Server Sessions are not the same as ASP sessions (for information on ASP sessions, 
see "My Fourth Shift Workplace User Information "). When the web browser connects to a terminal 
server, the ActiveX control in the frame establishes its own channel of communication with the 
Terminal Server, completely separate from the ASP session. Normally, it would be possible for 
different web browser instances, even on different clients to re-connect to the same Terminal 
Server session based solely on the use of the same Windows account when logging into the 
Terminal Server session. However, when a Terminal Server Session is started with a request to 
run an application at logon, an additional check is performed. 

The session is identified not only by the account name used to log in, but also by the command 
line used to start the application when the session begins. Therefore, a user will only re-connect to 
a particular session when using the same log in and the same command line. Since FS Portals 
passes the ASP session ID on the command line when starting an application for a Terminal 
Server session, there is a close correlation between ASP Sessions and Terminal Server sessions, 
even though they are considered separate. That means that closing the browser and starting a 
new one will never be able to connect a user to their old session because that unique session ID 
will not be assigned again.

There are only two ways that a user could connect to an old session:

• Leave the browser window open, switch between portals, and switch back to the original 
Terminal Server portal. Log in as the same user. Because the same user and the same 
command line will be sent (containing the same Session ID) the user will be re-connected to 
the session.

• Switch to a Terminal Server frame that does not start up an application, but instead exposes 
the desktop. This will connect the user to any running session under the Windows account 
used to log in. If multiple sessions for that user are running, they will be presented with a list of 
sessions to select one.

Because these sessions are difficult to reconnect to, My FS Workplace will attempt to clean up a 
session instead of allowing it to continue running after it is disconnected. The action is similar to an 
automatic log-off when the connection is broken (when the portal is closed or switched to another 
portal). That means there is practically no way to reconnect to a running session once a user 
disconnects from it. This frees up licenses that may have been in use by that session. If the log off 
fails because a running application contains unsaved data or cannot exit at the time, the session 
(and any applicable license locks) will remain active until the application closes cleanly or until the 
Terminal Server disconnected-session timeout expires. Then the session will be closed, forcefully 
if necessary.
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Portal Administration
Portal management can be done by users as well as administrators. You should consider how you 
wish to administer portals in your company as part of your overall system administration plan.

The following are some administration considerations:

• Portal definitions are stored in a Microsoft SQL Server (or SQL Express) database that is 
created when the server installation is done. This workplace database is called FSWorkplace 
by default. This technique allows users to run My Fourth Shift Workplace from any machine 
and use the portals defined for them. 

• The workplace database should be included in your daily backup if you are concerned about 
restoring this information in the event of a system failure. See "Performing Daily Backups" in 
the My Fourth Shift Workplace manual for more information.

• The portal administrator is a user with the ability to perform the advanced administrative 
tasks for My Fourth Shift Workplace. By default, it is the user who installs the My Fourth Shift 
Workplace software who becomes the main portal administrator. Only a portal administrator 
can perform the following administrative tasks:

- View and use the private admin portal groups (Portal Admin and Connectivity Toolkit)

- Delete any public or private portal

- Edit public portals
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Printing and Generating Reports in WebUI
My Fourth Shift Workplace has printing and reporting features similar to the reporting functionality 
within Fourth Shift. 

Reporting Features
• Most Fourth Shift screens can generate one or more reports. Select Preview or Print from the 

Reports menu to generate a report.

• Many batch process tasks also generate reports. Use the BEXE (Batch Execution) screen to 
specify the Report Destination for batch process reports.

- If Report Destination = 1, the report is displayed in a separate window. It is not 
printed directly.

- If Report Destination = 2, the report is printed to disk on the Fourth Shift server. The  
report is not displayed on your computer. In order to view the report, you must access 
it using a LAN or dial-up connection.

When you generate a screen report or batch process report, WebUI opens the report in a separate 
window after the report is generated. Each report opens a new window or in a new Internet 
Explorer tab. You can then print the report using any printer set up on your computer, or save the 
report to a file.

Note: The report will not be displayed until it is completely generated. Depending on the 
complexity and amount of data in the report, you may experience a slight delay before 
the report is displayed.

Template-based Reports
For template-based reports, a browser window opens containing the web-enabled version of the 
Crystal Reports viewer. This window displays the report.

RTF-based Reports
For RTF-based reports, a browser window opens containing Microsoft Word or Microsoft Word 
Viewer, if they are installed on your computer, and if one of them is defined as the default 
application used to view RTF files. 

Other RTF file viewers will probably not be able to display reports acceptably. Reports are not 
displayed automatically in a browser window if you use an RTF file viewer other than Microsoft 
Word, Word Viewer, or Fourth Shift Report Viewer. Instead, you will be asked either to download 
the RTF file to their workstation for later viewing, or to open it directly on the server.

Microsoft Office is Installed
If Microsoft Office is installed on your computer, Microsoft Word is probably the default application 
used to view RTF files. You may want to consider changing the default application to Microsoft 
Word Viewer since that program will load more quickly than Word. Word Viewer is installed as part 
of the Word installation within Microsoft Office.

When you use Microsoft Word or Word Viewer, be sure that your View option is set to Page 
Layout. This option displays the document header and footer, which may contain report data.

Microsoft Office is Not Installed
If Microsoft Office is not already installed on your computer, it is recommended that you install 
Microsoft Word Viewer. Contact your system administrator for instructions.
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Fourth Shift Report Viewer may also be used with acceptable results, although reports will not 
display in a browser window. Contact your system administrator for assistance in setting up Fourth 
Shift Report Viewer as your default application for RTF files.

Using Navigation Features
Fourth Shift WebUI offers a variety of system-wide features designed to provide flexibility and 
consistency across modules.

Using the Mouse
You can use your mouse to complete the following actions:

Action Description

Select a menu option Move your mouse over a menu, such as Reports, Tools or 
Help, to open it; then click a menu option to select it.

Select a portal bar link Click any portal bar link to perform the command.

Move to related screen Click any active tab to go to the tab. Click any link or the Next 
Step icon to go to the screen.

Go to an open field Click the field to move quickly to that field.

Select from a list Click any item in a selection list. The dialog closes and the 
data is inserted into the open field.

Activate a row Click on the line marker in a scrolling line to go to the first open 
field in that row.

Select text Click and drag over text in an open field to select it, or double 
click in any open field to select an entire word.

Go to the screen entered in the 
Function field

Click the Go button, which is next to the Function field.

Go to the previous screen Click the Back button, which is next to the Go button.

Save data Click Submit, which is in the lower right corner of the panel.

Change currency display Click Change, which is the lower right corner of the panel 
when the MCMM (Multi-Currency Management) Module is 
installed.
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Using Menu Options
Use the menu options to gain access to specific functionality. The menus are located in the upper 
right area of the screen and include the following:

Using Tools
My Fourth Shift Workplace WebUI has the same data entry and screen navigation tools as the 
traditional Fourth Shift program, but they are accessed differently. The data entry and screen 
navigation functionality is found on the Tools menu on My Fourth Shift Workplace.

Selecting from a Browse or Detail List
Use the Browse/Detail option on the Tools menu to select a record from a browse or detail list. 
For example, if you are on the CO Number field and you don't know the specific customer order 
number, use the Browse/Detail option to go to the Customer Order Browse screen. The Browse/
Detail feature can also be accessed using the CTRL+B keys.

Setting up Defaults
Use the Default Setup option on the Tools menu to activate the default mask and open the Mask 
Setup window. You can use the Mask Setup window as a tool if you need to enter repetitive or 
similar data. The Mask Setup option is not available from all screens, but on some screens it is 
available as a tab, in addition to the Tools menu.

Using Extended Text
Use the Extended Text option on the Tools menu to enter descriptive, context-specific text 
messages. The Extended Text option is not available from all screens.

Performing Mass Maintenance
Use the Mass Maintenance option on the Tools menu to select an action such as mass updates. 
Mass maintenance actions are screen-specific. Each Mass Maintenance Menu displays only the 
actions available on the current screen. 

Using Cash Reversal Selection
Use the Cash Reversal option on the Tools menu to go to the Cash Reversal Selection window. 
This option is only available when you are on the ARCD (A/R Cash Deposits) or ARPD (A/R Prior 
Period Cash Deposits) screens.

Adding Data
Use the Add Data option on the Tools menu to open a new line to add data to your screen. The 
Add Data feature can also be accessed using the CTRL+A keys.

Deleting Data
Use the Delete Data option on the Tools menu to delete the selected line from your screen and 
from the database. The Delete Data feature can also be accessed using the CTRL+D keys.

Menu Description

Reports Generate reports for the screen. 
Use the mouse or Ctrl+R keyboard shortcut.

Tools Access supplemental screen functionality, such as mass maintenance. 
Use the mouse or Ctrl+T keyboard shortcut.

Help Use to gain quick access to context-sensitive help, including screen help, field 
help and field messages. 
Use the mouse or Ctrl+H keyboard shortcut.
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Field Action
Use the Field Action option on the Tools menu to perform an associated action for the current 
field. The Field Action option is only available from selected screens. The Field Action feature can 
also be accessed using the CTRL+F keys. You can use the Field Action option on the following 
screens:

Screen Field Description

Batch Process Execu-
tion (BSET)

Task Display the task parameter formats and require-
ments.

Parameters Validate the task parameters.

Configuration of Inter-
face Account Numbers 
(CNFA) F8

Master Account No Display the organization and account description.

Customer Order Action 
(COAN)

Remaining Required 
Quantity or Ship Date

Display the item quantity (Order Qty and Shipped 
Quantity) that is available to promise. 

Customer Order 
(COMT)

Item Display the item description based on the type of 
item that was originally identified.

Order Qty (no Prom 
Dlvry)

Display the date the quantity is available.

Order Qty (and Prom 
Dlvry)

Display the availability of the quantity on the date.

Prom Dlvry (no Order 
Qty)

Display the quantity available on the date.

Ship Id Scroll through ship ids until the desired information is 
displayed. Make changes as necessary and press 
ENTER.

Tr LT Based on the transportation lead time and promised 
delivery date, display the calculated shipping date.

Unit Price (field empty) For quoted customer items (LS = Q) display the 
quoted price, or the Customer Item Price defined for 
a previous order on the Custom Product Detail 
screen.

Unit Price (field empty) For standard items (LS = S) display the calculated 
price.

Unit Price (value 
entered)

Display the adjusted price, or the comparison 
between the item's standard price and the actual 
price entered.

Custom Product Main-
tenance (CPMT)

Quantity (no Due Date) Display the availability date for the quantity or capac-
ity.

Quantity (and Due 
Date)

Display the availability of the quantity or capacity 
based on the specified date.

Due Date Display the available quantity or capacity for a spe-
cific date.

Customer Name/
Address Detail (CUS1)

Ship Id Scroll through ship ids until the desired information is 
displayed. Make changes as necessary and press 
ENTER.
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Toggling Currency Information
Currency information is displayed in a boxed area near the bottom of the WebUI frame if your 
Fourth Shift system includes the Multi-Currency Management Module (MCMM). Currency 
information includes the currency description and exchange rate.

Click the Change button to toggle all monetary values on the screen between the local currency 
and the foreign currency.

G/L Recurring/Tem-
plate Trans Detail 
(GLR1)

Cycles Determine the number of cycles completed to date.

Planner Action 
(MOAN)

Open/Suggested Order 
Qty

Display the item quantity (Quantity Ordered and 
Quantity Shipped).

Option Selection 
(OPSL)

Configuration Qty / 
Reqd Date

When an item is set up on the Planning Detail 
screen to calculate ATP quantities (ATP = Y or P) 
you can determine when the required quantity is 
available and /or what quantity is available on a spe-
cific date.

Buyer Action by Ven-
dor (POAN/POAS)

Open/Suggested Order 
Qty

Display the item quantity (Quantity Ordered and 
Quantity Rcvd)

Picklist (PICK) Reverse Quantity Display information on quantity required, issued and 
allocated.

Purchase Order 
(POMT)

Unit Price Load the unit price for the new order quantity as 
defined on the POCT screen.

PO Line Item Detail 
(POM2)

Conv or UM Display the most current values.

Bill of Lading (SBOL) Ship to Id Scroll through existing ship ids; press ENTER to 
select one

Ship (SHIP) Reverse Quantity Display information on quantity required, issued and 
shipped.

Shipment Quantity Display information on quantity required, issued and 
shipped.

Packaging Detail 
(SHI1)

Package Typ, Line 
Item Quantity, Weight 
or Volume

Calculate the package values. A net change might 
be calculated when adding items to an existing pack-
age.

Weight Calculate the package weight when you combine 
items in packages.

Screen Field Description
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Using Portal Bar Links
Use the portal bar to gain access to specific functionality. The portal bar links are located in the 
upper right area of My Fourth Shift Workplace portal and include the following:

Differences in My Fourth Shift Workplace
Several differences exist in My Fourth Shift Workplace with which existing Fourth Shift users may 
not be familiar. 

Fourth Shift WebUI Compared to Fourth Shift GUI
• Reports generated from My Fourth Shift Workplace are displayed on screen in a browser 

window if Report Destination = 1 (printer) on the BEXE (Batch Execution) screen. This allows 
you to select a desired printer.

• Files generated by the following tasks in My Fourth Workplace are created on the server 
instead of on your workstation: ACCX (Access Extract), ASCX (ASCII Extract), DBSX (dBase 
Extract) and EXLX (Excel Extract). You also can transfer these files to your client if desired. If 
you want these files to be generated on your local machine, you need to use the traditional 
Fourth Shift program.

• On the BEXE (Batch Process Execution) screen, the ability to show or hide details is no longer 
needed since detail messages are always shown during processing. Also, the Stop button has 
been split into two buttons called Stop Task and Stop Batch so that a second dialog is not 
needed.

• The following parameter functionality is no longer available when using the IMPT (Data 
Import) and RCVR (System Recovery) tasks:

- S Parameter: Step Mode. The Step Mode ability of the S parameter is not available 
in WebUI. The Step Mode ability allowed you to start the import process in single step 
mode so you could review each keystroke for troubleshooting purposes. The other S 
parameter abilities, such as allowing you to Pause, Continue or Stop, are still 
available.

- Vx Parameter: View Mode. The View Mode (Vx) parameter is not available in WebUI. 
This parameter allowed you to control how the user interface was displayed during 
import processing. You could hide transaction processing (VH), minimize the entire 
Fourth Shift session (VM) or show transaction processing (VS). 

The specified parameter functionality is not needed to save processing time. WebUI will 
always run in a manner similar to using hidden windows for the fastest performance.

Link Description

Portal Security To grant and revoke admin rights. Only shown for a portal 
administrator.

Preferences Edit portal and location preferences.

Save Layout Allows you to save changes to the size and position of the 
frames within the portal layout.

Log Off The preferred method to close My Fourth Shift Workplace.

Help Opens help for My Fourth Shift Workplace.
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You can use the traditional fat client Fourth Shift program to run the IMPT and RCVR tasks 
using the S parameter for Step Mode and the Vx parameter for View Mode, if desired.

• The size of each screen is based on its original size in Fourth Shift. For example, several 
detail screens in Fourth Shift WebUI are smaller than the main screens because these detail 
screens were smaller than the main screens in Fourth Shift.

• Several Fourth Shift modules do not take advantage of My Fourth Shift Workplace web-style 
features. See "Restricted Features" in the My Fourth Shift Workplace manual for more 
information on which modules need to run under a Windows Terminal Server frame.

Internet Explorer Options Compared to Fourth Shift WebUI
Several similar menu options and buttons are available from your Internet Explorer (IE) browser 
and from within Fourth Shift WebUI.

• Menus. Use the menus from the IE browser if you want to use the IE browser functionality. For 
example, use Internet Options from the Tools menu to configure your browser. Use the menu 
options from within Fourth Shift WebUI if you want to use Fourth Shift functionality. For 
example, use Browse/Detail from the Tools menu to open browse or detail windows.

• Buttons. Use the buttons from the IE browser if you want to use the IE browser functionality. 
For example, click the Favorites button to open your list of favorite sites. 

It is recommended that you do not use the first group of buttons (Back, Forward, Stop, Refresh 
and Home) from the IE browser while you are working in Fourth Shift WebUI. Instead, it is 
recommended that you use the buttons from within Fourth Shift WebUI to use Fourth Shift 
functionality.
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My Fourth Shift Workplace: How Do I?
This section is a guide to the activities or tasks you can perform using My Fourth Shift Workplace. 
Each activity includes:

• Procedures—the step-by-step instructions for performing the activity.

• Tips—this section includes important notes, pointers, and standard information you should 
know in order to perform the activity.

For detail information on using a specific Fourth Shift screen, choose Screen Help from the Help 
menu. Activities are separated into functionality categories.

Add Charting Portal
1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal.

The Edit Preferences/Portal screen is displayed.

2. Click the Add a New Portal icon.

3. Enter the Portal Name.

4. Select the Private/Public portal type.

5. Do one of the following to select the Portal Group. 

- Select an existing group from the drop-down list

- Click New Group to display the Add New Group -- Web Page Dialog window.

a. Add a New group name for your user information.

b. Select the Private or Public portal type.

c. Click OK.

6. Select whether you want this to be in a large virtual space or not.

7. Select the Layout tab.

8. Define the number of frames in this portal.

9. Enter frame definition information for your portal:

- frame title

- frame type = FS Chart

- location

- parent frame = Frame A or B—select the one where the Fourth Shift WebUI frame is 
located, based on your portal layout

- default charts

10. Click the Image tab and select an image for your portal. 

11. Click the Save button to save your changes, or click the Add button again to discard your 
changes.

Note: To view your new portal, click Start Portal in the My Fourth Shift portal bar. From the 
list of portal groups, select the group where your new portal is defined. From the list of 
portals, click the new portal.
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Tips
• To select a chart that starts by default when the portal is accessed, expand the Default Chart 

list and select a graph or table.

• Initialization string values differ by frame type. See "Initialization String" in the Portal Manager 
section of the My Fourth Shift Workplace manual for more information.

Add Finder Portal
1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal.

The Edit Preferences/Portal screen is displayed.

2. Click the Add a new Portal icon.

3. Enter the Portal Name. 

- This name must be unique from all other portals that you have created. 

- If it is a public portal, the name must be unique name from all other public portals.

4. Select the Private/Public portal type.

5. Do one of the following to select the Portal Group.

- Select an existing group from the drop-down list.

- Click New Group to display the Add New Group -- Web Page Dialog window.

a. Add a New group name for your user information.

b. Select the Private or Public portal type.

c. Click OK.

6. Select whether you want this to be in a large virtual space or not.

7. Select the Layout tab.

8. Define the number of frames in this portal.

9. Enter frame definition information for your portal:

- frame title

- frame type = FS Finder

- location

- parent frame = Frame A or B—select the one where the Fourth Shift WebUI frame is 
located, based on your portal layout

- Fourth Shift log on information

- navigation = select if you want the Find feature (parent) to navigate Fourth Shift 
WebUI (child) based on the Find feature's data selections.

- default finder

10. Click the Image tab and select an image for your portal.

11. Click the Save icon to save your changes, or click the Add icon again to discard your 
changes.

12. Click Close to exit the portal update process.
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Note: To view your new portal, click Start Portals in the My Fourth Shift portal bar. From the 
list of portal groups, select the group where your new portal is defined. From the list of 
portals, click on your new portal.

Tips
• When accessing the Find feature through a portal frame, you are prompted to log on to Fourth 

Shift. You can enter this log on information (user id and password) when creating the frame 
type so that you are not prompted for it when the Find feature is accessed.

• When the Find feature is defined as a parent frame, an option is available to set the level of 
navigation:

- Option Selected. The Find feature (parent) sends a message to Fourth Shift WebUI 
(child) and Fourth Shift WebUI changes to the desired screen and the data is entered 
into the appropriate field. 

- Option Not Selected. The Find feature (parent) sends a message to Fourth Shift 
WebUI (child) and if the desired screen is already displayed, the data is entered into 
the appropriate field. If the desired screen is not displaying the desired screen, the 
data is not entered.

• To select a finder that starts by default when the portal is accessed, expand the Default 
Finders list and select a finder.

• Initialization string values differ by frame type. See "Initialization String" in the Portal Manager 
section of the My Fourth Shift Workplace manual for more information.

Add Portal Definition
1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal.

The Edit Preferences/Portal screen is displayed.

2. Click the Add a New Portal icon.

3. Enter the Portal Name. 

- This name must be unique from all other portals that you have created. 

- If it is a public portal, the name must be unique name from all other public portals.

4. Select the Private/Public portal type.

5. Do one of the following to select the Portal Group.  

- Select an existing group from the drop-down list

- Click New Group to display the Add New Group -- Web Page Dialog window.

a. Add a New group name for your user information.

b. Select the Private or Public portal type.

c. Click OK.

6. Select whether you want this to be in a large virtual space or not.

7. Select a Layout tab.

8. Define the number of frames in this portal.
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9. Enter frame definition information. 

For example, enter the frame title, frame type, location, parent frame and default settings to 
customize your portal.

10. Click the Image tab and select an image for your portal.

11. Click the Save icon to save your changes or click the Add icon again to discard your changes.

12. Click Close to exit the portal update process.

Note: To view your new portal, click Start Portal in the My Fourth Shift portal bar. From the 
list of portal groups, select the group where your new portal is defined. From the list of 
portals, click your new portal.

Tips
• Public portal definitions are available for any user to access but they can only be changed or 

deleted by the portal administrator.

• Private portal definitions are saved by your Windows login identifier.

• If you wish to create a new portal group, click New Group and enter the new group 
information.

• Portal images must exist in the Inetpub\WWWRoot\FSPortals\Images directory. You can add 
.JPG files to this directory, if desired.

• Portal layout can only be defined when you create a new portal definition.

• Initialization string values differ by frame type. See "Initialization String" in the Portal Manager 
section of the My Fourth Shift Workplace manual for more information.

• Several optional settings are available for FS Finder and FS Chart frame types, such as 
specifying the default Chart or Find type, and whether the Find results navigate the Fourth 
Shift application.

Add Portal Group
1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal.

The Edit Preferences/Portal screen is displayed.

2. Click the Add a New Portal icon.

3. Click New Group to display the Add New Group dialog window.

4.  Add a New group name for your user information.

5. Select the Private or Public portal type.

6. Click OK.

The portal group is now available for use in a portal definition.

Tips
• Portal groups can be deleted and given to other users in a group tree.

• Private groups are saved by your Windows login identifier.
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Add Predefined Locations
1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal.

The Edit Preferences/Portal screen is displayed.

2. Click Locations.

The Edit Known Locations dialog is displayed.

3. Enter a new Location Name.

4. Enter a Location URL.

5. Enter the Configuration File.

6. Select one or more of the Supported Frame Types.
Note: The Arbitrary site and Named Site Frame Types are always supported.

- FS Chart

- FS Explorer

- FS Explorer Security

- FS Finder

- FS UIEditor

- FS WebUI

- Terminal Server

7. Click Add New.

The Defined Locations list is updated and your new location is listed.

Note: Because the Location Names are visible to users, we recommend using names that 
clearly identify what the URL address accesses. For example, use a location name 
like Colorado Plant rather than a server name like CCSVR-21.

Change Default Portal
1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal.

The Edit Preferences/Portal screen is displayed.

2. Select one of the predefined portals from the Default Portal drop-down list.

3. Click the Save icon.

The Edit Preferences/Portal screen displays the Changes saved message.

Tips
• Only public portals and your private portals can be selected.

• Create a new portal if none of the predefined portals meet your needs.

• To change back to the original default portal, select the Start Portal option from All Public 
Portals panel or click the Start Portal button in the upper-left corner.

• You can customize the links in the original default portal. 
For example, you can customize the "Your Company Home Page" link by updating the default 
link with your own company home page address.
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Change Portal Definition
1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal.

The Edit Preferences/Portal screen is displayed.

2. Select the portal you want to work with from the Portal Maintenance drop-down list.

3. Click the Edit this Portal icon.

4. Use the General Layout and Image tabs to display and change the definition.

For each frame in your portal, review and update the frame detail as needed.

5. Click the Save button to save your changes, or click the Edit button again to discard your 
changes.

6. Click Close to exit the portal update process.

Tips
• The Portal layout option cannot be changed. You must create a new portal to change the 

number or configuration of frames.

• If you wish to change the order of the frames, change the frame definitions to display the 
desired content.

Change Predefined Locations
1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal.

The Edit Preferences/Portal screen is displayed.

2. Click Locations.

3. Highlight the Defined Location you wish to change.

4. Review and change the Location Name if necessary.

5. Review and change the Location URL if necessary.

6. Review and change the Configuration File if necessary.

7. Update the Supported Frame Types.

8. Click Update.

Tips
• Changes to predefined locations are available to users immediately.
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Delete Portal Definition
1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal.

The Edit Preferences/Portal screen is displayed.

2. Select the portal you want to work with from the Portal Maintenance drop-down list.

Important: Deleting a portal is permanent—there is no Undo.

3. Click the Delete this Portal button.

The Delete Confirmation dialog message is displayed.

4. Verify that this is the correct portal then click Yes.

Tips
• Portal definitions must be recreated if you accidentally delete a portal. 

• Public portals can only be deleted by the Portal Administrator.

Delete Predefined Locations
1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal.

The Edit Preferences/Portal screen is displayed.

2. Click Locations.

3. Select the location you want to delete from the list displayed for Defined Locations.

Important: Deleting a location is permanent—there is no Undo.

4. Click Delete. 

The location is deleted and the Defined Location list is automatically updated.

Tips
• If the predefined location is referenced in a portal definition, the predefined location cannot be 

deleted.
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Update Fourth Shift Explorer Security Data
In order to make security changes available to Fourth Shift Explorer frames in My Fourth Shift 
Workplace portals, an additional step is required.

1. Log in to My Fourth Shift Workplace as the portal administrator.

2. Select the Explorer Security portal from the Portal Admin group.

3. Select the location of the My Fourth Shift Workplace server from the list.

4. Choose whether to update security for all users, or for only a single user.

- If you choose to update security for a single user only, enter that user's Fourth Shift 
User ID.

5. Click Update.

Tips
• These steps must be completed whenever security changes are made to the FCMT (Function 

Code Maintenance) or PASS (Password Maintenance) screens in Fourth Shift.

Change Explorer Mode
Several modes are available when using the Fourth Shift Navigation panel.

Switching to Full Mode
In Full Mode, you can search for a specific function based on a keyword. Use these steps to switch 
from the default Simple mode to Full Mode.

1. In the Explorer frame, click on the Switch Mode link to switch to Full Mode. 

2. Click on the arrow next to the module name to expand the list of functions in the module.

- You can go directly to the function by clicking on the function.

- Alternately, you can enter starting data before going to the function: 

a. Click on the arrow next to the desired function to open the parameter fields, if available. 

b. Enter specific starting data in the parameter fields. 
The starting data is used when navigating to the function.

c. Click Go to go to the selected function using the entered starting data.

Switching to Simple Mode
In Simple Mode, the available Fourth Shift modules are listed in alphabetical order. Use these 
steps to switch from Full Mode back to the default Simple Mode.

1. In the Explorer frame, click on the Switch Mode link to switch to Simple Mode. 

2. Click on the arrow next to the module name to expand the list of functions in the module.

3. Click on the function to go to that screen.

Tips
• You can click on the arrow to expand or collapse the list of modules or screens.

• You can use keywords to search through the screens and tasks by selecting a keyword from 
the drop-down list and clicking the Search button. Only those screens and tasks that relate to 
the keyword are displayed in the navigation results.

• When you click on a screen or task to go to that location, the location change information is 
sent to the portal frame that is "listening" to the Fourth Shift Explorer frame.
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• You can toggle back and forth between showing and hiding the function codes in the 
navigation list using the Show Codes and Hide Codes links.

Search by Keyword
1. In the Explorer frame, click the Switch Mode link to switch to Full Mode.

2. Click to open the drop-down list of available keywords.

3. Select a keyword and click the Search (magnifying glass) button.

4. Click on the arrow next to the results list to expand the list.

5. Click on the desired function or activity.

Tips
• You can search by keyword using either the Full Mode application view.

• For example, you can search for "credit memo" and only those functions that relate to credit 
memos are listed in the results. 

• You can toggle back and forth between showing and hiding the function codes in the 
navigation list using the Show Codes and Hide Codes links.

Access Help
Several methods are available for accessing help for My Fourth Shift Workplace and portals.

Context-Sensitive Help in Fourth Shift WebUI
1. Use the options in the Help menu on the current tab to review context-sensitive help for the 

function.

2. Click the X in the upper-right corner of the help window to close the window.

My Fourth Shift Workplace and Portals
1. Click the Help link in the My Fourth Shift Workplace portal bar.

2. Use the tabs to review the detail on using My Fourth Shift Workplace and portals.
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Close My Fourth Shift Workplace

Important: We strongly recommended that you do not use the Internet Explorer Close button ( ) 
to exit My Fourth Shift Workplace. Closing the Internet Explorer does not exit the Fourth 
Shift WebUI application—it will continue to run until the session times out.

1. Click the Log Off link in the upper-right corner of My Fourth Shift Workplace portal.

The Goodbye page is displayed and you are notified that the Fourth Shift Portals session has 
ended.

2. Do one of the following:

- Click the Internet Explorer Close button ( ) to close the browser window.

- Click the here link on the Goodbye page to start a new My Fourth Shift Workplace 
session.

Tips
• You are not allowed to close My Fourth Shift Portal session if you have not completed the 

current transaction in a Fourth Shift WebUI frame. For example, from the APIE (A/P Invoice 
Entry) screen, a warning message is displayed if you click the My Fourth Shift Portal button 
before you've completed the G/L distribution.

• We recommend that you use the Log Off portal bar link to exit My Fourth Shift Workplace. 

Select Portal from List
1. Click Start Portal or the portal name in the My Fourth Shift Workplace portal bar to open the 

portal manager (in the upper left-hand corner). 

2. Select one of the following to open a list of available portals. 

- Group Tree—to view a hierarchical tree of private and public groups.

- All Public Portals—to view a list of available public portals.

- Private Group Name—to view a list of your private portals in that group. 

3. Click the portal icon located above the portal name you want to work with.

Your selected portal is displayed automatically.

Note: Click the portal or group name to toggle between show or hide when displaying the list 
of portals or groups.

Tips
• Private portal definitions are only available to the user who created them.

• To change back to the original default portal, select the Start Portal option.

Run a Microsoft Windows-based Application
1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal.

The Edit Preferences/Portal screen is displayed.

2. Click the Add a New Portal icon.

3. Enter the Portal Name.

4. Select the Private/Public portal type.

5. Do one of the following to select the Portal Group. 
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- Select an existing group from the drop-down list

- Click New Group to display the Add New Group -- Web Page Dialog window.

a. Add a New group name for your user information.

b. Select the Private or Public portal type.

c. Click OK.

6. Select whether you want this to be in a large virtual space or not.

7. Select the Layout tab.

8. Define the number of frames in this portal.

9. Enter frame definition information—select Type = Terminal Server for at least one of the 
frames. 

This is the frame through which you can run an external application.

10. Select the Default Application you would like to run through the Terminal Server frame. 

For example, if you would like to run the Fourth Shift Shop Calendar in this frame, expand the 
"Fourth Shift WTS Applications" tree and select "Fourth Shift Shop Calendar." This is the 
application that will start by default when the portal is started.

11. Click the Image tab and select an image for your portal.

12. Click the Save button to save your changes, or click the Add button again to discard your 
changes.

13. Click Close to exit the portal update process.

Note: To view your new portal, click Start Portal in the My Fourth Shift portal bar. From the 
list of portal groups, select the group where your new portal is defined. From the list of 
portals, click on your new portal.

Tips
• Private portal definitions are only available to the user who created them.

• If you want to run any Windows desktop application from a Terminal Server frame, select 
"Windows Desktop" as the startup application when configuring the Terminal Server frame.

Save Find Feature Settings
1. Open the Finder feature either as a frame or a popup window from WebUI.

2. Select the fields to display in each column.

3. Specify filter criteria, if desired.

4. Click the Reload data icon.

The results are displayed in the Finder pane.

5. Click the Save settings icon.

Tips
• Settings are saved differently separately for each type of Finder.

• Settings are saved by workstation, not by User ID. You must have the necessary Internet 
security that allows cookies to be stored on your workstation in order to save settings.
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Specify Finder Feature Criteria
1. Do one of the following to open the Finder feature:

- From a field within Fourth Shift WebUI:

a. Point to the Find icon.

b. If this field has a menu of options, use the down arrow to display it.

c. From the list displayed, select Find <data>.

- From a portal frame:

a. Select the portal from your portal group that has been assigned the FS Finder 
frame type.

b. If prompted, log on to Fourth Shift using your User ID and Password
2. Select the fields to filter by and specify filter criteria, if desired.

3. Click the Reload data icon.

4. Click the arrow row marker to select the data.

The data is entered into the active field. 

- The Finder feature closes, if it was accessed from within Fourth Shift WebUI. 

- The Finder feature remains open, if it is a separate portal frame.

Tips
• As an alternative, you can press Ctrl+Down Arrow to open the list and then press the up/

down arrow keys to move within the list. Tab or Enter will select the highlighted item.

• Click the Clear Criteria icon to remove the filter criteria from all fields.

• Click the Save settings icon to retain your sort order and filter criteria for the current session.

• If starting data was entered in the originating field before accessing the Find feature, this data 
is automatically entered into the filter criteria. If starting data was not entered, the Find feature 
opens and you can enter filter criteria in the row of available fields.

• When entering criteria, you can enter a space before the specified value in order to display a 
list of all the identifiers that contain the criteria anywhere in the identifier. Without the space, 
the list includes only the identifiers with the criteria as starting characters.

• To change the sort order, click on the header of another column. To reverse the sort order 
from ascending to descending, click on a column header that is already sorted. The sort order 
is saved when Save Settings is selected.

• The Finder feature uses field-level security, which allows only the users who are assigned the 
appropriate security to see certain fields. See the Assigning Security topic, in the Fourth 
Shift Basics online Help, for more information on security for the Find feature.
Web UI 126



Fourth Shift Release 7.50
Using Order Number Assignment
The Order Number Assignment feature provides an easy method of automatically generating 
sequential order numbers for customer, purchase and manufacturing orders. The Order Number 
Assignment feature can be accessed from either Fourth Shift WebUI or the traditional Fourth Shift 
system. Both user interface types will use the same order number assignment database and will 
work correctly for a mix of users.

Setting Up the Configuration
You configure the Order Number Assignment feature by setting options and defining formats on 
the Order Number Assignment Configuration window. Once defined, the formats are used to 
assign order numbers when selected.

Opening the Configuration Window
The Order Number Assignment Configuration window is accessed by selecting the Order Number 
Assignment option on the OACF screen.

Defining the Order Number Format
You can independently define different formats for purchasing, manufacturing and customer order 
numbers. Each order number format may contain up to 30 characters and can contain several 
sections, including a prefix, current date and numeric sequence.

Prefix. A prefix is optional and includes the following:

Description Recommendations Example

Initial set of characters that remains con-
stant as order numbers are assigned; 
which allows you to group or categorize 
different types of purchasing, manufactur-
ing or customer orders. 
When using Fourth Shift WebUI, a prefix 
can be configured to be either alpha or 
numeric characters. It is recommended to 
use a prefix limited to 3 characters.

Prefix length should be less than 6 
characters so that the order num-
ber format has enough characters 
for the current date and a numeric 
sequence, if desired.

Prefix can be 3 
characters if the 
current date and a 
5-character numeric 
sequence are used.
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Current Date. A date is optional and includes the following:

Numeric. A numeric is required and includes the following:

Assigning Order Numbers
To assign an order number when using Fourth Shift WebUI, point to the icon (gold oval with 
exclamation mark) located to the right of the Order Number field and from the menu select Order 
Number. You can also press Ctrl+E to open the menu and then press O to open the Order 
Number Assignment feature.

Based on the number of order number formats defined, the order number is assigned using one of 
the following methods:

Description Recommendations Example

The date that can be inserted into order 
number formats using the Insert Date but-
ton when using Fourth Shift WebUI or the 
F6 key when using the traditional Fourth 
Shift system. The date is formatted 
according to the Date and Number For-
mat field on the CNFG screen, not by the 
default short date setting of the worksta-
tion. The date is 7 characters, which 
includes a 6 character date (MMDDYY) 
plus a trailing dash (-). The value of the 
date field is determined by the Fourth Shift 
system date.

Use the Last-Assigned Order 
Date field to identify the date of the 
most recently assigned order num-
ber. Set the value of the Daily 
Reset of <DATE>-Type Orders 
field to Y to restart the sequence of 
order numbers at the beginning of 
each day.

To ensure proper 
sequencing, the sys-
tem compares the 
sign-on date with the 
Last-Assigned 
Order Date and pre-
vents order number 
assignment. 
This feature guards 
against erroneous 
order number assign-
ment that could occur 
when a user inadvert-
ently signs on with a 
date earlier than the 
system date.

Description Recommendations Example

Unique "starting at" number sequence 
which increases each time an order num-
ber is assigned from that specific format.

The numeric sequence, date and 
prefix combination cannot exceed 
15 characters. In the order format, 
numeric values are displayed using 
the # symbol. The actual number is 
not assigned until the format is 
selected.

Numeric sequence 
can be 5 characters if 
a 3-character prefix 
and the current date 
is used; or 8 charac-
ters if only the current 
date is used.

Method Reason Example Steps to Continue

List displays More than one order 
format for an order type 
has been defined

If you are assigning customer 
orders, and CO-#### and CO-
<DATE>-### are both defined as 
order number formats on the 
Order Number Assignment Con-
figuration window, a dialog 
opens and both formats are 
listed.

Click on the format you 
want and the generated 
order number is entered 
into the field.
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The Customer Order Number Assignment feature is not used with the SOPM (Sales Order 
Processing) Module. If you are also using the SOPM Module see "Customer Order Number 
Prefixes" in the Sales Order Processing manual for more information.

Assigning Order Numbers by Multiple Users
Multiple users can use the Order Number Assignment feature simultaneously, and the order 
numbers increase sequentially. This multi-user capability is allowed since the actual order number 
is generated after the order format is "selected" by the user, and not when the selection list is 
displayed.

When the Order Number Assignment feature is accessed from traditional Fourth Shift, automatic 
order number assignment is locked to other users while the Order Number Assignment window is 
displayed. Locking does not need to occur when accessing the Order Number Assignment from 
Fourth Shift WebUI.

Summary of Order Number Assignment Feature Differences
The Order Number Assignment feature can be accessed from either Fourth Shift WebUI or the 
traditional Fourth Shift system, but several differences may be noticed between the two access 
methods. Differences include:

Troubleshooting

Automatically 
enters number

Only one order number 
format has been 
defined for an order 
type

If you are assigning purchase 
orders, and only one purchase 
order format is defined on the 
Order Number Assignment 
Configuration window, the next 
sequential number is automati-
cally entered into the Order 
Number field using that format.

Continue to the next 
field to enter order 
details

Action Fourth Shift WebUI Traditional Fourth Shift

inserting a date in a format click Insert Date type <DATE>

defining an optional prefix in a format up to 15 alphanumeric charac-
ters are possible

saving a format click Submit press ENTER

opening the order number assign-
ment window

point to the icon (gold oval with 
exclamation mark) next to Order 
Number field or press Ctrl+E+O.

press Alt+F8 in the Order 
Number field

selecting an order number select the order number format 
from the list, but the actual order 
number is displayed as a mask; 
for example, you select MO-####

select the actual order num-
ber from the list; for exam-
ple, you select MO-1212
Alt+F4

having multiple users multiple users can use the Order 
Number Assignment feature 
simultaneously

multiple users can only use 
the Order Number Assign-
ment feature sequentially

Method Reason Example Steps to Continue
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Use the following to assist you while using the Order Number Assignment feature:

Assigned Order Date Not Current
Use the Order Number Assignment Configuration window to review the date entered as the 
Last-Assigned Order Date. To ensure proper sequencing, the system compares the sign-on date 
with the Last-Assigned Order Date and prevents order number assignment. This feature guards 
against erroneous order number assignment that could occur when a user inadvertently signs on 
with a date earlier than the system date.

Order Number Assignment Feature Unavailable
When using the Fourth Shift WebUI, you may be momentarily restricted from accessing the next 
sequential order number if an order number in the traditional Fourth Shift system is displayed but 
not yet selected. The system tries to access the next sequential number for a period of time before 
this message is displayed. Refresh your screen and try again.

There are no available <type> order numbers
The order number format has reached its highest number, and therefore cannot generate any 
more order numbers. To generate more order numbers, you need to create a new order number 
format. Review the required use of the format so you can specify sufficient sequential numbers for 
the expected order volume when defining the format. For example, the order number format MO-
## limits you to 99 orders, where MO-#### allows 9999 orders.

You must select an Order Type to find an order
Several screens, such as LRRP, require that an order type be selected before opening the Order 
Number Assignment window. Verify you have selected an Order Type and try again.
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Using Fourth Shift Report Viewer
Fourth Shift Report Viewer is a program used to display reports before they are printed, or to open 
previously saved reports. It allows you to view any page of the report, and print the report on any 
printer set up on your computer. You can also save the report as a file on your computer, or open 
a previously saved report.

You can access Fourth Shift Report Viewer from any screen that generates a screen report by 
choosing Print Preview from the File menu. The Print Preview option is available only for screen 
reports. You can also access it by selecting Report Viewer from the Fourth Shift Tools menu.

Fourth Shift Report Viewer can open, print and save both template-based and RTF-based reports.

Printing Reports in Fourth Shift Report Viewer
Do one of the following to print a report from Fourth Shift Report Viewer:

• Choose Print from the File menu to specify a printer or fax machine, or to specify a range of 
pages to be printed

• Click Print on the toolbar to print the entire report on your computer's default printer

To change the paper size, specify portrait or landscape orientation, or modify any other printer 
settings, choose Print Setup from the File menu before printing the report.

Previewing Reports in Fourth Shift Report Viewer
Fourth Shift Report Viewer allows you to preview a report on your screen before it is printed. You 
can check the layout and content of a report before printing, or simply review and close a report 
without printing.

Normal and Preview Views of RTF Files
Fourth Shift Report Viewer provides two viewing options for previewing a report: Normal and 
Preview. Each time Fourth Shift Report Viewer opens, it is in Normal view. To switch to the 
Preview mode, select Print Preview from the File menu. Click Close to return to the Normal view.

The viewing option you choose does not affect the layout of the actual report. In Preview mode, 
you can do the following:

• see the printer margin area

• print the report

• display one page at a time, or two pages side by side

• zoom in for a detailed view or zoom out to see the overall layout of the report
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Moving Between Pages
Many reports contain more than one page. In Normal view mode, page breaks are shown on your 
screen by a dotted horizontal line. In Normal view, do one of the following to move between pages 
in a report:

• Use the vertical scroll bar to scroll between pages

• Use the toolbar buttons or the options in the View menu to move to the first, next, previous or 
last page

• Enter a specific page number in the toolbar then press Enter

Print Preview and Action Messages
A number of Fourth Shift action messages instruct you to print a specific document. Typically, 
when you print the document, the action message is deleted.

For these documents, selecting Print Preview is treated the same as printing the document. 

• If you choose to Print Preview one of these documents, Fourth Shift assumes that the 
document has been printed, and the action message is deleted. 

• Do not use Print Preview for these documents unless you plan to print the report at that time.

These action messages include:

Saving Screen Reports Using Fourth Shift Report Viewer
After you have previewed a newly-generated, or previously-saved, screen report, you can use the 
Fourth Shift Report Viewer to save it to a file.

Other Ways to Save a Screen Report
If you want to save a screen report (if available) without previewing it first, use the Print Export 
from the File menu. You can choose from several file formats when saving the report using the 
Print Export option. 

Viewing Batch Process Reports Using Fourth Shift Report Viewer
Reports generated by batch process tasks are printed to disk as a file if you selected Report 
Destination = 2 for the task. 

You can view these reports only after they are created. You cannot preview a batch process report 
as part of the batch process itself. You can, however, add a line to a batch process that opens the 
report using Fourth Shift Report Viewer, prints the report automatically, or converts the report file 
to plain text format. For more information, see Fourth Shift Report Viewer Command Line 
Parameters.

Open the Fourth Shift Report Viewer by choosing Report Viewer from the Tools menu. Locate 
the report you want to view and click Open. Be sure to select All files in the Files of type box, 
because batch process report files use the Process Id of the batch process as the file extension.

Action Messages Description
Document Printed 

From

ACK Print order acknowledgment COMT

PMO Print manufacturing order CPMT, MOMT

PPL Print picklist PICK

PPO Print purchase order POMT
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Note: If you regularly need to view report files, you may want to customize the toolbar by 
adding a button that opens the Fourth Shift Report Viewer. For more information, see 
the Customizing the Toolbar topic in the Fourth Shift Basics online Help.

Converting Saved Reports to Plain Text Format
There may be times when you need to convert a screen or batch process report file to plain text 
(TXT) comma-delimited format. Although you cannot change the file format when you save the 
report, you can run the Fourth Shift Report Viewer (FSPRINT.EXE) silently, using a command line 
parameter that performs this conversion.

The syntax for this command line parameter is as follows:

M:\MFGSYS\SYSTEM\FSPRINT.EXE  <report file name>  /text  <text file name>

For example, to convert the saved batch process report file M:\MFGSYS\PORR01.PUR to a plain 
text file in the same directory with a .TXT file name extension, use a command line similar to the 
following:

M:\MFGSYS\SYSTEM\FSPRINT.EXE  M:\MFGSYS\PORR01.PUR  /text  
M:\MFGSYS\PORR01.TXT

You can perform this conversion using any command line execution method, such as a batch file, 
batch process, shortcut, or the Run dialog box. For more information on operating Fourth Shift 
Report Viewer from a command line, see “Fourth Shift Report Viewer Command Line 
Parameters.”

Adjusting Report Fonts and Margins
You can change the look of your printed RTF-based reports by modifying the fonts and margins. 
To do this, you must add or modify lines in your FS.CFG (or [system name]LOCALFS.CFG) file.

The default font for reports is 10 point Courier New. You can modify this by changing value of the 
RtfReportFontName configuration variable. You can improve the speed of report printing on dot 
matrix printers by using a printer font instead of a TrueType font.

The default margin on the left side of the page is 13/36 inch, with no top, bottom or right margin. To 
modify these characteristics, add or change the following configuration variables:

Configuration Variable Description

RtfBarCodeFontName Name of bar code font

RtfBarCodeFontSize Size, in ½ points, of bar code font

RtfReportFontName Name of standard report font

RtfReportFontSize Size, in ½ points, of standard report font

RtfReportFontSizeCompress Size, in ½ points, of report font in compressed width areas

RtfReportLineSpacing Distance between baselines of consecutive lines

RtfTwipsMarginTop Size of top margin

RtfTwipsMarginBottom Size of bottom margin

RtfTwipsMarginRight Size of right margin

RtfTwipsMarginLeft Size of left margin

RtfTwipsGutter Size of gutter
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Note: These configuration variables have no effect on template-based reports. You can 
adjust the report fonts and margins on those reports by customizing the report 
template.

For more information, see "Configuration Variables" in the System Administration manual.

Fourth Shift Report Viewer Menus
Fourth Shift Report Viewer has three menus containing options for displaying, saving and printing 
reports.

Fourth Shift Report Viewer Command Line Parameters
You can create a shortcut to the Fourth Shift Report Viewer, or include it in a batch process or 
batch file, by using the following command line syntax:

FSPRINT <filename> [/title <title>] [/dir <dir>] [/save [<outfile>] | /
print [/ask] | /text [<outfile>] | /showopen]

In the following example, Fourth Shift Report Viewer is used to print a saved batch process report 
to the default printer after it is generated:

M:\MFGSYS\SYSTEM\FSPRINT.EXE  M:\MFGSYS\PORR01.PUR  /PRINT

RtfTwipsHeaderY Position of report header

RtfTwipsFooterY Position of report footer

Parameter Description

<filename> Specifies the name and fully qualified path of the file to be opened, printed or 
converted.

/title <title> Used to set the window title of the document when opened in Fourth Shift Report 
Viewer.

/dir <dir> Used to set the default directory of the document when opened in Fourth Shift 
Report Viewer.

/save <outfile> Used to save <filename> directly to the specified name and fully qualified path; if 
no <outfile> is specified, the Save As dialog box is displayed. This parameter can 
not be used with the /print, /text or /showopen parameters.

/print [/ask] Used to print <filename> directly to the default printer set up for the workstation. 
If /ask is specified, the Print dialog box is displayed, allowing a choice of printers 
and other options. This parameter can not be used with the /save, /text, or /
showopen parameters.

/text <outfile> Used to convert <filename> to a plain text, comma-delimited file with the 
specified name. If no <outfile> is specified, the Save As dialog box is displayed. 
This parameter can not be used with the /save, /print, or /showopen parameters.

/showopen Used to display the Open dialog box. This parameter can not be used with the /
save, /print, or /text parameters.

Configuration Variable Description
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Report Templates
Many Fourth Shift reports are generated using templates that define not only the data that appears 
on the reports, but the layout and formatting of the reports as well.

There are no differences in the actions you take to generate template-based screen reports or 
template-based batch process reports. However, template-based reports provide you with 
additional options for generating customized output, or multiple outputs of a single report.

Screen reports and batch process reports that are not generated using a template are generated 
instead as RTF (Rich Text Format) based documents.

Note: The templates used to generate these reports can be customized to change the layout 
of the report, or even the data contained in the report. For detailed instructions, see 
"Customizing Report Templates" in the System Administration manual.

Choosing Report Formats
When you use template-based reports, you can export reports to files in different formats such as 
PDF and CDF (Comma Delimited File). These files can then be viewed at a later time or used as 
input for processing by custom applications or distributed via email. 

Printing External Documents
Fourth Shift generates a number of documents that are either distributed to your trading partners, 
or used to conduct business transactions with your trading partners. Many are designed to be 
printed on preprinted forms, although you can customize the templates used to generate the 
documents and print instead on plain paper. Or you can choose to email the reports automatically.  

External documents are produced in a variety of ways. For example:

• Customer order acknowledgments, purchase orders and shipping documents are generated 
as screen reports.

• Invoices, order acknowledgements, and customer statements are generated as batch process 
reports.

• Checks and 1099 forms are generated as the result of screen processing.

For lists and samples of the external documents produced by Fourth Shift, see "Documents that 
Use Preprinted Forms" in the Getting Started manual.

Printing on Preprinted Forms
You may choose to print external documents, such as bills of lading, invoices and checks, on 
preprinted forms. If you are using preprinted forms, most of these documents offer alignment tests 
as part of the printing process. Use the alignment test before beginning a print run to ensure that 
the preprinted paper forms are correctly loaded in the printer.

Note: You are not required to use preprinted forms. Optionally, you can customize the report 
template used for printing external documents, and print them on plain paper using a 
laser printer. For more information on customizing report templates, see "Customizing 
Report Templates" in the System Administration manual.
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